Contents

Preface ................................................................................................................................. ix
  Intended Audience ........................................................................................................ ix
  Where to Find More Information ................................................................................ ix
  Documentation Accessibility ...................................................................................... ix

1 Introduction
  Introduction .................................................................................................................... 1-1
    Argus Safety Configuration Process Overview ...................................................... 1-1
    Usage Conventions .................................................................................................. 1-2
    Getting Started ........................................................................................................ 1-2
    Argus Console Architecture ................................................................................... 1-3
      Required Fields ...................................................................................................... 1-3
      Standard Buttons .................................................................................................. 1-3
      Standard Icons ..................................................................................................... 1-4
    Administrator Login ................................................................................................. 1-5
      Logging In as an Administrator: .......................................................................... 1-5
      Changing the Administrator’s Password ............................................................. 1-6
      Logging out ............................................................................................................ 1-6
      Accessing the Home Page ..................................................................................... 1-6
      Launching Online Help ......................................................................................... 1-7
      Understanding Argus Console GUI ....................................................................... 1-7

2 Access Management
  Access Management ..................................................................................................... 2-1
    Configuring User Sites ............................................................................................ 2-1
      Field Descriptions ............................................................................................... 2-1
      Adding User Sites ............................................................................................... 2-2
        About Filtering Criterion .................................................................................... 2-4
    Configuring Groups .................................................................................................. 2-5
      Field Descriptions ............................................................................................... 2-5
      Adding User Groups ............................................................................................. 2-7
        Groups Included with the Factory Data ............................................................. 2-10
        About Filtering Criterion ................................................................................... 2-10
    Printing a User Group ............................................................................................. 2-11
      Group Configuration Print Out ............................................................................. 2-12
3 Business Configuration

About Business Configuration ................................................................. 3-1
Editable and Non-editable Business Configuration Sections .................. 3-1
  Type Ahead Fields ........................................................................... 3-3
  Additional Comments Fields ............................................................. 3-3
Configuring Product Family ................................................................. 3-3
  Field Descriptions .......................................................................... 3-4
  Adding Product Families ................................................................. 3-4
  About Filtering Criterion ................................................................. 3-5
Creating Data Sheets .......................................................................... 3-6
  Field Descriptions .......................................................................... 3-6
Configuring Products ........................................................................... 3-9
  Field Descriptions .......................................................................... 3-10
  Adding Products ............................................................................ 3-11
  About Filtering Criterion ................................................................. 3-12
Configuring Licenses .......................................................................... 3-13
  Field Descriptions .......................................................................... 3-13
  Adding Product Licenses ................................................................. 3-15
  Using the Product Browser .............................................................. 3-17
Configuring Clinical Studies ................................................................. 3-18
  Field Descriptions .......................................................................... 3-19
  Adding Clinical Study Configurations ............................................. 3-22
    About Filtering Criterion ............................................................... 3-23
  Adding WHO Drug Details .............................................................. 3-24
  Adding Product Details ................................................................... 3-25
  Configuring Auto Encoding ............................................................. 3-26
  Configuring Study Reporting .......................................................... 3-28
Configuring Expedited Report Rules .................................................... 3-29
  Field Descriptions .......................................................................... 3-31
  Adding Expedited Report Rules ....................................................... 3-35
    About the Filtering Criterion .......................................................... 3-37

4 System Configuration

System Configuration Overview ............................................................ 4-1
Configuring Case Priority ................................................................... 4-2
  Field Descriptions .......................................................................... 4-2
Configuring Field Validations .............................................................. 4-4
  Field Descriptions .......................................................................... 4-5
  Modifying Field Validations ............................................................ 4-5
Configuring LAM System Numbering .................................................... 4-6
Configuring E2B ................................................................. 4-47
Field Descriptions ........................................................... 4-47
Configuring eMDR ............................................................. 4-49
Configuring eVAERS ......................................................... 4-49
Expedited Reports Configuration ........................................ 4-50
BfP Reporting ........................................................................ 4-53
Expedited BfArM Reports Configuration ............................... 4-53
Expedited Canada Reports Configuration ............................. 4-54
Expedited CIOMS Reports ................................................... 4-56
Expedited MedWatch Reports Configuration ....................... 4-58
Periodic Reports Configuration ............................................ 4-61
Scheduling Reports Configuration ......................................... 4-64
Configuring Security ........................................................ 4-65
Configuring Cryptography within Common Profile > Security .. 4-68
Configuring Single Sign-on .................................................. 4-68
Error Messages ..................................................................... 4-70
Configuring SMTP ............................................................... 4-70
Field Descriptions ............................................................. 4-71
Configuring Workflow Items ................................................ 4-72
Field Descriptions ............................................................. 4-73
Configuring Workflow ........................................................ 4-74
Worklist Updates ................................................................... 4-74
Configuring Case Workflow ............................................... 4-75
Configuring Workflow States .............................................. 4-75
Configuring Workflow Rules .............................................. 4-76
Worklist Intake ...................................................................... 4-79
Pending Dialog ..................................................................... 4-79
Worklist Intake View .......................................................... 4-81
Worklist ............................................................................... 4-81
Rejected Cases ..................................................................... 4-84
User Site Updates and Access Management ......................... 4-85
Configuring System Numbering .......................................... 4-86
Field Descriptions ............................................................. 4-86
Configuring Field Properties .............................................. 4-88
Field Descriptions ............................................................. 4-89
Adding User Defined Fields ................................................. 4-91
Configuring User Defined Fields ......................................... 4-91

5 Code List Configuration

Configuring Code Lists > Argus .......................................... 5-1
Configuring Autosignals ...................................................... 5-2
Field Descriptions ............................................................. 5-2
Configuring Batch Reports ................................................ 5-4
Field Descriptions ............................................................. 5-4
Configuring Letters ............................................................ 5-6
Field Descriptions ............................................................. 5-6
Configuring Justifications ................................................... 5-9
# 6 Accessing Tools

**Accessing Tools** ................................................................. 6-1  
**Report Features** ................................................................. 6-1  
**Viewing the ISCR Length Check Report** .......................... 6-2

# 7 Using Advanced Conditions

**Using Advanced Conditions** ............................................... 7-1  
**Features within Advanced Conditions** ............................. 7-2  
**Using Advanced Conditions** ............................................... 7-3  
**Creating Advanced Conditions** ....................................... 7-3  
**Creating a Query Set of Advanced Conditions** ................. 7-4  
**New Action Type Fields and Field Description** ................. 7-5  
**The Hit List Tab** ............................................................... 7-9

# 8 Best Practices

**Configuring Argus Safety for ICSR Reports (HL7)** ............. 8-1  
**Configuring Reporting Destination for HL7 ICSR Reports** .... 8-1
This document describes the steps for installing and configuring the components of the Argus Safety Solution application.

A * has been placed before fields that have been introduced in this release but are currently non-operational.

**Intended Audience**

This document is intended for administrators of the Argus Safety system for configuring Argus Safety.

**Where to Find More Information**

**Oracle Help Center**

**My Oracle Support**
The latest release notes, patches and white papers are on My Oracle Support (MOS) at [https://support.oracle.com](https://support.oracle.com). For help with using MOS, see [https://docs.oracle.com/cd/E74665_01/MOSHP/toc.htm](https://docs.oracle.com/cd/E74665_01/MOSHP/toc.htm).

**Documentation Accessibility**


**Access to Oracle Support**

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit [http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info](http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info) or visit [http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs](http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs) if you are hearing impaired.
Introduction

Argus Safety assists manufacturers of pharmaceuticals and devices by providing a simple and efficient way to comply with international and domestic regulatory safety reporting requirements. It also facilitates internal company safety surveillance by providing tools for signal detection and for analyzing the overall safety profile of both investigational compounds and marketed products.

Argus Safety Configuration Process Overview

To configure Argus Safety, the Administrator must follow a particular sequence of steps. Steps that fall later in the sequence might depend on those that appear earlier. It is, therefore, important for the Administrator to use the following flowchart as a guideline for configuring Argus Safety.

<table>
<thead>
<tr>
<th>Task</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure User Sites, Groups and Accounts</td>
<td>Enter user sites, create user groups and user accounts, configure group and individual user access rights</td>
</tr>
<tr>
<td>Configure Products</td>
<td>Configure Manufacturers, Ingredients, Formulations, Dosage Units, Product Families, and Data Sheets</td>
</tr>
<tr>
<td>Configure Licenses</td>
<td>Enter license information, countries and products associated with the license</td>
</tr>
<tr>
<td>Configure Code List Items</td>
<td>Configure list maintenance items that are not covered in other topics, like Action Taken, Clinical Studies, Study Centers, etc.</td>
</tr>
</tbody>
</table>
### Usage Conventions

The following conventions are used throughout this document to help you identify specific kinds of information.

<table>
<thead>
<tr>
<th>Usage Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>User interface elements such as Buttons, Dialog boxes, Check boxes, Combo boxes, Drop-down lists, Labels, Option (Radio) buttons, Tabs, Text boxes, etc.</td>
</tr>
<tr>
<td>“between quotation marks”</td>
<td>Information that may appear as-is on screen, or information provided by the user.</td>
</tr>
<tr>
<td><strong>Note: Text</strong></td>
<td>Information that should be noted before proceeding with the instructions.</td>
</tr>
<tr>
<td><strong>Important! Text</strong></td>
<td>Important information that must be noted to ensure accurate, reliable, or safe behavior of the system.</td>
</tr>
<tr>
<td><strong>Tip: Text</strong></td>
<td>Information that enables easier completion of the current task or helps in completing other tasks.</td>
</tr>
<tr>
<td><strong>ALL CAPITALS</strong></td>
<td>Keyboard keys</td>
</tr>
<tr>
<td><strong>Initial Capitals</strong></td>
<td>Names of user interface elements, modules, applications, proper nouns, etc.</td>
</tr>
</tbody>
</table>

### Getting Started

This section introduces the basic tasks for configuring Argus Safety. To get started with the configuration process, the person responsible for configuring Argus Safety must log on as Administrator to configure the Argus Console.

Refer to the following sections for information pertaining to:

<table>
<thead>
<tr>
<th>Section</th>
<th>Topics Covered</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Login</td>
<td>- Logging in and out of the Argus Console</td>
</tr>
<tr>
<td></td>
<td>- Changing the Administrator password</td>
</tr>
<tr>
<td></td>
<td>- Accessing the Home Page and Online Help</td>
</tr>
<tr>
<td>Understanding Argus Console user interface</td>
<td>Read this section for an overview of the Argus Console user interface components.</td>
</tr>
</tbody>
</table>
Argus Console Architecture

The Argus Web Administration Console has been designed to enhance ease of navigation for the Argus end-users.

The following illustration shows the design and location of the individual components under the main Argus Console Menu.

**Note:** The menu items that you can access depend on the security permissions that are defined for your account by the administrator.

- **Required Fields**
  Fields that are marked with a red flag image and associated with an orange boundary are required fields. These fields must be filled in, to proceed with the configuration requirements.

- **Standard Buttons**
  The standard buttons used in this console are described in the following table:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Use this button to save changes associated with a section</td>
</tr>
<tr>
<td>Cancel</td>
<td>Use this button to cancel changes associated with a section</td>
</tr>
<tr>
<td>Print</td>
<td>Use this button to print information associated with a sub-section in a PDF</td>
</tr>
<tr>
<td>Delete</td>
<td>Use this button to delete an item associated with a section</td>
</tr>
<tr>
<td>Copy</td>
<td>Use this button to create a new editable copy of an item within a section</td>
</tr>
<tr>
<td>OK</td>
<td>Use this button to confirm an action associated with a section</td>
</tr>
</tbody>
</table>
### Introduction

The standard icons used in this console are described in the following table:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Identifies</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon with a red arrow" /></td>
<td>A required field</td>
</tr>
<tr>
<td><img src="image" alt="Folder icon" /></td>
<td>An item placed inside a folder in the tree-view</td>
</tr>
<tr>
<td><img src="image" alt="Closed folder icon" /></td>
<td>A closed folder containing sub-folders or nodes</td>
</tr>
<tr>
<td><img src="image" alt="Open folder icon" /></td>
<td>An open folder displaying sub-folders or nodes</td>
</tr>
<tr>
<td><img src="image" alt="Folder icon with checkmark" /></td>
<td>An open folder that does not contain sub-folders or nodes</td>
</tr>
<tr>
<td><img src="image" alt="Closed folder icon with checkmark" /></td>
<td>A closed folder that does not contain sub-folders or nodes</td>
</tr>
<tr>
<td><img src="image" alt="Browser tree view icon" /></td>
<td>An expandable or collapsible browser tree view</td>
</tr>
<tr>
<td><img src="image" alt="Sort columns icon" /></td>
<td>An option to sort columns alphabetically (when placed next to a column header)</td>
</tr>
<tr>
<td><img src="image" alt="Multiple categories icon" /></td>
<td>An item appearing under multiple categories (e.g. a user name appearing under multiple groups)</td>
</tr>
<tr>
<td><img src="image" alt="Withdrawn license icon" /></td>
<td>A withdrawn license in the tree-view of licenses.</td>
</tr>
</tbody>
</table>
Administrator Login

When Argus Safety is installed, an account for the Administrator is automatically created. The installation program assigns "admin" as both the User Name and Password for this account.

Before logging in to the Argus Console, be aware of the following:

■ If you enter an incorrect username or password three (3) consecutive times, the system disables the Login button and displays the following message:

  The login button has been disabled due to 3 consecutive incorrect entries of Username or Password. Please refresh the page to enable the Login button.

■ The Date/Time format 24-hour used by the Web server: DD-MMM-YYYY HH:MM:SS.

---

**Note:** The Administrator or System password can be reset from new Argus Key Management Tool > Reset Password for the default Administrator and System Account.

---

Logging In as an Administrator:

1. Enter the **Argus URL** in your web browser, to launch Argus Safety. The login screen appears as shown:

   ![Login Screen](image)

   **Tip:**

   ■ The modules displayed in bold text identify the modules you have permission to access.

   ■ Your login user ID and password are valid for all accessible Argus modules.

2. Enter the **User Name** and **Password** to login to Argus Safety.
3. Select the database name from the Database list.
4. Press Enter or click Login.
5. When the window opens, click Yes to proceed with the login.

   **Note:** If the window does not appear, verify that your browser’s Pop-Up blocker is disabled.

6. Click Argus Console to launch the Argus Console Administrator screen.

   **Note:** If the window does not appear, verify that your browser’s Pop-Up blocker is disabled.

### Changing the Administrator’s Password

1. Select Utilities -> Change Password in Argus Safety.
2. The Change Password dialog opens.

   ![Change Password Dialog](image)

3. Enter the current password and the new password.

   **Note:** In case of a Single Sign-On user, the Change Password option is not supported in Argus Safety.

4. Confirm the new password and click OK.

### Logging out

1. Click Close to leave the Argus Console application.
2. To log out at any time from Argus Safety, click Logout.

### Accessing the Home Page

To go back to the Home page, click Home. The default Home page appears.
Launching Online Help
To launch online help click Help.

Understanding Argus Console GUI
This section broadly categorizes the sections of the Argus Console GUI with their associated descriptions.

<table>
<thead>
<tr>
<th>Section</th>
<th>Sub-Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>~</td>
<td>This section provides information about new keyboard navigation features for the Argus Console.</td>
</tr>
<tr>
<td>Access Management</td>
<td>Sites</td>
<td>This section enables the administrator to enter and configure new user sites.</td>
</tr>
<tr>
<td></td>
<td>Groups</td>
<td>This section enables the administrator to enter and configure new user groups.</td>
</tr>
<tr>
<td></td>
<td>Users</td>
<td>This section enables the administrator to configure user accounts.</td>
</tr>
<tr>
<td>Business Configuration</td>
<td>Product and License</td>
<td>This section helps in capturing Product Details (product specifics, product licenses, products involved in the studies. These can be the products marketed, or under investigation, by the company.</td>
</tr>
<tr>
<td></td>
<td>Studies</td>
<td>This section helps in capturing Study information (study specifics, products involved in the study licensed countries associated with the study and the clinical references used in the expedited reports.</td>
</tr>
<tr>
<td>Expedited Reporting Rules</td>
<td></td>
<td>This section helps in capturing Expedited Reporting Rule configuration. The Reporting Rules configuration feature enables the administrator to define the reporting rules or criteria for the cases to be qualified for expedited reporting.</td>
</tr>
<tr>
<td>Section</td>
<td>Sub-Section</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System Configuration</td>
<td>Case Priority</td>
<td>This section enables the administrator to configure rules to determine the priority of new cases that are entered into the system.</td>
</tr>
<tr>
<td></td>
<td>Field Labels</td>
<td>This section enables the administrator to change field labels, hide and unhide fields in Case form.</td>
</tr>
<tr>
<td></td>
<td>Field Validation</td>
<td>This section enables the administrator to configure field level validations for the case form fields.</td>
</tr>
<tr>
<td></td>
<td>LAM System</td>
<td>This dialog enables the administrator to specify the case numbering preferences for LAM cases.</td>
</tr>
<tr>
<td></td>
<td>Numbering</td>
<td></td>
</tr>
<tr>
<td>System Management</td>
<td>Common Profile</td>
<td>This section enables the configuration of Common Profile Switches that affect the behavior of the Argus application.</td>
</tr>
<tr>
<td></td>
<td>Switches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Workflow</td>
<td>The section enables the configuration of workflow states and rules, within the safety department starting from initial case receipt to case closure. The system enables tracking of the progress of cases between users and states of activity.</td>
</tr>
<tr>
<td></td>
<td>System Numbering</td>
<td>This section enables the administrator to specify the case numbering preferences.</td>
</tr>
<tr>
<td></td>
<td>SMTP Configuration</td>
<td>This screen enables the user to configure SMTP settings.</td>
</tr>
<tr>
<td>Tools</td>
<td>ICSR Length Check</td>
<td>This screen enables the user to view the ICSR Length Check report in PDF format.</td>
</tr>
</tbody>
</table>
Access Management

Site, group, and user configuration takes place in the Access Management section of Argus Console. Here you can add, copy or delete users, groups or sites.

Each user must be assigned to at least one group in order to determine their security level. Each group is assigned a specific security level. This security level enables members of the group to view, modify, or restrict access rights to various sections of the Case Form, and so on.

The first set of steps in configuring Argus safety is to create the following exactly in the listed order:

- Sites
- Groups
- Users

Note: The configuration must occur in the exact order specified above.

Configuring User Sites

Addition of Sites is necessary in order to create Users because every user must be assigned to exactly one Site. Site information can also be used in automatic numbering of case IDs.

To configure Sites, use the Access Management -> Argus -> Sites section. The following is an illustration of that section.

Field Descriptions
The following table lists and describes the fields on the screen.
Adding User Sites

This screen helps in capturing Site information (such as user site description, abbreviated term, site type and LAM site configuration).

Use the following procedure to add a user site.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description of the site.</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Enter an abbreviation of the site name. A one to four character abbreviation is required for each site.</td>
</tr>
<tr>
<td>Site Type</td>
<td>Select the Site Type Argus or LAM (Local Affiliate Module).</td>
</tr>
<tr>
<td>Protect Patient Confidentiality - Default</td>
<td>Protects or reveals Patient Confidentiality for the specific site.</td>
</tr>
<tr>
<td>Protect Reporter Confidentiality - Default</td>
<td>Protects or reveals Reporter Confidentiality for the specific site.</td>
</tr>
<tr>
<td>Bulk report By form (Approved reports) - Default</td>
<td>Allows or protects availability of the Bulk Reports by Form for the specific site.</td>
</tr>
<tr>
<td>LAM Sites</td>
<td>Select and add previously created LAM sites.</td>
</tr>
<tr>
<td>Site Printers</td>
<td>The Site Printers section is used to configure site printers.</td>
</tr>
</tbody>
</table>

2. In the left panel, select User Sites. The User Sites are listed in the right panel.

   **Tip:** You can alternatively click Modify to modify an existing site.
   Use Copy to make an editable copy of an existing user site.
   Use Delete to delete a user site.

3. Select a User Site and click Add New.

4. Enter the user site Description.

5. Enter the user site Abbreviation.

   **Note:** A maximum four-character abbreviation is required for each user site.

6. Select a Site Type.

   **Note:** Each Argus Safety user must be assigned to exactly one user site.
   You cannot change the site type from LAM to Central if the current central site has an association with a LAM site, the current site is associated with any user, or the current LAM site has any events assigned to it.

7. Select the following options as required:
   - Select the Protect Patient Confidentiality - Default to protect or reveal Patient Confidentiality for this specific user site.
   - Select the Protect Reporter Confidentiality - Default to protect or reveal Reporter Confidentiality for this specific user site.
   - Select the Bulk Report by Form (Approved Reports) - Default to enable availability of the Bulk Reports By Form for this specific site.

8. Add or remove any LAM Sites information.
9. In the Site Printers section, click Add to add a site printer.

10. Enter the Name of the printer that will be displayed in the application when referring to the printer. The name can have up to 20 characters.

11. To delete a site printer, select the printer and click Delete.

12. Click Print to print the site information, as shown below:

![Site Information Capture](image)

13. In the Path textbox, enter the full path of the printer on the network. This path name can have upto 256 characters. The specified path should be accessible from the machine where Argus Safety Service is installed.

14. Click Save to save the information and return to the Code List Maintenance dialog.

**About Filtering Criterion** The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Access Management section. The filtering browser is displayed as the **Code Filter List**

Argus Console helps you to filter information further for the Access Management section. Using the **Code Filter List** you can specify whether your search should contain or start with specific alphabets.

*For Example:* The following filtering criteria enables the system to search for all User Sites that contain A in the abbreviated term.

![Filter Criteria](image)

The right panel now displays the list of User Sites based on the filtering criterion.
Configuring Groups

Each user of Argus Safety can be a member of one or more user groups. The access rights of each user group to the menus in the user interface and specific sections of the Case Form can be configured when the group is created.

Configuration of the user site is done using the Access Management->Argus -> Groups section.

Field Descriptions
The following table lists and describes the fields in the Modify Group Information section.
Adding User Groups

This section enables the Administrator to configure the security levels for each work group.

Radio buttons enable you to view the group and assign access rights for several specific sections of the case form, menu, case workflow, and report workflow.

If a user belongs to multiple groups, the access rights for the user will be the sum-total of the individual group access rights. Consider the following example:

John Smith is an Argus User and his profile has been added to 2 user groups with different access level permissions for each group.

- John has access rights to the Patient Tab in one group and access rights to the General Tab in another group.
- In this case, John will be able to access both the Patient and the General tabs of Argus.

Use the following procedure to create a user group

2. Select the filtering criterion to display the list of Groups or Users in the left panel.
3. Select a Group and click to view the group details in the right panel.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>Enter a unique name for the group.</td>
</tr>
<tr>
<td>Email</td>
<td>Add the group email, used for case priority notification and workflow routing notification.</td>
</tr>
<tr>
<td>Supervisor Email</td>
<td>Add the Group’s Supervisor Email as applicable. This e-mail address is used to send notifications when the maximum time of a case for a particular workflow state is exceeded.</td>
</tr>
<tr>
<td>Menus</td>
<td>Lists the menus and sub menus within a Case Form and allows you to enable or disable each of them.</td>
</tr>
<tr>
<td>Case Form</td>
<td>Lists the sections and sub sections within a Case Form and enables you to assign the group Modify; View (Read Only); or No Access (not visible) to each area.</td>
</tr>
<tr>
<td>Advanced Condition</td>
<td>Allows you to configure advanced condition settings, as applicable. The options are: No Access to Create Advanced Conditions, No Access to Share Advanced Conditions, No Access to View and Edit SQL.</td>
</tr>
<tr>
<td>Listedness</td>
<td>Assigns Argus users to the group that has rights to change the listedness determination for licenses originating in the selected countries.</td>
</tr>
<tr>
<td>Listedness -</td>
<td>Countries</td>
</tr>
<tr>
<td>Restrictions -</td>
<td>Products</td>
</tr>
<tr>
<td>Restrictions -</td>
<td>Studies</td>
</tr>
<tr>
<td>Default report (LAM only)</td>
<td>Lists the expedited report forms in the drop-down list.</td>
</tr>
</tbody>
</table>

1. Click the Studies checkbox to enable the Select button
2. Click this button to view a security configuration containing a tree view list of available items
3. Select a study family to select all its constituents
4. Enter the **Group Name**. This should be a unique name associated with this Group.

5. Enter the **Email** address, if applicable.

6. Enter the **Supervisor Email** address, if applicable.

7. In the **Case Form** section, select the desired access right option (“Modify”, “View”, or “No Access”) for the group’s access to each of the listed items of Case Form.

**Tip:**
- You can alternatively click **Add Group** to create a new group.
- Use **Copy** to make an editable copy of an existing group.
- Use **Delete** to delete a group.

**Note:** The following fields are required in order to save a case: **Initial Receipt Date**, **Country of Incidence**, **Report Type**, **Suspect Product**, and **Event Description as Reported**. Therefore, the group responsible for initial case entry must have access to these fields in order to save new cases.

8. In the **Menus** section, enable or disable access of the group, to particular items in the Argus Safety menu.
In the Listedness Determination section, select a list of countries. This enables the end user to override the listedness determination in the Event Assessment section of the Case Form for product licenses that match the countries selected in this step.

In the Advanced Conditions section, select No Access to Create Advanced Condition, No Access to Share Advanced Conditions, and/or No Access to View and Edit SQL.

Note: Only trusted users should be given access to Advanced Conditions. This is because users who have this access will have complete access to the information in the Argus Schema.

Tip:
- If you select No Access to Create Advanced Condition, Advanced Conditions does not appear as an option for that user group.
- If you select No Access to Share Advanced Conditions, the user group does not have access to share Advanced Conditions.
- If you select No Access to View and Edit SQL, the SQL... button will not appear as an option for that user group.

In the Restrictions section, select Products.

Click Add Product, to open the Available Products dialog box.

Select each product you want to add and click OK.
14. In the **Restrictions** section, select **Study**.

15. Click **Add Study**, to open the **Available Studies** dialog box.

16. Click the appropriate checkboxes to select the required studies and click **OK**.

![Available Studies dialog box](image)

17. Click **OK** to save the group.

**Groups Included with the Factory Data** The following table lists and describes the groups included with the factory data.

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>This group has access rights to all areas and all the functionality of Argus Safety.</td>
</tr>
<tr>
<td>Investigator</td>
<td>Receives an e-mail alert that can be set up during Clinical Study Configuration.</td>
</tr>
</tbody>
</table>

**About Filtering Criterion** The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Access Management section.

**Using Organized by**
The system displays the filtering browser in the top-left corner of the left panel. You can filter based on either of the two combination shown in the following illustration.

![Filtering browser](image)

Consider the following,
If you enable **Organized by Groups**, the generated output displays in a tree-format in the left panel. The structure is based on the entire categorization of Groups and Users.

If you enable the **Organized by Users**, only the User list is available in the tree view in the left panel.

Using **contains or starts with** enables you to specify whether your search should contain or start with specific alphabetic characters. For example, filtering criterion shown in the following illustration enables the system to for all Groups that contain the word "administrator."

![Browser](image)

**Printing a User Group**

Use the following procedure to print a user group.

1. Select **Access Management->Argus->Groups**.
2. Select the filtering criterion to display the list of Groups or Users (based on the filtering criterion) in the left panel.
3. Select a **Group** and click to view the group details in the right panel.
4. Click **Print** to display a **Print** dialog that enables the user to choose to print the entire window or to print only the text covered by the current selection.

![Print](image)

5. Select the appropriate options and click **OK**.
6. The system opens the **Print Groups** to enable the user select the sections to be printed in the **Group Configuration** printout.
   
   By default, the **Group Information** checkbox is selected and disabled so that it always gets printed.
7. Select the appropriate checkboxes, and click **OK**.
Group Configuration Print Out  The following is an illustration of the Group Configuration printout.

- It lists the users which are configured to the groups.
- User are sorted alphabetically by User Full Name in the report section

<table>
<thead>
<tr>
<th>Users</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>User ID</td>
<td>Site</td>
</tr>
<tr>
<td>John Smith</td>
<td>Johns</td>
<td>United States</td>
</tr>
</tbody>
</table>

About Filtering Criterion  The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Access Management section.

Using Organized by
The system displays the filtering browser in the top-left corner of the left panel. You can filter based on either of the two combinations.

Consider the following.

- If you enable Organized by Groups, the generated output displays in a tree-format in the left panel. The structure is based on the entire categorization of Groups and Users
- If you enable the Organized by Users, only the User list is available in the tree view in the left panel.

Using contains or starts with enables you to specify whether your search should contain or start with specific alphabetic characters. For example, filtering criterion
shown in the following illustration enables the system to for all Groups that contain the word "administrator."

Configuring Users

User Maintenance enables you to add, copy, or delete users for the system.

- Each user must be assigned to at least one group in order to determine security level.
- Each group is assigned a specific security level that defines whether group members can view, modify, or have no access rights to various sections of the case form, etc.

Configuration of the users is done using the Access Management->Argus->Users section. If the Enable LDAP Login checkbox is not checked, you can specify a password when creating or modifying an individual user account. When updating user records, be aware of the following:

- If you enter a value in the Password field, the system uses this password to authenticate at login.
- The Reset Password field is available only when you select Reset Password. The new password can be up to 30 characters.
- If you leave the value blank, the system uses the default password as defined in the Common Profile for the system.
- When you save the user configuration, the system saves the default password you enter.
- During entry, the system displays the password you type.

The following illustration shows the fields associated with this section.

Field Descriptions

The following table lists and describes the fields in the Administrator section.
<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Enter the full name.</td>
</tr>
<tr>
<td>User ID</td>
<td>Enter a unique user identification (ID).</td>
</tr>
<tr>
<td>Reset Password</td>
<td>Reset the password of a user to a default value specified in the common profile section.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enter the user's e-mail address.</td>
</tr>
<tr>
<td>Site</td>
<td>Assigns the user to a site. The values in this field are populated from the codelist item User Sites.</td>
</tr>
<tr>
<td>User Group - Select</td>
<td>Attaches the user to pre-configured user groups.</td>
</tr>
<tr>
<td>User Type</td>
<td>Select the type of user, such as an Argus J user from the drop-down list.</td>
</tr>
<tr>
<td>User Roles - Select</td>
<td>Attaches the user to pre-configured user roles such as Global Admin. By default, a Global Admin role is granted to only an Administrator, who can grant/revoke this role to other Argus users. Such a user role should be assigned to users who need access to the Argus Global application. Similarly, you can also select from other roles present within User Roles.</td>
</tr>
<tr>
<td>Application Access</td>
<td>Configure user access settings for Argus Console and Argus Safety. The default application access for the user can be selected from the list.</td>
</tr>
<tr>
<td>Worklist to display at login</td>
<td>Configure users to see their worklists immediately upon login. The options are:</td>
</tr>
<tr>
<td></td>
<td>■ None (default) - Does not open any worklist when the user logs into Argus. Displays personal Argus status on login.</td>
</tr>
<tr>
<td></td>
<td>■ Action Items - Opens Worklist - Action Items screen for the user on login into Argus</td>
</tr>
<tr>
<td></td>
<td>■ New - Opens Worklist - New screen for the user on login into Argus</td>
</tr>
<tr>
<td></td>
<td>■ Open - Opens Worklist - Open screen for the user on login to Argus</td>
</tr>
<tr>
<td></td>
<td>■ Reports - Opens Worklist - Reports screen for the user on login into Argus</td>
</tr>
<tr>
<td>Enable site security</td>
<td>If Enable Security is checked, the site-based data security will be enabled for the user. If the box is not checked, the user will have full access to data from all sites.</td>
</tr>
<tr>
<td>Enable LDAP Login</td>
<td>Authenticates users against the active directory server. When Enable LDAP Login is selected, all fields inside the Access section are disabled, excluding the Account Disabled option.</td>
</tr>
<tr>
<td>Account Disabled</td>
<td>When this option is selected, the user account is temporarily disabled to prevent users from logging in. This option is different from deleting a user as it enables the Administrator to re-activate the account at a later date.</td>
</tr>
<tr>
<td>Security Disabled</td>
<td>■ When unchecked, the login procedure keeps track of the number of consecutive unsuccessful attempts at logging into the system. If the count reaches three, the login procedure will always fail the password validation to lock the user out. Administrators with rights to user maintenance can reset the login attempts for the user to unlock the account.</td>
</tr>
<tr>
<td></td>
<td>■ When checked, the login procedure that tracks the consecutive unsuccessful attempts at logging into the system do not apply.</td>
</tr>
<tr>
<td>Field/Control Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Force password change at login</td>
<td>If this check box is selected, the users must change the password the first time user logs on to the system after the checkbox is checked.</td>
</tr>
<tr>
<td>Force password to expire every</td>
<td>Enables the Administrator to force the user’s password to expire in the specified number of days.</td>
</tr>
<tr>
<td>Days</td>
<td>Enables the Administrator to enter the number of days after which the password should expire.</td>
</tr>
<tr>
<td>__ Days remaining</td>
<td>The field displays the number of days remaining for the password change.</td>
</tr>
<tr>
<td>Allow unblinding of cases</td>
<td>Enables the user to unblind a study case.</td>
</tr>
<tr>
<td></td>
<td>For example, a user <strong>without</strong> unblinding rights will not see the Study Drug field. A user with unblinding rights sees a yellow Unblind tag next to concentration of product field and the Broken by Sponsor option in Blinding Status drop-down list is enabled. User will have to enter password when user selects Broken by Sponsor’ option.</td>
</tr>
<tr>
<td>Protect from unblinded information</td>
<td>When checked, the user cannot view any unblinded information.</td>
</tr>
<tr>
<td>Protect from printing unblinded information</td>
<td>When checked, the user cannot print any unblinded information.</td>
</tr>
<tr>
<td>Allow locking of cases</td>
<td>Enables the user, to lock/unlock the cases.</td>
</tr>
<tr>
<td>Allow local locking</td>
<td>Enables the user, to locally lock/unlock a case for which local Japan data entry/assessment is complete, triggering the scheduling and/or generation of the applicable local reports.</td>
</tr>
<tr>
<td>Allow Forced unlock (Global and Local)</td>
<td>Allows the user to forcibly unlock a case that been globally and/or locally locked but pending report generation.</td>
</tr>
<tr>
<td></td>
<td>This option is enabled only if the Allow locking of cases checkbox (above) is checked and only if DLP is not enabled for Expedited Reporting.</td>
</tr>
<tr>
<td></td>
<td>If the Argus Console &gt; Access Management &gt; Users &gt; &quot;Allow locking of cases&quot; is unchecked by user or if the profile switch &quot;DLP_EXPEDITED_E2B_REPORTS&quot; is set to 1 (i.e., enabled), then this option is also unchecked and disabled.</td>
</tr>
<tr>
<td></td>
<td>If the profile switch &quot;DLP_EXPEDITED_E2B_REPORTS&quot; is set to 1 (i.e., DLP is enabled for Expedited Reporting), this option is not applicable. So Case unlock occurs irrespective of this switch when DLP_EXPEDITED_E2B_REPORTS is set to 1.</td>
</tr>
<tr>
<td></td>
<td>Note that it is not expected that the system automatically updates the new switch to unchecked and disabled for all users if the customer updates the profile switch &quot;DLP_EXPEDITED_E2B_REPORTS&quot; to 1 via backend update.</td>
</tr>
<tr>
<td>Allow Global Unlock on Pending Local Lock</td>
<td>Allows users to be set up with the privilege to forcibly unlock a case that is still pending a local lock.</td>
</tr>
<tr>
<td></td>
<td>This option is enabled only if the Allow locking of cases checkbox (above) is checked.</td>
</tr>
<tr>
<td>Allow closing of cases</td>
<td>Allows the user to close the cases.</td>
</tr>
<tr>
<td>Route on close case</td>
<td>Opens a routing dialog when the user closes the case.</td>
</tr>
</tbody>
</table>
Use the following procedure to print users.

1. Select **Access Management > Argus > Users**.
2. Select a **User** and click to view the user details in the right panel.
3. Click **Print** to display the **Print User** dialog.
4. Click OK to display list of **Print User** options.
5. Select the appropriate option(s) and click OK.
## User Configuration - Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise User</td>
<td>This privilege allows administrators to configure a workflow manager user as an Enterprise user. If Enterprise role is assigned, the user can view cases of any site outside its site.</td>
</tr>
<tr>
<td>ESM Admin</td>
<td>This privilege allows the user to access the Interchange Mapping utility in the Argus Console.</td>
</tr>
<tr>
<td>Copy Configuration</td>
<td>This privilege lets you copy all the configuration data from the enterprise where they have this role to any new enterprise that they create through the Global Enterprise Management portlet. The factory data Administrator user has this role enabled by default.</td>
</tr>
<tr>
<td>Global Admin</td>
<td>This privilege lets the administrator allow users to be designated as Global Users for selected enterprises and not necessarily all enterprises.</td>
</tr>
<tr>
<td>AC Library Admin</td>
<td>This privilege lets the administrator allow users to perform specific operation on ACs such as re-assigning the ownership, grant access to various user groups using Permission, Modification, and Deletion.</td>
</tr>
<tr>
<td>Workflow Manager</td>
<td>This privilege allows the users to perform specific workflow operations such as routing cases to any workflow state, routing cases to user, viewing all open cases and all action items present in the system, changing the priority of a case and changing the assignee of an action item or a case.</td>
</tr>
</tbody>
</table>
About Business Configuration

This section explains the Business Configuration of the Argus Console, categorized into the following modules:

<table>
<thead>
<tr>
<th>Section</th>
<th>Sub-Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Configuration</td>
<td>Products and Licenses:</td>
<td>This section helps in capturing Product Details such as product specifics, product licenses and products involved in the studies. These can be the products marketed, or under investigation, by the company. Refer to the following sections for further information on: - Configuring Product Families - Configuring Products - Configuring Licenses</td>
</tr>
<tr>
<td>Studies</td>
<td></td>
<td>This section helps in capturing Study information such as study specifics, products involved in the study licensed countries associated with the study and the clinical references used in the expedited reports.</td>
</tr>
<tr>
<td>Expedited Report Rules</td>
<td></td>
<td>This section helps in capturing Expedited Reporting Rule configuration. The Reporting Rules configuration feature enables the administrator to define the reporting rules or criteria for the cases to be qualified for expedited reporting.</td>
</tr>
</tbody>
</table>

Editable and Non-editable Business Configuration Sections

Each of the three Business Configuration sub-sections supports various views for efficient access to data. Each view consists of a hierarchical tree-structure comprising various nodes such as Family, Product, Licenses, and Countries.

The following table list which nodes can be edited and which cannot.
<table>
<thead>
<tr>
<th>Business Configuration Sub-Section</th>
<th>Organized By</th>
<th>Node</th>
<th>Editable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products and Licenses</td>
<td>Family / Product / Licenses</td>
<td>Family</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Product</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Licenses</td>
<td>Yes</td>
</tr>
<tr>
<td>Product / Licenses</td>
<td></td>
<td>Product</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Licenses</td>
<td>Yes</td>
</tr>
<tr>
<td>License / Products</td>
<td></td>
<td>License</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Products</td>
<td>Yes</td>
</tr>
<tr>
<td>Countries / Licenses</td>
<td></td>
<td>Countries</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Licenses</td>
<td>No</td>
</tr>
<tr>
<td>Countries / License Type / Licenses</td>
<td></td>
<td>Countries</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>License Type</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Licenses</td>
<td>No</td>
</tr>
<tr>
<td>Studies</td>
<td>Projects / Studies / Products</td>
<td>Projects</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Studies</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Products</td>
<td>No</td>
</tr>
<tr>
<td>Studies / Products</td>
<td></td>
<td>Studies</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Products</td>
<td>No</td>
</tr>
<tr>
<td>Products / Studies</td>
<td></td>
<td>Products</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Studies</td>
<td>No</td>
</tr>
<tr>
<td>Countries / Projects / Studies</td>
<td></td>
<td>Countries</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Projects</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Studies</td>
<td>No</td>
</tr>
<tr>
<td>Expedited Report Rules</td>
<td>Country / License Type / Reporting Rule</td>
<td>Country</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>License Type</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Rule</td>
<td>Yes</td>
</tr>
<tr>
<td>License Type / Reporting Destination / Reporting Rule</td>
<td>License Type</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Destination</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Rule</td>
<td>Yes</td>
</tr>
<tr>
<td>Responsible Group / Reporting Rule</td>
<td></td>
<td>Responsible Group</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Rule</td>
<td>Yes</td>
</tr>
<tr>
<td>Inactive Rules</td>
<td></td>
<td>Country</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>License Type</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Rule</td>
<td>Yes</td>
</tr>
<tr>
<td>Active Rules</td>
<td></td>
<td>Country</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>License Type</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reporting Rule</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Type Ahead Fields
Some fields in the Business Configuration section of Argus Console are enabled with Type Ahead-input. This means that these fields are equipped with the ability to guess what the user is typing.

Based on the text being entered, this feature provides suggestions for the user to choose from.

The following fields have the type-ahead feature:

- Clinical Reference Type (Under ClinicalStudies Configuration)
- Ingredients (Under Product Family Configuration)
- Manufacturers (Under Product and License Configuration)
- Project ID (Under Clinical Studies Configuration)
- Reporting Destination (Under Expedited Reporting Rules)

Additional Comments Fields
Be aware of the following:

- The system has a Comments field that accommodates a maximum of 1000 characters on the Product Family, Product, and License and Study configurations.
- The Product Configuration permits a maximum of 50 characters in the PSUR Group Name field. Multiple blank spaces between words will cause the generation of unusable report templates.
- The License Configuration permits a maximum of 50 characters in the CTPR Group Name. Multiple blank spaces between words will cause the generation of unusable report templates.
- The Business Configuration report prints the Comments field, and the system tracks any changes made to these fields in the audit log.

Configuring Product Family
Each company has a set of products to sell and a set of processes unique to its business. The Administrator should be aware of the company business processes and/or workflow rules. The manner of product configuration in Argus Safety will depend on how the company handles its internal workflow related to the release of a product.
Details of the company’s products can be added in Argus Safety using the Business Configuration section. This feature helps end-users to retrieve details of company products, without entering significant product information for each case.

Every company product should belong to a product family. Each product within a product family shares the same key ingredient and data sheets but can have a different concentration for the key ingredient.

Configuration of the product is done in the Business Configuration->Products and Licenses section.

The following illustration shows the fields associated with this section.

**Field Descriptions**

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Family Name</td>
<td>Enables the user to enter a new product family name.</td>
</tr>
<tr>
<td>Product Group</td>
<td>Enables the user to select a product group name.</td>
</tr>
<tr>
<td>Ingredient Name</td>
<td>Enables the user to select the multiple key ingredients for the product family</td>
</tr>
<tr>
<td></td>
<td>- The user can sort the field alphanumerically.</td>
</tr>
<tr>
<td></td>
<td>- Sorting on the ingredient name in the Product Family Configuration updates the sort order in all the products which are part of the same family</td>
</tr>
<tr>
<td></td>
<td>- A maximum of 25 items are displayed as the search results in the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- The Key Ingredients drop-down list enables the user to enter up to 20 active ingredients for a product family.</td>
</tr>
</tbody>
</table>

**Adding Product Families**

The screen helps in capturing the Product Family information. As per the Argus data model, the Product Family adds the Ingredients, Data Sheets, and the Product group.

Products are associated with Product families and are created using the Data Sheets, Dosage form, Strength and unit of the corresponding Product Family. The Product Group field in the Product Family configuration screen enables the Argus administrator to group the product families into various Product Groups.

Use the following procedure to add a product family.

1. In the Business Configuration section, select **Product and Licenses**.
2. In the left panel, select a filtering criterion. The left panel now displays the tree view of the Family based on the filtering criterion.
3. Select a Product Family and click to view the product family details in the right panel.

**Note:** Ensure that you select the top-level folder to view the details of the product family.

Product family details appear in the right panel.
Tip:
- You can alternatively click Add Family to create a new family of products.
- Use Copy to make an editable copy of an existing product family.
- Use Copy with Datasheets to make an editable copy of an existing product family, along with all associated datasheets.

4. Enter the Product Family Name as applicable.
5. Select the Product Group from the drop-down list. This helps you to group the product families into various product groups.
6. Select the required Ingredient Name(s) displayed under the Key Ingredients section.
7. Select the required Datasheet configuration.
8. Click Save to save the changes made to the Product Family.

Tip: If you have added a new Product Family, click Add Family to save the new Product Family.

About Filtering Criterion
The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Business Configuration section.

Using Organized by
The filtering browser is displayed in the top-left corner of the left panel. The Products and Licenses section can be filtered based on any of the three combinations shown in the following illustration. Consider the following:
- If you enable Organized by Family/Product/License, then the generated output will be visible in a tree-format in the left panel.
- If you enable the Organized by Product/License, only the Product and License views are available in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business Configuration section. Once you have selected the Organized by, you can specify whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to search for all Family/Product/License data that contains the term Cure.
Creating Data Sheets
Packaged medications (like prescriptions) are marketed with an insert sheet that lists the known contraindications (side-effects) that may occur as a consequence of taking the product. These inserts are also referred to as data sheets. It is important to list these effects in order to ensure accuracy in reporting. An inaccurate report could result in the wrong action taken or bring harm to a patient.

The Listed Events & Indications from the data sheet determine the listedness of the adverse event(s) for the case. Depending on the configured regulatory report rules, the listedness determination will automatically schedule the expedited reports.

The data sheet in the Product Family is configured using the Business Configuration -> Products Family section.

Field Descriptions
The following table lists the Field Descriptions for this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Enables the user to rename the datasheet.</td>
</tr>
<tr>
<td>Activate Data Sheet</td>
<td>Enables the user to activate the current data sheet. Be aware of the following:</td>
</tr>
<tr>
<td></td>
<td>■ When you click the checkbox, the system enables the radio buttons next to Activate Data Sheet.</td>
</tr>
<tr>
<td></td>
<td>■ You can either select the option to activate the data sheet with Terms added on the current dates or on another date entered in the Other Date field.</td>
</tr>
<tr>
<td></td>
<td>■ Once the datasheet is activated, the system disables the Activate Datasheet text box.</td>
</tr>
<tr>
<td></td>
<td>■ If you enter a date greater than the current system date, the system permits you to enable the activation date.</td>
</tr>
<tr>
<td>Core Sheet</td>
<td>The Core Sheet checkbox enables the user to indicate that this data sheet is the central data sheet. This checkbox is disabled if another data sheet is marked as the core data sheet.</td>
</tr>
</tbody>
</table>
Include

The Include checkbox enables the user to indicate that this data sheet includes the particular datasheet selected in the drop-down list. Be aware of the following:

- The system populates the drop-down list with the list of datasheets that do not include other data sheets.
- The system enables the drop-down list only when the include checkbox is checked.

If a product family has a single datasheet that is marked 'Core', the system disables the Include checkbox.

Other Date

This radio button is enabled if the current date is not to be selected. Select this checkbox and enter any other date, as required.

Global / No local labeling assessment required

Checking this option automatically marks any license using this data sheet, as assessed, and the license does not require any local labeling assessment.

Notes

On clicking the notes icon, a pop-up appears to enable users to enter notes while entering the details of the Datasheet.

Listed Term

This field displays the listed terms (Preferred Term) for the datasheet.

View Revisions

Enables users to view a list of term that were added or removed with the added date.

The View Revisions dialog displays the datasheet revisions, as shown below:
Use the following procedure to create a datasheet.

1. In the **Datasheet** section of the **Product Family** section, click **Activate Datasheet** to activate the data sheet associated with the Product Family.

2. Select the **Core Sheet** check box, if this data sheet is required to be the core data sheet. Only one core data sheet is allowed per product.

3. Select the **Include** check box and select the value from a drop-down list. This helps you to indicate that this data sheet includes the particular datasheet selected in the drop-down list.

4. Select **Global/No local labeling assessment required** to automatically mark any license using this data sheet as assessed.

5. Click **Add Term** to select the listed terms (Preferred Term) for the datasheet. The MedDRA browser appears.

---

**Note:** In order to facilitate optimum system performance, you can configure a limit on the number of revised terms that get displayed. If, for example, this value is set to 1000, the datasheet will display only 1000 revised terms in the list. This value is configurable in web.config by using the keyname **DataSheetRevisionTermCount**. The default value is 1000.

Click **Print** to view all other revised terms.
6. The MedDRA Browser available for Datasheets enables the administrator to select either multiple or all Preferred Terms (PTs) in the following way:
   - Click the required High Level Term (HLT) and select multiple PTs by clicking on each required PT.
   OR
   - Right-click the HLT to select all entities available under PT.
7. Select the Preferred term from the MedDRA browser and click Select.
   **Tip:** You can alternatively click Select and Close, in the MedDRA browser to save and exit the Product Family screen.
   You can use Delete Term to delete the selected listed term(s) from the datasheet.
8. Click Select from the Event Groups tab of Datasheet to select an event group. The Event Group Selection window appears.
9. Press Save to save the data sheet. The Data Sheet name displays in the Data Sheets list.
   **Tip:** To view the revision history associated with a Datasheet, click Revisions. A pop-up appears containing the following information:
   - Rev. No: Displays the revision number of the datasheet. This number is updated each time the data sheet is activated
   - Terms: Displays all the terms that were added / removed. In case a term has been deleted, it is marked with * against the term name.
   - Added On: Displays the date when the terms were added in the datasheet
   - Active On: Displays the date when the datasheet was made active for that revision

**Configuring Products**

Each company has a set of products to sell and a set of processes that are unique to its business.

The manner of product configuration in Argus Safety depends on how the company handles its internal workflow, related to the release of a product. Therefore the Administrator should be familiar with the business processes or workflow rules of the company.

Configuration of the product is done in Business Configuration -> Products and Licenses.

When configuring a product, be aware of the following:
   - When the user clicks the Notes link on a data sheet, he/she can enter a maximum of 2000 characters in the Preferred Terms section of a data sheet as shown in the following illustration.
   - When the user clicks the Notes link, he/she can enter one note for each term.
   - The user can use the standard spell check function.
- If notes have been entered for the term, the system displays the Notes icon to indicate that notes are present.
- The system also prints the notes on the **Product Family** details.
- A comments field that can contain up to 1000 characters has been added to the **Product Family/Product/License** and **Study** configuration elements.
- The **Product** configuration also has a 50 character PSUR Name.
- The **Business Configuration** reports print the contents of the **Comments** fields.
- The system tracks any updates made to the datasheets in the audit log.

The following illustration shows the fields associated with this section.

### Field Descriptions

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Family Name</td>
<td>Enables the user to enter the unique family name for the product. The Product Family Name must be of at least five (5) characters.</td>
</tr>
<tr>
<td>Product Group</td>
<td>Select the product group for the product.</td>
</tr>
<tr>
<td>Ingredient Name</td>
<td>Displays the Ingredients of the Product Family to which the Product belongs. The user can alphanumerically sort the field. Sorting on the ingredient name in the Product Configuration updates the sort order in the corresponding Product Family and all the other products which are part of the same family.</td>
</tr>
<tr>
<td>Datasheet</td>
<td>To view the description of the fields of this section, see Creating Data Sheets.</td>
</tr>
</tbody>
</table>
About Business Configuration

Adding Products

This screen helps in capturing Product Details (product specifics, product licenses, products involved in the studies. These can be the products marketed, or under investigation, by the company. Every company product should belong to a product family. Each product within a product family shares the same key ingredient and data sheets but can have a different concentration for the key ingredient. This data is reflected in multiple expedited and periodic reports and case form-general information section.

Use the following procedure to add a product.

1. In the Business Configuration section, select **Product and Licenses**.
2. In the left panel, select a filtering criterion.
3. Select a Product and click to view the product details in the right panel.
4. The details of the product appear in the right panel.

   **Tip:**
   - You can alternatively click **Add Product** to create a new product.
   - Use **Copy** to make an editable copy of an existing product.
   - Use **Copy with Licenses** to make an editable copy of an existing product, along with all associated licenses.

5. Enter the **Product Name** and **Product Abbreviation**.
6. Enter the **Dose** information associated with the **Ingredient Names** in the **Key Ingredients** section.
7. Select the **Unit** information from the drop-down list, associated with the **Ingredient Names** in the **Key Ingredients** section.
8. Enter the **Generic Name**.

---

**Field Name** | **Description**
--- | ---
Preferred Terms | Displays the Listed Term (Preferred Term) for the product, as described in the field description table under Creating Data Sheets.
Event Groups | The Event Group, selected from the Select button > Available Event Groups dialog, is displayed as follows:
   - Event Group Name in English
   
   The event group name is displayed in the following format for Japanese users:
   - Event Group Name in English (Event Group Name in Japanese)

   The count of the total number of Event Group Names present for the case is displayed on the header of the Event Groups tab.

   For more details about Event Groups, see the section Event Groups tab under Configuring Event Groups.

---
Tip: To copy all the Key Ingredients entered in the previous section, click Copy From Ingredients. This helps you to modify the list as required, instead of entering all the names manually.

9. Enter the Dosage Formulation.

10. Enter the Strength of the dosage and select the Units from a drop-down list.

11. Click Encode to enter the Primary Indication. This enables you to display a primary indication for the product using either the MedDRA or the ICD-9 Dictionary.

12. Enter the Model # number associated with the product.

13. Select the Manufacturer from the drop-down list.

14. Click Select icon to select the WHO Drug Code associated with the product.

15. Enter the Company Code allotted for the product.

16. Enter the Lot# and Date associated with the Product.

Tip: You can click Add to add new Lot# numbers. If you wish to add the current date in the Date field, use the = sign on your keyboard as a short-cut.

17. Click Save to save the product details.

Tip: If you have added a new Product, click Add Product to save the new Product.

About Filtering Criterion The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Business Configuration section.

Using Organized by
The filtering browser displays in the top-left corner of the left panel. The Products and Licenses section can be filtered on the basis of any of the three combinations displayed below. Consider the following:

- If you enable Organized byFamily/Product/License, the generated output is visible in a tree-format, in the left panel.
- If you enable Organized byProduct/License, only the Product and License views are in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business Configuration section. Once you have selected the Organized by, you can specify whether your search should contain or start with specific alphabets.

For example, the filtering criterion defined in the following illustration searches for all Family/Product/License data that contains the term Cure.

The left panel now displays the tree view of the Product Family->Product based on the filtering criterion.

Tip: The number displayed next to the folder signifies the number of licenses within that product.
Configuring Licenses

Once product configuration is complete, you must create product licenses. Licenses are issued for pre-market and post-market release of a drug, device, or vaccine. Investigational (pre-market) licenses are issued for studies done at study centers and marketed licenses are issued for release of product. Configuration of licenses related to a product is a key step in the configuration of Argus Safety.

Configure licenses in the Business Configuration -> Products and Licenses section.

The following illustration shows the fields associated with this section.

Field Descriptions

The following table lists the Field Descriptions for the License configuration section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trade Name</td>
<td>Enables the user to enter the Trade Name under which this product(s) is (are) authorized by this license.</td>
</tr>
<tr>
<td>Award Date</td>
<td>Enables the user to enter the license award date for this license.</td>
</tr>
<tr>
<td>Withdrawn Date</td>
<td>Enables the user to enter the license withdrawal date for this license. The withdrawn date cannot be less than the award date.</td>
</tr>
<tr>
<td>Market Authorization Holder</td>
<td>Enables the user to select a manufacturer or co-marketing partner for this license of the product.</td>
</tr>
<tr>
<td>Biologic / Vaccine</td>
<td>Whether the license is for a Biologic/Vaccine (this can impact reporting rule). If this is option is checked MedWatch will print PLA# not NDA# in section G5. It is included to support the Biologic License Application (BLA) and the Product License Application (PLA) requirements.</td>
</tr>
<tr>
<td>Field/Control Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Not in Tradename lookup / Not Auto-scheduled</td>
<td>An option to indicate that this license name should not appear in the filter criteria for Auto Scheduling of Reports or trade name lookup browser. When this checkbox is checked, the trade name will not appear for this license in the Trade Name Lookup dialog and this license will not be evaluated or allowed for auto scheduling of the reports, but will be available for manual scheduling of reports. The license will be displayed in event assessment.</td>
</tr>
<tr>
<td>Labeled for Single Use</td>
<td>Whether the drug is for single use (such as disposables) If this option is selected it will mark YES in section H5 of the MedWatch device form, otherwise it will mark NO.</td>
</tr>
<tr>
<td>OTC Product</td>
<td>This enables the user to specify if the Product has been bought as an Over-the-Counter Product.</td>
</tr>
<tr>
<td>Datasheet URL</td>
<td>User can enter a hyperlink to a site giving information about the datasheet of the product.</td>
</tr>
<tr>
<td>Authorization Country</td>
<td>This enables the user to select the Country for which this license applies. The chosen country does not impact the reporting rules algorithm. This field maps to the Country field in the Reporting rules configuration.</td>
</tr>
<tr>
<td>License Type</td>
<td>The user can select one of the possible six types: Investigational Drug/Device/Vaccine or Marketed Drug/Device/Vaccine The chosen license type maps to the License type field under each country on the Reporting rules configuration.</td>
</tr>
<tr>
<td>Datasheet Name</td>
<td>The datasheet drop-down enables the user to associate a datasheet with the License. The field lists the datasheets for all the product families of the added products. The Data Sheet drop-down is enabled when one or more products have been added to the Products list.</td>
</tr>
<tr>
<td>Application Type</td>
<td>Enables the user to license application type such as IND, NDA, STN etc.</td>
</tr>
<tr>
<td>License #</td>
<td>Enables the user to enter the License Number of the Trade name.</td>
</tr>
<tr>
<td>Company Item Number</td>
<td>Enables the user to enter the Company Item number corresponding to the license.</td>
</tr>
<tr>
<td>Countries List</td>
<td>Enables the user to select all the countries in which the same license was issued. The system adds the authorization country to the Countries Lise and updates the list when the user updates the authorization country.</td>
</tr>
<tr>
<td>TIKEN</td>
<td>Selecting the TIKEN checkbox indicates that the customer will not send the investigational report for the other license.</td>
</tr>
<tr>
<td>Status Category of New Drugs</td>
<td>The Status Category of New Drugs field captures the Status category of new drugs. This information is transmitted in the J.2.4k element of PMDA E2B R3.</td>
</tr>
<tr>
<td>Risk Category of OTC Drugs</td>
<td>The Risk Category of OTC Drugs field captures the risk category of OTC drugs. This information is transmitted to the J.2.5k element of PMDA E2B R3.</td>
</tr>
<tr>
<td>Product Name</td>
<td>The Product List box displays the list of products (product name, dosage form and strength) that this associated license covers for regulatory reporting purposes.</td>
</tr>
</tbody>
</table>
About Business Configuration

Adding Product Licenses

This screen helps capture License information (License specifics, associated with the License, Countries where the product is marketed or is under investigation). This data is reflected in multiple expedited and periodic reports and in case form-product information section.

Use the following procedure to add a product license.

1. In the Business Configuration section, select **Product and Licenses**.
2. In the left panel, select a filtering criterion.
3. Expand the folders till you reach the license associated with a product.
4. Select a license and click to view the license in the right panel.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide</td>
<td>When a product is marked as non display, it will not appear in the Trade Name Product lookup dialogue associated with the license tradename.</td>
</tr>
<tr>
<td>PMA/510(k)#</td>
<td>This field is associated with medical device information and prints in expedited reports.</td>
</tr>
<tr>
<td>Nomenclature Code</td>
<td>This field is associated with medical device information and prints in expedited reports.</td>
</tr>
</tbody>
</table>
| Medical Device Information | This field is associated with medical device information and can contain the following values:  
|                      | - AIMD Active Implants  
|                      | - MDD Class III  
|                      | - MDD Class IIb  
|                      | - MDD Class IIa  
|                      | - MDD Class I  
|                      | - IVD Annex II List A  
|                      | - IVD Annex II List B  
|                      | - IVD Devices for self-testing  
|                      | - IVD General  
|                      | - Class I  
|                      | - Class II  
|                      | - Class III  
|                      | - Class IV  
|                      | - Blank (default) |
| CE Marked          | CE marking is a mandatory conformity marking for certain products sold within the European Economic Area (EEA). For a Marketed or Investigational Device, this field can be set to Yes or No. For all other license types, this field is disabled. |
| CTPR Group Name    | This value is used in Argus Safety when filter periodic report data. |
| Comments           | Enables the user to enter information about the element configuration. |
| Device Company Identification# | Enables you to capture information about the Device Company Identification number. |
| Device Identification# | Enables you to capture information about the Device Identification number. |
5. The system opens the following screen:

![Screen Image]

1. Enter the **Trade Name** of the license.
2. In the **Manufacturer** list, select the manufacturer of the product.
3. Select the **Authorization Country** in which the license was issued.
4. Select the **License Type**. This is the type of license.
5. Enter the license number in **License#**.
6. If this license is to be reported under the PLA# and not the NDA# select the **Biologic/Vaccine** checkbox. If this checkbox is selected, the PLA# (and not the NDA#) will be printed in section G5 of the MedWatch form.
7. Specify if the drug is **Labeled for Single Use** or not.
8. Specify if the drug has been bought as an **Over-the-Counter (OTC) Product**.
9. Under **Award Date**, enter the date the license was granted to the manufacturer.
10. Enter the **Withdrawn** date, if applicable.
11. Enter the Company item number in **Company item number**.
12. Enter a URL reference for the license under **Data Sheet URL**. (A URL reference might be a link to product label or product information).
13. A world wide web address or an appropriate network path (For example: http://anydomainname/anypath or \FILESERVER\LOCATION) can be entered in this field.
14. Select **Not in Tradename lookup/Not Auto-Scheduled** if this license is not to be involved in reporting.
15. In the **Countries List**, select the countries that define whether the case will be classified as domestic or foreign for regulatory report scheduling algorithm.
Tip: To modify this list, use the Modify option (placed next to the Countries List).

16. Select the Data Sheet Name associated with the license, from the drop-down list.

17. Click Add in the Product Name/Dosage Form/Strength to add a product to the License

Tip: You can alternatively click Add License to create a new license. Use Copy to make an editable copy of an existing license.

6. The ProductBrowser dialog opens.
7. Enter the name (partial or full) of the product and select FullSearch.
8. Select the appropriate product in the search results and click Select. Enter all the required products in this manner.

Using the Product Browser
1. Click on Add Products to add products.
2. The Products Browser window opens:
   - Enter the Ingredient key word for the search. The ingredient is displayed in the first column.
   - Select the Ingredient to obtain the Family it is associated with.
   - Select the Product Name to view the associated Trade Names.
   - Select the Trade Name required.
3. Select is now enabled at the bottom of the window.
4. Click Select to add the product details under the Product Name section. The Product Name is displayed in under the Product Name section.
5. The product browser available for datasheets, enables the administrator to select either multiple or all Product Names as follows:
   - Click the Family name and select multiple Product Names by clicking on each required Product Name.
   OR
   - Right-click the Family name to select all entities available under Product Name.

6. Click Save to save the changes.

   **Tip:** If you have added a new License, click Add License to save the new License.

### Configuring Clinical Studies

It is important to configure clinical studies in the Argus Console because it helps the system categorize the source of information for the cases that have been registered. This screen helps in capturing Study information (study specifics, products involved in the study licensed countries associated with the study and the clinical references used in the expedited reports.

Configuration of the product is done using the Business Configuration->Studies section.

The following illustration shows the fields associated with this section.
Field Descriptions
The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study ID</td>
<td>This is the Study ID.</td>
</tr>
<tr>
<td>Project ID</td>
<td>This is the project ID for the study.</td>
</tr>
<tr>
<td>Other ID</td>
<td>Enter any other ID associated with this study.</td>
</tr>
<tr>
<td>Observe Study Type (E2B)</td>
<td>This enables the user to select the study type from a drop-down list.</td>
</tr>
<tr>
<td></td>
<td>- This element is populate from the Case From Clinical Study section of the application.</td>
</tr>
<tr>
<td></td>
<td>- The value selected in Study Configuration, Observe Study Type (E2B) is populated in the Case Form Study section when the user selects the Clinical Study.</td>
</tr>
<tr>
<td></td>
<td>- The system updates the standard E2B profiles (EMA, FDA, and ICH) to populate the tag.</td>
</tr>
<tr>
<td>Template Only</td>
<td>Select this checkbox to select only a template for the study.</td>
</tr>
<tr>
<td>Study Development Phase</td>
<td>Enables you to choose the study phase.</td>
</tr>
<tr>
<td>* Non-Interventional Study</td>
<td>Enables you to identify a study as a non-interventional study. The available options are Yes and No. The default value is set to No.</td>
</tr>
<tr>
<td></td>
<td>This field is not used in the application (Case Form, Reports) for this release.</td>
</tr>
<tr>
<td>Arms</td>
<td></td>
</tr>
<tr>
<td>Study Name</td>
<td>Enter the name of the study. This is a mandatory field. You can add upto 99 Arms to a study.</td>
</tr>
<tr>
<td>Study Type</td>
<td>Enter the type of study.</td>
</tr>
</tbody>
</table>

**Note:** The Study Name and the Study Type fields must be unique for a study.
About Business Configuration

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary License</td>
<td>Select the applicable primary license from the list of licenses available in this drop-down list. These licenses are displayed as per the products that have been selected for the Arm. This drop-down list is displayed as blank for a new Arm.</td>
</tr>
<tr>
<td>Copy</td>
<td>Click this button to copy a selected Arm.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this button to delete a selected Arm.</td>
</tr>
</tbody>
</table>

**Products**

- **Product Name (Dosage Form/Strength/Units)**: Provides information about the Product Name along with the (Product formulation/Product Concentration/Product Units).
- **Blinded**: Check this checkbox to configure a blinded study. You cannot check this checkbox if the Study Type for that Arm is not blinded.

**Note:** A **Study is eligible for Unblinding** checkbox is enabled when a study has at least one Arm with Study type as Blinded (Single/Double).

The **Study is eligible for Unblinding** checkbox should be unchecked in study configuration. If this checkbox is checked, the user will be able to see the complete case data even if he has protection enabled.

- **Product Type**: Allows you to select a Product Type from the drop-down list comprising options of 'Investigational Product', 'Placebo', and 'Comparator'.

**Clinical References**

- **Reference Type**: Shows the various reference types that can be setup for this study.
- **Country**: Enables the user to select a country for the clinical reference type.
- **Reference Number**: Captures the reference number that will be reflected on the regulatory reports.
- **Add**: Enables the user to add another clinical reference.
- **Delete**: Enables the user to delete the selected clinical reference.
- **Countries**: Enables the user to select a country for the clinical reference type.
- **License**: This is the license of the primary (company) product participating in the study.

**Product Abbreviation**: This enables the user to enter an up to 5 character abbreviation of the study name which would be used in Case numbering when Product' is selected in the system numbering configuration in case of study cases.

**Centers**: The system displays the selected study centers for the study.

**Study Description**: Enables the user to enter a brief description of the study.

- Opens the study description in zoom mode and provides a spell check dialog.

- Opens the multi-lingual dialog allowing the user to choose the language by clicking on the relevant flag of the country.
Investigator Alert Enables the user to select an existing Advanced Condition. Under Investigator alert, an advanced condition can be created / selected. When this condition is satisfied, the system automatically sends an e-mail to the investigator group associated with this study.

Investigator Alert - select Opens up the Advance Condition browser.

Study is eligible for Unblinding Check this box if the study can be unblinded. If the Study Type selected is Not Blinded”, this field is disabled. This checkbox is enabled when a study has at least one Arm with Study type as Blinded (Single/Double).

Enable Study Specific Encoding User checks this box if Study specific Auto encoding has to be enabled.

Autoencoding : Drugs(dict) If unchecked (default state) the study will use the dictionaries configured using the Case form Configuration options. If checked, the Auto encoding button is activated.

Autoencoding : Events & Indications Select this field to enable the system to encode Events & Indications using the dictionary the user selects from the list.

Study Reporting

Products - Add Product Opens the Search screen for selecting a company product.

Products - Delete Deletes the selected product row.

Inherent Reporting Rules Form This drop-down list is populated from all the Study templates which are configured for SUSAR Reports. Users can use the pre-defined SUSAR reports by selecting the applicable template from the drop-down list.

Always report Usually the study-specific reporting is configured to handle reporting requirements for non-company products, e.g. Placebo or a comparator, as the company-based reporting is taken care by the license based reporting logic utilized in Argus.

However, checking this checkbox will force Argus to check for qualifying expedited reporting rules based on the country, license type and reporting destination specified even if no non-company products are identified as study drugs.

If the checkbox is unchecked then expedited reports based on the study-specific reporting rule will only be scheduled if there is a non-company product identified as a study drug.

Country Specifies what country’s reporting rules the console should consider. The list includes countries for which the expedited reporting rules exist.

License Type Specifies what license type to consider for the specified country. Only applicable license types, i.e. Marketed Drug, Device, Vaccine or Investigational Drug, Device, Vaccine are displayed in this drop down list.

For example if a country Germany” only has reporting rules for investigation drugs, then Investigational Drug” is the valid drop-down element.
About Business Configuration

Adding Clinical Study Configurations

This screen helps capture study information (study specifics, products involved in the study licensed countries associated with the study and the clinical references used in the expedited reports). Study Information is required if a case has been reported while conducting a study and the participating product(s) belong to the company. This data is reflected in multiple expedited and periodic reports and case form-general information section.

Be aware of the following:

- The IND Reference Number drop down displays only those reference numbers (license numbers) associated with a product with a License Type of Investigational.
  - The Reference Number drop down field should be limited to IND (Investigational) US Licenses Number only.

- The Study Name on the Study Configuration can be a maximum 70 Characters (same as the Product name).

Use the following procedure to add a study:

1. In the Business Configuration section, select Studies.
2. In the left panel, select a filtering criterion.
3. Select a Study and click to view the study details in the right panel.

---

**Note:** Ensure that you select the study-level folder to view the details of the study.

4. The details of the study appear in the right panel.
5. Enter the Study ID and Study Name associated with the Study.
6. Select the Project ID for the Study, from the drop-down list.
7. Select the Study Type associated with the Study, from the drop-down list.
8. Enter the Other ID. This will be an alternative id for the Study.
9. Select Template to associate a template with the Study.
10. Select the Observer Study Type (E2B) from the drop-down list.

**About Filtering Criterion**

The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Business Configuration section.

**Using Organized by**

The filtering browser displays in the top-left corner of the left panel. The studies section can be filtered based on any of the three combinations shown in the following illustration. The generated output is visible in a tree-format, in the left panel, based on the entire categorization of Projects, Studies, Products.

**Tip:**

- You can alternatively click Add Study to create a new study.
- Click Copy to copy of the Study Name and the Study Type data to the new Study.
- Click Copy with Products to copy the Study Name and the Study Type data, as well as to copy the blinded and open products.
If you enable the **Organized by** Study/Products, only the Study and Product views will be available in the tree view in the left panel.

The Argus Console helps you to filter information further for the Business Configuration section. Once you have selected the **Organized by**, you can specify whether your search should contain or start with specific alphabets.

The filtering criterion shown in the following illustration, enables the system to search for all Projects/Studies/Products data that contain the term Cure.

The left panel displays the tree view of the **Projects/Studies/Products** based on the filtering criterion.

**Tip:** The number displayed next to the folder signifies the number of studies/products within that project/studies family.

**Adding WHO Drug Details**

Use the following procedure to add WHO Drug detail information.

1. Select **Add WHO Drug** in the Products section to add the WHO Drug details associated with the Study.
2. Click on **WHO Drug** to add WHO drug details (using the WHO Drug browser window) associated with the Study.
3. The system opens the WHO Drug browser window.
4. Select the **Trade Name** or the **Ingredient** radio-button, to search for the WHO Drug term associated with either the Trade Name or the main Ingredient of the drug.

5. Click **Search** to execute the search. The data is displayed as follows.

6. Select the required component/row (this can be the key **Trade Name** or **Ingredient**).

7. The row now appears highlighted and the **Drug Details** section displays the associated information.

8. Click **Select** to add this drug information in the **Product Name** section of the Studies Configuration window.

9. The WHO Drug browser window closes and the drug appears in the **Product Name** section.

**Adding Product Details**

Use the following procedure to add details about the Product in the Product Browser.

1. Select **Add Product** in the Products section to add the products associated with the Study.

2. Click on **Add Products** to add products. The Product Browser window appears.

3. Enter the **Ingredient** key word for the search. The ingredient is displayed in the first column.

4. Select the **Ingredient** to obtain the **Family** it is associated with.

5. Select the **Product Name** to view the associated Trade Names.

6. Select the **Trade Name** required.

7. **Select** is now enabled at the bottom of the window. Click **Select** to add the product details under the **Product Name** section. The Product Name is displayed in under the Product Name section.
Tip: To delete a product, select the product and click Delete (placed next to Add Product). A pop-up appears asking you to confirm the action.

1. Select the Reference Type associated with this Study, from the drop-down list.
2. Select the Country associated with this Study, from the drop-down list.
3. Enter the Reference Number associated with the Reference Type in this Study.

Tip:
- To add more Reference Types in the Clinical Reference section, simply click Add. A new row is added to this section.
- To delete the Reference Type, select the Reference Type and click Delete (placed next to Add). A pop-up appears asking you to confirm the action.

4. The Countries field is a display only field. You can Add or Delete this list based on your requirements.
5. Select the Product License from the drop-down list. This is the license of the primary (company) product participating in the study.
6. Enter the Product Abbreviation.
7. The Centers are displayed as per the centers you choose to associate with the Study. To modify this list, click on Modify (placed next to Centers). Using this option you can add and delete Centers associated with the Study.

Tip:
- To add more Centers to the Study Center list, use the Add>>/Add All options.
- To delete the Centers from the Study Center list, use the Delete>>/Delete All options.

8. Enter the Study Description associated with the Study.
9. Click Select placed next to Investigator Alert to select or create an Advanced Condition for this Study.
10. Select Study is eligible for Unblinding to enable the study to be unblinded.
11. Select Enable Study Specific Encoding to enable the study specific Auto Encoding.

Configuring Auto Encoding
The Auto Encoding features helps you to configure your own dictionary of encoded data. Using this enables you to:
- Configure studies to use dictionaries different from the dictionaries configured using the Case Form configuration.
- Retrieve coded Events, Drugs and Events & Indications and codes from the lists associated with this section.
- Ensure that the expedited reports display the correct verbatim and coded terms

Use the following procedure to configure Auto Encoding.
1. Click Auto Encoding to open the Auto Encoding dialog. The Auto Encoding dialog opens.

2. Select the encoding options as required for Drugs and Events & Indications. Use the items in the list to encode. For Study Encoding, go to Console -> Business Configuration -> Studies -> Study Encoding to support Central Encoding for Events & Indications for study cases, in a similar way as for non-study cases. Checking the Central Encoding checkbox (next to the Event & Indications Checkbox) also ensures that Central Encoding also gets reflected (as configured here) in the Argus Case Form, for study cases.

3. Select Prevent manual encoding for Events & Indications, if you want to disable manual encoding by users.

4. Select the Require event term encoding before case closure, to ensure that the expedited reports display the correct verbatim and coded terms.

**Note:** If this feature is not selected, then the study will use the dictionaries configured using the Case Form Configuration options.

Cases where the report type does not include clinical trial cases, will always encode with the dictionaries configured through the Case Form configuration options.
5. Select Inherit Reporting Rules From using the drop-down list to configure study-based reporting requirements.

Configuring Study Reporting

Study Reporting is provided in the Study Configuration section to configure study-based reporting requirements.

The reporting rules are not directly defined in the study, but rather identify which reporting rules to check from the already configured expedited reporting rules.

The identification is based on specifying what set of reporting rules to evaluate, as per the criteria of:

- Country
- License Type
- Reporting Destination

Use the following procedure to configure study based reporting.

1. Click Add in the Inherit Reporting Rules From section. The Study Reporting dialog opens.
2. Select Always Report as required.
   
   Tip: Select this checkbox to force Argus to check for qualifying expedited reporting rules. These rules are based on the country, license type and reporting destination specified. Refer to the Field Descriptions for details.

3. Select the Country from the drop-down list.
   
   Tip: This field specifies which country’s reporting rules should be included. The drop-down list includes countries for which the expedited reporting rules exist.

4. Select the License Type from the drop-down list.
   
   Tip: This field specifies the license type to be considered for the specified country. Refer to the Field Descriptions for details.

5. Select the Reporting Destination from the drop-down list.
   
   Tip: This field is optional.

6. The Time Frame and Possible Report Forms cannot be searched or altered, but is included for informational purposes.

   Tip:
   - To add information pertaining to inheriting reporting rules in the Study Reporting section, click Add
   - To delete information pertaining to inheriting reporting rules in the Study Reporting section, select the reporting rule and click Delete. A pop-up appears asking you to confirm the action.

7. Click Save to save the changes made to the Studies section.
**About Business Configuration**

This section describes the configuration of Expedited Reports using pre-defined rules. These reports are required by Regulatory Authorities. The Administrator is responsible for entering information about Regulatory Authorities to which regulatory reports will be submitted.

This information is entered in the **Regulatory Agency Information** screen. Information about the local company contact for a regulatory authority can also be entered in this screen.

Configuration of the expedited report rules is done using the **Business Configuration -> Expedited Report Rules** section shown in the following illustration.

When configuring expedited reporting rules, be aware of the following:

- **If the user does not have permission to access Advanced Conditions on the Expedited Reporting Rules**, the system does the following:
  - Displays the advanced condition name instead of displaying a blank.
  - **Does not** permit the user to modify or view advanced condition details.
  - Disables the **Advance Condition** button.

- The system enables the user configure the **Blinding Study Products** option for those included in the case (default unchecked).
  - The system track updates to this field in the audit log.
  - The **Reporting Rules** reports print the new options.

- For cases where expedited reports are due, the user can force-distribute expedited reports even if processing is incomplete.

- Due Dates for expedited reports differ from Country to Country regulations. For Group 1 countries, the Due Date is based on the Aware Date received globally for the case.
  
  For Group 2 countries, the Due Date is based on the Aware Date when the affiliate or a company representative of that country received information about the case.

**Tip:** If you have added a new Study, click **Add Study** to save the new Study.
In that case, the Due date for these reports could be 15 days after the report was actually generated based on the aware date received globally.

When reports are scheduled and generated, the Due Date for Group 2 countries is calculated. The Due Date for a Group 2 Country = Report Generation Date + Additional days for Group 2 countries.

The Due Date for a Group 2 country can be adjusted as per the holidays and weekends, through the Adjust Due Date for Group 2 countries by XXX days checkbox.

- The reporting rules have a Force Distribute XXX days before due checkbox. The default is unchecked.
  - If the user checks the Force Distribute option, the # of days before due field is entered and automatically checks the Auto Distribute checkbox on the reporting rule (grayed out).
  - The user can enter the number of days from 0 - # of days defined within the time frame.
  - If the user enters a value greater than the defined time frame, the system displays the following message:
    
    Please enter a value less than the Time Frame defined for the Reporting Rule.
  - If the user has not checked Force Distribute, the system disables the days before due.

- The system tracks updates made to the new Argus Console fields in the audit log.

- The system prints an audit log and print out that shows the expedited report rules information as shown in the following illustration.

- A super rule is a rule that overrides other rules when it finds a match. Be aware of the following:
  - The system executes a super rule before executing any other reporting rules.
  - If a super rule matches, it executes all the super rules but does not execute other rules.
  - If the super rule does not match, the application executes the other rules.
### Field Descriptions

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>Enables the user to view or enter the name of the Report.</td>
</tr>
<tr>
<td>Report Destination</td>
<td>Enables the user to select the name of the agency to which the report will be scheduled.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the user to specify whether the configured rule is active or inactive.</td>
</tr>
<tr>
<td></td>
<td>- Only active rules are considered for report scheduling.</td>
</tr>
<tr>
<td></td>
<td>- Inactive rules are not checked when the report scheduling algorithm runs.</td>
</tr>
<tr>
<td>Auto Distribute Reports</td>
<td>Enables you to distribute reports automatically. Except the E2B Reports, all the Expedited Reports that are selected for auto-distribution are tracked under the Worklist-&gt; Bulk Transmit screen. The E2B Reports which are transmitted automatically, are tracked from Worklist-&gt; Bulk Transmit E2B.</td>
</tr>
</tbody>
</table>
Protect Reporter and Patient Confidentiality

- Enables the user to configure Protect Reporter and Patient Confidentiality
  - If this option checked and a report is generated or draft is viewed, the Patient and Reporter information will be hidden.
  - This option will override the check-boxes on the case form (for Protect Reporter and Protect Patient) if it is checked.
  - If this option is unchecked, the Case Form check-boxes will take effect.

- The Reports listed below will check for the Reporting Rule Confidentiality Flag:
  - EU Device Initial
  - EU Device Final
  - French CERFA Report
  - CIOMS Report
  - MedWatch Report
  - Vaers Report

HCP Case

- When checked, the system check for any reporter in the case where HCP=Yes. This enables the report to be scheduled if other parameters for the reporting rules are satisfied.
- The default is unchecked.

Report on Drug Not Administered

- If this checkbox is checked, system schedules report for the suspect products (study or non-study products) that are marked as ‘Drug not administered’ along with the other suspect products in the case.
- If this checkbox is unchecked, system ignores suspect products (study or non-study products) that are marked as ‘Drug not administered’ and Reports are scheduled for other suspect products in the case for which ‘Drug not administered’ is not marked.

Active Moiety

- Enable this check-box to enable rule to act exclusively as an active moiety rule for that country.
- When this option is enabled the system will disable and ignore the county when evaluating the domestic/foreign causality sections. Listedness will be evaluated at the case level.

No Follow-up or Downgrade

- The system does not schedule a follow up or a downgrade report for the case when the the initial report was scheduled based on the current rule.

Origin of Events to Include - Domestic

- Enables the user to select the inclusion of domestic or foreign cases based on their country of incidence.
  - Domestic: The event is marked as Domestic, if the country of incidence appears in the list of selected countries.
  - This list is displayed in the Countries tab, in the List Maintenance Licenses (section) for the license(s) of the suspect product(s) under examination.
<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin of Events to Include - Foreign</td>
<td>Enables the user to select the inclusion of domestic or foreign cases based on their country of incidence.</td>
</tr>
<tr>
<td></td>
<td>■ Foreign: The event is marked as Foreign, if the country of incidence does not appear in the list of selected countries.</td>
</tr>
<tr>
<td></td>
<td>■ This list is displayed in the Countries Tab on List Maintenance License (section) for the license(s) of the suspect product(s) under examination.</td>
</tr>
<tr>
<td>Timeframe</td>
<td>This field specifies the report's scheduled due-date based on the number of days, after the initial receipt or significant follow-up date.</td>
</tr>
<tr>
<td>Adjust due date for Group 2 countries by xxx days</td>
<td>This field allows the user to specify the number of days by which the due date for a report may need to be adjusted for a Group 2 country.</td>
</tr>
<tr>
<td>Form</td>
<td>This field is the drop-down list of expedited report forms.</td>
</tr>
<tr>
<td>Local Comment Type</td>
<td>This field is used to extract the local evaluator comment from case data (French CERFA 65-0044, CIOMS-I (Local)). This field is only enabled for CIOMS-I (Local) form.</td>
</tr>
<tr>
<td>Clinical Reference Type</td>
<td>This field is used to get information from the study configured for a case. This field is enabled for CIOMS-I and other forms.</td>
</tr>
<tr>
<td>Language</td>
<td>Enables the user to select language type.</td>
</tr>
<tr>
<td></td>
<td>■ English is the default language of choice.</td>
</tr>
<tr>
<td></td>
<td>■ The system does not support other languages at this time.</td>
</tr>
<tr>
<td></td>
<td>■ Reports such as the German BfArM, German PEI, and French CERFA can utilize some field values in their corresponding language (For example: narrative).</td>
</tr>
<tr>
<td>Message Type</td>
<td>Enables the user to select the message type.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is displayed when an E2B or eVAERS report is selected as the Report Form. If the Report Form is selected as eVAERS, then the Message type is set to ICHICSR and is disabled.</td>
</tr>
<tr>
<td>Listedness</td>
<td>Enables the user to check if the license being evaluated for reporting is listed. The possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ Listed</td>
</tr>
<tr>
<td></td>
<td>■ Unlisted</td>
</tr>
<tr>
<td></td>
<td>■ Ignore (default)</td>
</tr>
<tr>
<td>Seriousness - Fatal/Life Threatening</td>
<td>Enables the user to check if the case contains a Death’ or Life Threatening’ seriousness criteria for the current event being evaluated.</td>
</tr>
<tr>
<td></td>
<td>The possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ Yes</td>
</tr>
<tr>
<td></td>
<td>■ No</td>
</tr>
<tr>
<td></td>
<td>■ Ignore (default)</td>
</tr>
<tr>
<td>Seriousness - Serious (Case)</td>
<td>Enables the user to check if case level seriousness assessment is ‘Serious’. The possible values are:</td>
</tr>
<tr>
<td></td>
<td>■ Yes</td>
</tr>
<tr>
<td></td>
<td>■ No</td>
</tr>
<tr>
<td></td>
<td>■ Ignore (default)</td>
</tr>
</tbody>
</table>
### Field/Control Name | Description
--- | ---
Seriousness - Serious (Event) | Enables the user to check if the event level seriousness assessment (for any event) is **Serious**. The possible values are:
- Yes
- No
- Ignore (default)

Seriousness - Severity | Enables the user to select a term descriptive of the severity of the event. E.g. Mild, Moderate, severe, unknown.

Product Specific - Family Name | Enables the user to configure product specific reporting rules.

Product Specific - Product Group | Enables the user to configure product specific reporting rules. Product Group drop-down always lists the configured Product Groups.

Causality - Most Conservative | If this checkbox is marked, the system will look at the event level reported causalities, event level determined causalities and case level causalities, and if any of these three causalities is **Yes** then the case will be considered **Reportable**.

If checked, the following options are hidden and set to **Ignore**:
- Causality as Reported (Event)
- Causality as Determined (Event)
- Causality as Reported (Case)
- Causality as Determined (Case)
- Causality is ignored when scheduling reports for non-study cases. This only Study cases.

Causality - Include Non-Clinical Trial Cases | Enables you to include the Spontaneous Cases (Non Clinical Trial Cases) for causality assessments.

Causality - Causality as Reported (Event) | Assesses As Reported causality in conjunction with the Listed value (if any) specified in the rule for the license/event combination being assessed. **Ignored for non-study cases. Only applies to Study cases.** The possible values are:
- Reportable
- Non-reportable
- Ignore (default)

Causality - Causality as Determined (Event) | Assesses As Determined causality in conjunction with the Listed value (if any) specified in the rule for the license/event combination being assessed. **Ignored for spontaneous, literature and regulatory authority cases.**

Ignored for non-study cases. Only applies to Study cases.

The possible values are:
- Reportable
- Non-reportable
- Ignore (default)
Adding Expedited Report Rules

The Reporting Rules configuration feature enables you to define the reporting rules or criteria for the cases to be qualified for expedited reporting.

Use the following procedure to add expedited report rules.

1. In the Business Configuration section, select **Expedited Report Rules**.
2. In the left panel, select a filtering criterion. The left panel now displays the tree view of the **Country/License Type/Reporting Rule** based on the filtering criterion.
3. Select a Reporting Rule and click to view the reporting details in the right panel.

**Note:** Ensure that you select the reporting rule-level icon/folder to view the details of the reporting rule.
Tip: You can alternatively click Add Rule to create a new reporting rule.

- Use Copy Rule to make an editable copy of an existing reporting rule, along with all associated expedited reporting rule information.

4. Enter the Report Name.

5. Select the Report Destination from the drop-down list. This is the name of the agency to which the report will be scheduled.

6. Select Auto Distribute Reports to distribute reports automatically.

7. Select Active to specify if the configured rule is active or inactive.

Note: Only active rules are considered for report scheduling

8. Select Origin of events to include-Domestic to include domestic cases based on the country of incidence OR Select Origin of events to include-Foreign to include foreign cases based on the country of incidence

9. Select Report on Drug not Administered. This option ensures that all drugs that are not administered are reported.

10. Select Active Moiety if you want to enable this option.

11. Select the required Form from the drop-down list of expedited report forms.

12. Select the Local Comment Type from the drop-down list. This field is used to extract local evaluator comments from case data.

13. Select the Clinical Reference Type from the drop-down list. This field is used to obtain information from study configured for a case.

    Tip: This field is enabled only for CIOMS-I and other forms.

14. Select the Language and Message Type from the drop-down list.

15. Select the Listedness from the drop-down list. This ensures that the license being evaluated for reporting is listed.

16. Select the Seriousness- Fatal/Life Threatening option from the drop-down list. This field ensures that cases that contain Death or Life Threatening seriousness criteria for an event are evaluated.

17. Select the Seriousness- Serious (Event) option from the drop-down list. Enable this field to check if the event level seriousness assessment is Serious

18. Select the Seriousness- Serious (Case) option from the drop-down list. Enable this field to check if the case level seriousness assessment is Serious

19. Select the Seriousness- Serious (Severity) option from the drop-down list. This enables you to define the Severity as Mild, Moderate, Severe and Unknown.

20. Select the Product Specific - Group Name from the drop-down list. This field enables you to configure product specific reporting rules.

21. Select the Product Specific - Family Name from the drop-down list. This field enables you to configure product specific reporting rules.
22. Select **Causality-Most Conservative**. This ensures that the system looks at event level reported causality, event level determined causality and case level causality.

23. Select **Causality-Include Non-Clinical Trial Cases**. This enables you to include the Spontaneous Cases (Non Clinical Trial Cases) for causality assessments.

24. Select **Causality - Causality as Reported (Event)** as required, from the drop-down list.

25. Select **Causality - Causality as Determined (Event)** as required, from the drop-down list.

26. Select **Causality - Causality as Reported (Case)** as required, from the drop-down list.

27. Select **Causality - Causality as Reported (Case)** as required, from the drop-down list.

28. Select or create the **Advanced Condition** to restrict cases to the advanced conditions defined here.

If any of these three causalities are confirmed, then the case will be considered as reportable.

---

**Note:** Use the Advanced Conditions browser to select or create an Advanced Condition by clicking **Select**.

---

29. Select the **Responsible Group** from the drop-down list. This is the group to which the reports scheduled by this reporting rule will be assigned.

30. Select the **Cover Letter** from the drop-down list. Use this field to select cover letters that have been configured for reporting template use.

31. Enter any regulatory report comments under the **Comments** text box.

32. Click **Save** to save the changes made to this section.

**Tip:** If you have added a new Reporting Rule, click **Add Rule** to save the new **Expedited Reporting Rule**.

**About the Filtering Criterion** The filtering criterion is essential as it helps you to search for specific items. The Argus Console provides this option for the Business Configuration section.

**Using Organized by**

The filtering browser is displayed in the top-left corner of the left panel. The Expedited Report Rules section can be filtered on the basis of any of the five combinations shown in the following illustration.
Consider the following examples:

- If you enable Organized by Country/License Type/Reporting Rule, then the output generated will be visible in a tree-format, in the left panel, based on the entire categorization of Country, License Type and Reporting Rule.

- If you enable the Organized by Responsible Group/Reporting Rule, then only the Responsible Group and Reporting Rule views will be available in the tree view in the left panel.

**Tip:**

- Enable the Organized By filter for Active Rules, to obtain the list of active reporting rules.

- Enable the Organized By filter for Inactive Rules, to obtain the list of inactive reporting rules

The Argus Console helps you to filter information further for the Business Configuration section. Once you have selected the Organized by, you can specify whether your search should contain or start with specific alphabets or words.

For example, the filtering criterion defined in the following illustration for all Country/License Type/Reporting Rule data that contain the term Canada.

![Filtering Illustration](image)

**Sorting of Expedited Report Rules**

The Reporting Rules are sorted in an alphanumeric order. The logic of ordering of Reporting rules based on ‘Organized by’ is as follows:

1. **Country/License Type/Reporting Rule**
   
   For each country, there will be a folder for license type. Within each folder, the active and inactive reporting rules will be presented together in alphanumeric order.

2. **License Type/Reporting Rule**
   
   For each license type, there will be a folder for each reporting destination. For each destination, the active and inactive reporting rules will be presented together in alphanumeric order.

3. **Responsible Group / Reporting Rule**
   
   There will be a folder for each reporting group. Within each folder, the active and inactive reporting rules will be presented together in alphanumeric order.

4. **Active Rules**
   
   Only active rules will be presented. For each country, there will be a folder for license type. Within each folder, active rules will be presented in alphanumeric order.

5. **Inactive Rules**
Only inactive rules will be presented.

For each country, there will be a folder for license type. Within each folder, inactive rules will be presented in alphanumeric order.
System Configuration

This chapter provides information about configuring the system. It includes information about how to configure the following:

- Case Priority
- Field Validations
- LAM System Numbering
- Common Profile Switches
- Reporting Configuration
- Workflow
- System Numbering
- Field Properties
- User-Defined Fields

System Configuration Overview

The following table describes how the system options are configured:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Priority</td>
<td>This screen enables the administrator to configure rules to determine the priority of new cases that are entered into the system.</td>
</tr>
<tr>
<td>Field Validation</td>
<td>This screen enables the administrator to configure field level validations for the Case Form fields.</td>
</tr>
<tr>
<td>Field Properties</td>
<td>This screen enables the administrator to configure field properties.</td>
</tr>
<tr>
<td>LAM System Numbering</td>
<td>This section enables the administrator to specify the case numbering preferences for LAM cases.</td>
</tr>
<tr>
<td>System Management (Common Profile Switches)</td>
<td>This screen enables the administrator to configure common profile switches.</td>
</tr>
<tr>
<td>Workflow</td>
<td>This screen enables the administrator to configure Workflow states and rules.</td>
</tr>
<tr>
<td>System Numbering</td>
<td>This screen enables the administrator to specify the case numbering preferences.</td>
</tr>
<tr>
<td>SMTP</td>
<td>This screen enables the administrator to configure SMTP for e-mails.</td>
</tr>
</tbody>
</table>
Configuring Case Priority

Configure rules to determine the priority of new cases that are entered into the system. Based on these rules, the system assigns each case a priority that is displayed in the Worklist.

Each row in the Case Priority Configuration screen represents the priority level assigned to a case that meets the specific criteria selected for that level. This data is reflected in multiple expedited and periodic reports and case form-product information section.

- The user can select the priority level for which the criterion is to be configured.
- Select System Configuration -> Case Priority to view the Case Priority page.

Field Descriptions

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Enables the user to select the priority level whose criterion is to be configured. The user can disable only the last enabled priority. Example: If a user has priority 1-4 checked, the priority can be disabled only in the order of 4-1.</td>
</tr>
<tr>
<td>Case Assessment - Serious</td>
<td>Enables the user to configure the seriousness for case assessment.</td>
</tr>
<tr>
<td></td>
<td>■ Select Yes from the drop-down list to give priority to cases that are serious.</td>
</tr>
<tr>
<td></td>
<td>■ Select No for non-serious cases to be considered for this priority level. Seriousness is considered at the case level.</td>
</tr>
<tr>
<td></td>
<td>■ Select Ignore from the drop-down list to ignore this condition when assessing the priority of this case.</td>
</tr>
<tr>
<td>Case Assessment - Unlisted</td>
<td>Enables the user to configure the priority level for unlisted case assessment.</td>
</tr>
<tr>
<td></td>
<td>■ Select Yes from the drop-down list for unlisted cases to be considered for this priority level.</td>
</tr>
<tr>
<td></td>
<td>■ Select No for listed cases to be considered for this priority level. Listedness criteria is considered at the case level.</td>
</tr>
<tr>
<td></td>
<td>■ Select Ignore from the drop-down list to ignore this condition when assessing the priority of this case.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure Case Priority

1. Select the priority level whose criterion is to be configured.
2. Select the **Case Assessment - Serious**. The options in the drop-down list are **Yes**, **No**, **Ignore**.
3. Select the **Case Assessment - Listed**. The options in the drop-down list are **Yes**, **No**, **Ignore**.
4. Select the **Case Assessment - Casual**. The options in the drop-down list are **Yes**, **No**, **Ignore**.
5. Select **First Report Due Date as Due Soon or Ignore**. Enter the #Warning days for Due Soon.
6. Select the **Advanced Conditions** from the drop-down list.
7. Use the **AC button** to create a new Advanced Condition.
8. Select **Run All Case Priority Determination on Middle Tier** to ensure that the application does not assess priority when a case is saved in Web and Client/Server.
9. Click **Save** to save the changes made.
Configuring Field Validations

This screen enables you to configure field level validations for the Case Form fields. Be aware of the following:

- These validation rules are expressed as an advanced condition, with their criteria marked as required or warning.
- The field level validations feature helps in automatic checking of data as it is entered on the Case Form, to ensure consistency of data as per company requirements. Consider the following example:

  Suppose that the year in the patient's date of birth is entered as 1860. The patient’s date of birth probably could not have been prior to 1880; hence, a warning is issued to ensure the accuracy of the entered data.

- A field level validation message such as this one is a "warning violation" and the user can therefore enter a justification and continue working on the case.

- An example of a mandatory violation would be a dosage regimen stop date that occurs before the dosage regimen start date. Cases cannot be saved without correcting mandatory violations.

- For dependent fields, Argus Safety is pre-loaded with several field level validations. Some of these validations are protected and cannot be disabled. Others can be disabled, if required by company policy.

- The system displays the Advance Condition Description for field validations on the case form after the Advanced Condition name in the following format: Field: XXXX:YYYYReason: ZZZZ

where:

| XXXX   | Is the Field Label Tree view followed by the field label as configured in the field label configuration. |
| YYYY  | Is the Advance Condition name configured for the field validation. |
| ZZZZ   | Is the advance conditions descriptions as configured for the Advance conditions. |

This text prints only if there is a description available for the Advanced Condition. Otherwise, the system disables the field label.

Select System Configuration->Field Validation to view the Case Form Field Level Validation screen. The following is an illustration of the screen.
Consider the following example:

The General Tab in the Case Form contains sections such as Study, Follow-up, Case Literature, etc. To view the list of field names associated with the Study section, click Study in the left panel. The field names associated with Study appear in the right panel.

**Field Descriptions**

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Displays the name of the field.</td>
</tr>
<tr>
<td>Condition for Warning</td>
<td>Displays the advanced condition for warning.</td>
</tr>
<tr>
<td>Table</td>
<td>Displays the name of the selected sub-folder as displayed in the browser tree-view. This field cannot be edited.</td>
</tr>
<tr>
<td>Field</td>
<td>Displays the name of the selected field label in the browser tree-view. This field cannot be edited.</td>
</tr>
<tr>
<td>Condition for Warning</td>
<td>Displays the advanced condition for warning.</td>
</tr>
<tr>
<td>Condition for Mandatory Exception</td>
<td>Displays the advanced condition for mandatory exception.</td>
</tr>
<tr>
<td>Print All</td>
<td>Displays a list of validations on all tables, fields and advanced conditions of each Group in the Case Form as a PDF.</td>
</tr>
</tbody>
</table>

**Modifying Field Validations**

This section enables the user to edit the information already entered in fields. Use the following procedure to modify a field validation.
1. Select the Case Form folder and field for which, the validation rule is to be modified.

   **Tip:** The information of the selected field is displayed in the **Modify** section.

2. Click **Select** icon to create/select advanced conditions for **Condition for Warning** and **Condition for Mandatory Exception**.

   **Tip:** Click here for details on Advanced Conditions.

**Note:**
- If all validation rules are met, a green icon is displayed.
- If a condition for warning is met during field validation, an orange icon is displayed.
- If a condition for mandatory exception is met during field validation, a red icon is displayed.

3. Click **Save** to save the changes made.

**Note:** Label Changes will not be reflected in Argus Case Form unless IIS is reset.

**Configuring LAM System Numbering**

This section enables you to specify the case numbering preferences for LAM cases. The system provides the ability to use multiple case numbering schemes for global use. For example, if site is used in the numbering, the system provides the option to keep separate sequences for each site.

Select **System Configuration->LAM System Numbering** to view the LAM System Numbering screen shown in the following illustration.

![LAM System Numbering Screen](image)

**Field Descriptions**

The following table lists and describes the fields in this section.
<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Number Cases</td>
<td>The option is used to enable the user to manually number the cases on booking or while copying the case, using the save as' option on the case form.</td>
</tr>
<tr>
<td>Automatically Number Cases</td>
<td>On selection, the system automatically numbers the cases as defined by the user in the numbering format.</td>
</tr>
<tr>
<td>Start at</td>
<td>Enables the user to initialize the counter of the sequence number.</td>
</tr>
<tr>
<td>Separate sequence for each site</td>
<td>Enables the user to separate the sequence numbering for cases on site by site basis. If there are cases being entered from two different sites then each site will have different sequencing of case numbers.</td>
</tr>
<tr>
<td>Separate sequence for each report type</td>
<td>Enables the user to separate the sequence numbering for cases by the report type of the case.</td>
</tr>
<tr>
<td>Separate sequence for each year</td>
<td>Enables the user to reset the sequence numbering for cases after each year, based on the initial receipt date of the case.</td>
</tr>
<tr>
<td>Separate sequence for each month</td>
<td>Enables the user to reset the sequence numbering for cases after each month, based on the initial receipt date of the case.</td>
</tr>
<tr>
<td>Separate sequence for each product abbreviation</td>
<td>Enables the user to reset the sequence numbering for cases for each different product abbreviation.</td>
</tr>
<tr>
<td>Numbering Format</td>
<td>Enables the user to select the numbering format by selecting the different placeholders.</td>
</tr>
<tr>
<td></td>
<td>- Define the numbering format by typing in custom keywords to print on every case number and selecting different placeholders.</td>
</tr>
<tr>
<td></td>
<td>- [YY][MM]-[##] is the default format.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure LAM Numbering.

1. Select the **Numbering** feature as required. This can be manual numbering or automatic numbering of cases.

2. Select the **Sequencing Options** as required.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placeholder</td>
<td>Enables the user to enter a placeholder.</td>
</tr>
<tr>
<td></td>
<td>- Placeholders are used to pickup values from the database to be used in the Case numbering format.</td>
</tr>
<tr>
<td></td>
<td>- The possible values populated in this list are:</td>
</tr>
<tr>
<td></td>
<td>- # - Number: defines the digits to be used as the sequence number in the format. The field is used to display the sequence number on the case numbers.</td>
</tr>
<tr>
<td></td>
<td>- CC- Country code: When selected, this uses the A2 code for the country of incidence for the case number.</td>
</tr>
<tr>
<td></td>
<td>- DD - Day: When selected, this uses the date of the Initial receipt date’ field of the case.</td>
</tr>
<tr>
<td></td>
<td>- MM - month: When selected, this uses the month of the Initial receipt date’ field of the case.</td>
</tr>
<tr>
<td></td>
<td>- P -When selected, this uses either of the two values:</td>
</tr>
<tr>
<td></td>
<td>- If report type is Spontaneous or other during booking: the system uses the value of the Product Abbreviation’ field specified in the Product configuration for the selected Primary suspect product.</td>
</tr>
<tr>
<td></td>
<td>- SSS – User Site: When selected this uses the Site abbreviation of the site belonging to the user who booked in the case.</td>
</tr>
<tr>
<td></td>
<td>- TTT – Report Type: When selected this uses the report type abbreviation of the report type selected during bookin of the case.</td>
</tr>
</tbody>
</table>
|                    |     - YY- Year: When selected, this uses the year of the Initial receipt date’ field of the case.
Tip: For the complete explanation of the sequencing option refer to the Field Descriptions.

3. Select the Numbering Format. Use Placeholders to enter the required format.

Tip: To customize the Numbering Format, use the placeholder values. Consider the following example:

To select Country Code, Month and Year (as values to be incorporated from the database) as the Case numbering format, execute the following steps.

1. Click on Country Code. This appears in the Numbering Format field.
2. Click on Month. This appears in the Numbering Format field next to the Country Code.
3. Click on Year. This appears in the Numbering Format field next to the Country Code and Month.
4. The final data listed in the Numbering Format field is the Case Numbering Format.

4. Click Save to save the changes made.

Configuring System Management - Common Profile Switches

This section lists the configurable sections for Common Profile Switches.

Select System Configuration and then System Management to view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

Note: If any change is made in the System Management (Common Profile Switches) screen, the Argusvr2.exe and Argusvr2a.exe should be killed from each Web Server and the IIS on Argus Web / Report Servers must be reset, in order to reflect the changes made in the Argus application.

The following table provides the list of configurable sections associated with Common Profile Switches.

<table>
<thead>
<tr>
<th>Section</th>
<th>Sub Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Conditions</td>
<td>~</td>
<td>The Advanced Conditions configuration screen enables you to specify the number of rows to be displayed on the Advanced Condition search screen.</td>
</tr>
<tr>
<td>Argus Dossier</td>
<td>Report Configuration</td>
<td>The Argus Dossier screen enables you to modify the customizable fields of Argus Dossier.</td>
</tr>
<tr>
<td>Argus Insight</td>
<td>~</td>
<td>If Argus Enterprise products are enabled, the Argus Insight URL can be provided here.</td>
</tr>
</tbody>
</table>
## System Configuration Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Sub Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argus J</td>
<td>E2B</td>
<td>The Argus J Configuration screen enables you to modify the customizable fields on the Argus J form.</td>
</tr>
<tr>
<td></td>
<td>Reporting</td>
<td></td>
</tr>
<tr>
<td></td>
<td>~Device Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Responsible Officer</td>
<td></td>
</tr>
<tr>
<td>Argus Mart</td>
<td>~</td>
<td>If Argus Enterprise products are enabled, Argus MART related settings can be configured here.</td>
</tr>
<tr>
<td>Case Form Configuration</td>
<td>~</td>
<td>This screen enables you to configure Common Profile Switches that affect the behavior of the Argus application</td>
</tr>
<tr>
<td>Case Processing</td>
<td>Assessments</td>
<td>This section enables you to configure the case processing fields and items.</td>
</tr>
<tr>
<td></td>
<td>Always Show Literature Data</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto Archiving</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Case Numbering</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dictionary Browser</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enable Local Unlocking</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lot Number Processing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Performance</td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>~</td>
<td>The database related parameters can be maintained here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Calculation functions for Case Seriousness, Listedness and Causality calculation.</td>
</tr>
<tr>
<td>Document Management</td>
<td>~</td>
<td>This screen enables you to configure the Documentum fields and items for Documentum.</td>
</tr>
<tr>
<td>Help</td>
<td>~</td>
<td>Centralized Online Help URL.</td>
</tr>
<tr>
<td>Local Labeling</td>
<td>LAM</td>
<td>The Local Labeling Configuration screen enables you to modify the options available through local labeling.</td>
</tr>
<tr>
<td>Network Settings</td>
<td>~</td>
<td>The Network Settings screen enables you to modify the settings on the Argus Safety Load Balancer Server and Proxy.</td>
</tr>
<tr>
<td>Section</td>
<td>Sub Section</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reporting</td>
<td>BIP Reporting</td>
<td>The Reporting Configuration screen enables you to modify the options available for reporting.</td>
</tr>
<tr>
<td></td>
<td>E2B</td>
<td></td>
</tr>
<tr>
<td></td>
<td>eMDR</td>
<td></td>
</tr>
<tr>
<td></td>
<td>eVAERS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expedited</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expedited - BfArM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expedited - Canada</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expedited - CIOMS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expedited - MedWatch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MedWatch</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Periodic</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scheduling</td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td>Cryptography</td>
<td>The Security Configuration screen enables you to modify the options available for security.</td>
</tr>
<tr>
<td></td>
<td>LDAP</td>
<td></td>
</tr>
<tr>
<td>Session Timeout</td>
<td>Session expiration time in minutes</td>
<td>The maximum idle time allowed for a user’s session. Valid range for this value is 5-1440. Default value is 30 min. Note that long running processes like CDA are controlled through the table CMN_URL_ACCESS_GLOBAL where user can specify a timeout value local to that process. Further, the user would need to set the process as IS_LONG_RUNNING = 1. By default, the following are categorized as long running: '&lt;REPO\RTS/CIOMSII/CIOMS2_SAVE\NG.ASP&gt;' '&lt;AUDITLOG/AUDITLOGLIST.ASP&gt;' '&lt;REPO\RTS/CDA/CDAGENERATE.ASP&gt;'</td>
</tr>
<tr>
<td>Single Sign-On</td>
<td>~</td>
<td>The Single Sign-On screen enables you to modify the options available for Single Sign-On such as enabling or disabling it, its HTTP Header, Logout URL, and using Oracle Access Server SDK for LDAP Validation. Note that in a SSO configured environment, for the SSO to take effect, the session timeout value should be set to maximum value.</td>
</tr>
<tr>
<td>User Interface</td>
<td>~</td>
<td>The User Interface screen enables you to modify the options available for User Interface.</td>
</tr>
<tr>
<td>Workflow</td>
<td>~</td>
<td>The Workflow Items screen enables you to modify the options available for Workflow Items.</td>
</tr>
</tbody>
</table>
Configuring Advanced Conditions

Select **System Configuration -> System Management** to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the rows to display on each page of an advanced condition screen, click the **Advanced Conditions** folder in the left panel.

Field Descriptions  The following table lists and describes the fields in **Advanced Conditions Configuration**.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of rows to display per page on the Advanced Condition Search screen</td>
<td>Enables the user to specify the number of rows to be displayed on the Advanced Condition search screen.</td>
</tr>
</tbody>
</table>
| Comma separated list of allowable parameters for custom advanced conditions | This feature allows the Advanced conditions to store and execute customer SQLs containing bind variables through the UI. The application supports the bind variables defined in a comma separated format. The bind variables defined here are case insensitive. This switch supports a maximum length of 1000 characters. In OOTB configuration, the following bind variables are supported: 
  - P_CASE_ID
  - P_SEQ_NUM
  - P_REG_RPT_ID
  - P_REG_REPORT_ID
  - P_REPORT_FORM_ID |

Use the following procedure to configure Advanced Conditions.

1. Enter the Number of rows to display per page on the Advanced Conditions Search screen.
2. Click **Save** to save the changes made.

Configuring Case Form (System Management)

This screen enables you to configure Common Profile Switches that affect the behavior of the Argus application.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.
To view the list of field names associated with the **Case Form Configuration** section, click the **Case Form Configuration** folder in the left panel. The field names associated with **Case Form Configuration** appears in the right panel.

The Case Form Configuration dialog helps you customize the case processing activities in order to meet the company’s requirements. The Administrator can configure the following items by using the Case Form Configuration dialog shown in the following illustration.

Auto Encoding, Dictionary and Central Encoding. To enable the use of standardized medical terminology throughout the adverse event reporting process, dictionaries can be used to encode certain terms in the Case Form.

The dictionaries that will be used to encode drugs, Events & Indications, and events can be specified in the **Autoencoding** section of the **Case Form Configuration** dialog.

**Field Descriptions**

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Coding</td>
<td>You can independently turn On/Off Centralized Coding for individual enterprises from the Argus Console -&gt; System Management -&gt; Case Form Configuration by marking the checkbox next to the Events &amp; Indications MedDRA dictionary version drop-down list. The enterprise can use its own MedDRA version using the Argus Console -&gt; System Management -&gt; Case Form Configuration -&gt; Centralized Coding -&gt; Centralized Coding Configuration.</td>
</tr>
</tbody>
</table>
The Automation section enables the user to generate an Auto narrative based on one of the templates configured by the method described in this topic.

### Field Descriptions

The following table lists and describes the fields in the Automation dialog box.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Regulatory Scheduling</td>
<td>This enables the user to configure the manner in which Argus Safety handles the Auto-scheduling of Regulatory Reports.</td>
</tr>
<tr>
<td></td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Always</td>
</tr>
<tr>
<td></td>
<td>- Significant</td>
</tr>
<tr>
<td></td>
<td>- Manual</td>
</tr>
<tr>
<td></td>
<td>When the common profile switch is set to Always, the system does not wait for a lock to schedule reports, it tries to auto-schedule each time the user saves the case. However, the only criteria to run the auto-scheduling algorithm is that the case must have product, event and event assessment.</td>
</tr>
</tbody>
</table>
System Configuration Overview

Report Generation

The Report Generation option helps you to configure how the system responds to new data when generating auto-scheduled regulatory reports.

- When new data is entered, the system re-runs the regulatory report-scheduling algorithm to determine which reporting rules apply to the case.

- If Overwrite Existing Reports is selected, the system updates the existing scheduled reports with the new data entered. This setting ensures that follow-up numbering is specific to each health authority.

- If a MedWatch report for the FDA has already been scheduled for this case, that report would then be updated with the new information entered.

- If Create as Follow-up is selected, the system uses the new data to create new reports marked as follow-up reports. This setting ensures that the same number would identify a follow-up report worldwide. Users will be unable to submit follow-up reports before one of the following events occur on the initial or previous follow-up report.

Aware date and Due date of a scheduled report can be overwritten or retained with original dates based on the internal common profile switch "Scheduled Report Update".

If "Scheduled Report Update" is set to "Update to current aware date and new due date", the current Aware date is used and due date is updated based on the current aware date while overwriting a scheduled report.

If "Scheduled Report Update" is set to "Keep original aware date and due date" the aware date/due date are not updated based on current aware date while overwriting a scheduled report.

If the common profile switch Report Generation is set to Create as Follow-up then, system allows generation of follow-up reports irrespective of submission status of previously scheduled reports based on the settings made to the common profile switch Allow Report Generation.

Case Locking for Report

The Administrator has the option of indicating whether cases that are not locked can appear in periodic reports.

- If Allow Unlocked cases to be included is selected, then a check box on the periodic report configuration dialogs will allow unlocked cases to appear in periodic reports.

- To prevent unlocked cases from appearing in periodic reports, select Prevent unlocked cases from appearing.

Report On Selecting Diagnoses will only list the events marked as diagnoses plus events unassociated with a diagnosis in Regulatory Reports.

- The Event Assessment section of the case form will only list diagnosis and unrelated events. If there are no diagnoses, all events are listed. You can configure a default setting for selecting the Diagnoses state at a system level.

- Selecting All Events will always list all events, regardless of their relationship in the Event Assessment section of the case form. The system will take into consideration both events marked as diagnoses and events marked as symptoms when running the regulatory report algorithm.
Clicking the Templates button enables the Administrator to create a new Autonarrative template, modify/copy an existing template, or delete an existing template.

Use the following procedure to create a new Autonarrative template.

1. Click the Templates button in the Case Form Configuration dialog to open the Autonarrative Configuration dialog.
2. Click New to open the Narrative Configuration dialog.
3. Under Template Name, enter a name for this new template.
4. Click the Add button at the bottom of the dialog. A new row for entering a phrase and its associated logic will appear.
5. Enter a text phrase in the Phrase field. The text can include placeholders that will be substituted by the appropriate case data when the Autonarrative is generated. For example: A phrase might be entered as: “The patient was [age] at the onset of this event”. When the Autonarrative is being generated, the “[age]” placeholder will be substituted for the actual age of the particular patient in the case.
6. Click the ellipsis button to the right of the Logic column. Select or enter an Advanced Condition for the logic section.

   *This search will be used to determine whether or not the corresponding phrase will appear in a narrative for a particular case. For example: An advanced condition can be specified such that only cases involving children younger than five years old will have the phrase "*

   The patient was [age] at the onset of this event in the Autonarrative.

7. Repeat steps 4 through 6 to add other text phrases to the template. Click OK to save the template or Cancel to exit the dialog without saving the changes.

---

**Note:** Selecting the Preventing Modification of Autonarrative checkbox in the Case Form Configuration dialog will prevent users from modifying autonarratives.

---

**Creating a Template in Another Language** Use the following procedure to create a template in another language.

1. Once a template is created, double-click the "Narrative Templates" folder to expand the template tree in the Autonarrative Configuration dialog.

   **Tip:** To open the Autonarrative Configuration dialog, click the Autonarrative button in the Case Form Configuration dialog.

2. Expand the selected template folder to display the languages for this template. To configure this template in a language other than English, double-click the appropriate language icon.

3. Configure the foreign language template as described in steps 4 through 7 of the procedure for creating the Autonarrative template above.

4. Click Close to exit the Autonarrative Configuration dialog.

---

**Note:** Autonarrative placeholders in a language other than English will get substituted by text from that particular language. If no text is available in that language, English language text will be used to substitute the placeholders.

---

**Copying a Template to Another Language** Use the following procedure to copy a template to another language.

1. Select the original language from which the target language copy is to be created. The original language can be selected in the tree-view of the Autonarrative Configuration dialog.

   **Tip:** To open the Autonarrative Configuration dialog, click the Autonarrative button in the Case Form Configuration dialog.

2. Click Copy. The Autonarrative Copy dialog will appear.

---

**Note:** In the Autonarrative Configuration dialog, the Copy button for a selected language template will only be available if a template has already been created in that language.
3. Select the language to which the narrative template is to be copied and click **Copy**.
4. The contents of the original language template will now be copied into the selected language template.

**Deleting Templates** Use the following procedure to delete templates.

1. To delete a language template, select the appropriate language icon for the template in the Autonarrative Configuration dialog and click **Delete**.
2. To delete the entire Autonarrative template, select the template folder icon in the Autonarrative Configuration dialog and click **Delete**.

**Duration Calculations** The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>The <strong>Duration Calculations</strong> section is used to indicate whether the system should calculate event duration (the time from Event Onset Date to Event Stop Date) in an inclusive or an exclusive manner. For instance, select <strong>Inclusive</strong> to calculate a range from 01 January to 10 January as ten days. Select <strong>Exclusive</strong> to calculate a range from 01 January to 10 January as nine days. If the user has entered both the date and time, the exclusive/inclusive designation is ignored.</td>
</tr>
<tr>
<td>Drug</td>
<td>The <strong>Drug Duration Calculations</strong> section is used to indicate whether the system should calculate drug duration in an inclusive manner or an exclusive manner, as described under Event Duration Calculations.</td>
</tr>
</tbody>
</table>

**Documentum Common Login** The Documentum Common Login information is used to connect to the Documentum server to perform Documentum related activities to the case form. The system uses this information only if the common profile switch to use the common login is set. This option is only available if the system is configured to use Documentum.

The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>This is the username associated with the Documentum Common Login.</td>
</tr>
<tr>
<td>Password</td>
<td>This is the password associated with the Documentum Common Login username.</td>
</tr>
</tbody>
</table>

**Custom Routines** The following table lists the Field Descriptions associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Routine</td>
<td>The function behaves the same way as the Custom Routine Before Commit. The case ID is passed as a parameter to the function. The return value is a string format. If a null string is returned, the system assumes the procedure executed without any error, and continues with the case save operation. If any numeric/string value is returned, the case save routine is aborted and the system displays the returned string as an error message to the user.</td>
</tr>
</tbody>
</table>
System Configuration Overview

Table Config Button

The Table Config button enables you to fetch only the delta table data after post-save, so that the entire case is not reloaded. This button is enabled only when the Custom Routine After Commit checkbox is selected.

Use the following procedure to remove case tables.

1. Select the Custom Routine After Commit checkbox and click the Table Config button. The following screen appears.

Initially, all case tables open under the Available Tables list box.

2. Select the required table(s) and click Add>> to include them to the Selected Tables list.

Alternatively, you can select the required table(s) and click <<Remove to exclude them from the Selected Tables list.

3. Click Cancel to close the screen without making any changes or click Save to save this configuration.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Routine Before Commit</td>
<td>This is the Custom routine to be called before case save. Ensure that the custom routine is present in the database, and the application has access to it.</td>
</tr>
<tr>
<td>Custom Routine After Commit</td>
<td>This is the after-save Custom routine to be called after case save. Ensure that the custom routine is present in the database, and the application has access to it. Select the Table Config button to select the tables that are being modified in the post-save script.</td>
</tr>
<tr>
<td>Custom Routine Before Lock</td>
<td>This is the Custom routine to be called before case lock. Ensure that the custom routine is present in the database, and the application has access to it.</td>
</tr>
<tr>
<td>Attachment File Size Limit (in Megabytes)</td>
<td>The file size entered in this field enables you to specify the maximum size limit for attaching a file. The upload limit defined here can be seen in the Attachments and References section of the Bookin screen. The default size for uploading an attachment is 30 MB. You can also configure the file size as per your requirement, up to 300 MB.</td>
</tr>
</tbody>
</table>

Custom Routine Before Lock

This is the Custom routine to be called before case lock. Ensure that the custom routine is present in the database, and the application has access to it.

Attachment File Size Limit (in Megabytes)

The file size entered in this field enables you to specify the maximum size limit for attaching a file. The upload limit defined here can be seen in the Attachments and References section of the Bookin screen. The default size for uploading an attachment is 30 MB. You can also configure the file size as per your requirement, up to 300 MB.
The Case Save routine gets modified to retrieve only the table data from the Selected Tables in the configuration.

If no Post Save is configured, the Case Save does not execute the Case Load routine.

Modify Data Lock Point This section is displayed only if the DLP_SETUP switch is set to ON in the database schema in the CMN_Profile_Global table.

The following table lists and describes the fields in this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Data Lock Point</td>
<td>Enables you to activate a data lock point by selecting this checkbox. If this checkbox is not selected, the Modify Data Lock Point section displays only this field as editable.</td>
</tr>
<tr>
<td>Use Last Completed Version</td>
<td>Enables you to use the last completed version.</td>
</tr>
<tr>
<td>Use Next Completed Version (Includes Data Cleaning)</td>
<td>Enables you to use the next completed version that includes data cleaning.</td>
</tr>
</tbody>
</table>

SMTP Configuration
The system enables you to attach a Custom SMTP Header along with the preconfigured text as the Header for every e-mail it sends.

The Custom SMTP Header text is enabled only when the Custom SMTP Header check box is checked.
- The user can define the Header and the Header text in the Custom SMTP Header configuration by separating them with a colon ( : ).
- The system does not validate the value for the Custom SMTP Header text.

You can enter a maximum of 255 characters.
All e-mail messages sent using the following processes are sent as Confidential:
- AG Service: Bulk Transmit Email
- AG Service: General Email
- ESM Service: Business / User / IT Email

The Audit Log tracks updates to this field.

Configuring Case Processing
This section enables you to configure the case processing fields and items. Select System Configuration -> System Management to view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing section, click the Case Processing folder in the left panel.

The field names associated with Case Processing Configuration appear in the right panel.

The Case Processing folder has been further categorized into the following sub-folders:
- Configuring Assessments
- Configuring Always Show Literature Data
- Configuring Auto Archiving
- Configuring Case Numbering
- Configuring Dictionary Browser
- Configuring Lot Number Processing
- Configuring Performance

Field Descriptions  The following table lists the fields available under Case Processing Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create follow-up on unblinding</td>
<td>The available options are Yes and No.</td>
</tr>
<tr>
<td>* Perform Field Validation</td>
<td>This control is not operational for this release.</td>
</tr>
<tr>
<td>* Perform Safe length check on Validation check</td>
<td>This control is not operational for this release.</td>
</tr>
<tr>
<td>Manually Schedule reports</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- Report scheduling will schedule follow up reports</td>
</tr>
<tr>
<td></td>
<td>- Report scheduling will not schedule follow up reports</td>
</tr>
<tr>
<td>Field/Control Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Events to Display on Assessment Tab | The available options are:  
  - Event Assessment will display all Events  
  - Event Assessment will display Diagnosis Events only |
| Access on Patient Information | The available options are:  
  - Initials part of Patient information access group  
  - Initials part of Personal Patient Information access group |
| Enable Local Unlocking | Provides a system level control permitting local users to locally unlock a case and make any corrections to the previously entered local data. Enables you to select whether to locally unlock a case or not. The available options are:  
  - Yes  
  - No |
| Search product on Case Form | The available options are:  
  - Product Name product lookup. Based on products configured in the system.  
  - Trade Name product lookup. Based on the licenses configured in the system. |
| Select Type of WHO drug search for auto drug encoding | The available options are:  
  - Default WHO schema  
  - Use alternate who tables |
| Action Item Code when QC info is entered | The available action item codes are listed in the drop-down list box. |
| ActiveX Compatibility Mode (This option is applicable only if Auto Upload letter is checked) | The available options are:  
  - Standard (WinHTTP method): This is option is selected by default. System uses the WinHTTP for uploading files.  
  - Compatibility (Older OS and IE Versions which do not use WinHTTP method): System uses Internet Explorer for uploading files. This option can be used if WinHTTP is not working for older OS/IE. This feature is deprecated. |
| Default Network directory for scanned images | Enter the path of the default network directory of scanned images in this text box. When the user selects New Case from Image from the Quick Launch toolbar, the Windows Open dialog opens, and displays the path specified in this textbox, by default. |
| Valid Attachment File Types | Allows users to attach files in Case Form with the file types mentioned in this parameter. |
SQL to prevent case unlock when reports are pending generation

Allows customization to prevent users from unlocking the case from Case Form, E2B, and LAM if there were reports pending generation.

You can configure this behavior by adding a SQL or database function in the given text field.

1. If the value returned is greater than 0, then the system shall behave as described below:
   - If the Value of Allow forced unlock (Global and Local) is Yes, Report Status (Global or Local) is Pending (i.e. the value from SQL check returned > 0), a warning message is displayed. The case is unlocked using the existing “Locked Case” dialog if user selects “Yes” on the warning message. This means that the pending global reports will not be generated on unlock and may be overwritten or removed depending on case data on the subsequent global lock.
   - If the Value of Allow forced unlock (Global and Local) is No, Report Status (Global or Local) is Pending (i.e. the value from SQL check returned > 0), the case is not unlocked and an error message is displayed.
   - If the Value of Allow forced unlock (Global and Local) is N/A, Report Status (Global or Local) is Generated /Submitted (i.e. the value from SQL check returned 0 or no SQL has been configured), the case is not unlocked.

2. If the value returned is 0 or no SQL has been configured, the system shall allow users to global unlock the case without any of the other checks.

The default for this configuration will stop the users from unlocking the case if there are scheduled reports pending generation.

The checks for reports pending generation is applicable only when DLP_EXPEDITED_E2B_REPORTS is set to 0 (i.e., DLP is not enabled for Expedited Reporting).

Make sure that the name that is being used for the bind parameter is P_CASE_ID.
This common profile switch helps to suppress user confirmation during generation of auto-narrative for the other language while the user performs the operation in the English side or Japanese side.

Click Yes to generate or No (default) to not generate the auto-narrative.

If auto-narrative is being performed prior to global lock:

If a user is performing the auto-narrative from the Japanese side of the case form and if the auto-narrative template has any other language other than Japanese configured, and if the new common profile switch "Generate auto-narrative for the other language without user confirmation" is set to "No", the system shall first prompt the user if they wanted to generate the English and other language narratives as well. The system shall proceed with all the non-Japanese language narrative generation steps only if the user chose Yes to this dialog (note that existing generation steps and prompts still hold good) or if the new common profile switch "Generate auto-narrative for the other language without user confirmation" is set to "Yes. If they chose No to the user prompt, the system shall proceed with only Japanese narrative generation (note that existing generation steps and prompts still holds true). If they chose Cancel, the system shall not proceed with auto-narrative generation for any language.

If a user is performing the auto-narrative from the English side of the case form and if the chosen Narrative template has Japanese language configured, and if the new common profile switch "Generate auto-narrative for the other language without user confirmation" is set to "No", the system shall first prompt the user if they wanted to generate the Japanese narrative as well. The system shall proceed with the Japanese language narrative generation steps only if the user chose Yes to this dialog (note that existing generation steps and prompts still hold good) or if the new common profile switch "Generate auto-narrative for the other language without user confirmation" is set to "Yes. If they chose No to the user prompt, the system shall proceed with only the non-Japanese (English and all other languages except Japanese) narrative generation (note that existing generation steps and prompts still holds true). Note that the prompt shall not display if Japanese language was not configured in the template. If they chose Cancel, the system shall not proceed with auto-narrative generation for any language.

Provides a system level control allowing customers to define SQL or PL/SQL block or specify database function to test if a case with suspect Local (Japanese) License product is a Local PRPT case. This field is a multi-line text fields with a limit of up to 1000 characters. It is partitioned by enterprises for multi-tenant customers.

The SQL or PL/SQL block or the database function shall accept a bind variable :P_CASE_ID representing the case from which this switch is being invoked. If the value returned from the configured SQL or PL/SQL block or the database function is > 0, the system shall consider the case with suspect products having local (Japanese) license as a Local PRPT case.

If the value returned is 0, the system shall not consider the case a Local PRPT case (unless there is already a local report pending generation i.e., Scheduled or New data available report states).

If there is no SQL or PL/SQL block or database function configured in this switch, the system shall consider that the switch returns a default value of 1.

The system does not allow illegal data manipulations (e.g., UPDATE/INSERT/DELETE statements) to the underlying Argus schema via this switch.

This switch is also used to determine if a report is a Local report.
Use the following procedure to configure the case processing options.

1. Select the required option in **Create follow-up on unblinding**.
2. Select the required option in **Allow User to regenerate reports**.
3. Select the required option in **Manually Schedule reports**.
4. Select the required option in **Events to Display on Assessment Tab**.
5. Select the required option in **Access on Patient Information**.
6. Select the required option in **Search product on Case Form**.
7. Select the required option in **Select Type of WHO drug search for auto drug encoding**.
8. Select the required action item code from the drop-down list box in **Action Item Code when QC info is entered**.
9. Enter the path of the default network directory of scanned images in the **Default Network directory for scanned images** text box.
10. The Auto Upload Letters feature is no longer available. You are requested to select only the **Manually Upload Letters** option.
11. Click **Save** to save the changes made to this section.

**Configuring Database**

This screen enables you to configure the case processing fields and items for the database. **Select System Configuration -> Database** to view the Common Profile Configuration screen.

To view the list of field names associated with the **Case Processing -> Database** section, click the **Database** folder in the left panel.

The field names associated with **Modify Database** appear in the right panel.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uploading Letter after generation <strong>This feature is deprecated.</strong></td>
<td>Select <strong>Auto Upload Letter (enabling Active X)</strong> to upload letters automatically through the Active X control. The Active X control supports the following versions of MS Office - Office XP, Office 2003 and Office 2007. Select <strong>Manually upload letter</strong> to manually upload a letter saved on the local machine.</td>
</tr>
<tr>
<td>Always show Literature Data section on Case Form</td>
<td>When configured to Yes, the application always displays the literature section in the Case Form and Book-in. Default: 0</td>
</tr>
</tbody>
</table>
Field Descriptions  The following table lists the fields available under Modify Database:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Server OS Timezone</td>
<td>The database server timezone can be specified here. This value can be configured during the Argus database installation. Note that the timezone selected here should be in sync with the database, web and transaction servers.</td>
</tr>
<tr>
<td>Override Case Seriousness Calculation Function (Note: Default function shall be used if left BLANK)</td>
<td>If this configured in Common Profile Switches -&gt; Database -&gt; Modify Database, the configured function is executed. (Note: Default function shall be used if left BLANK).</td>
</tr>
<tr>
<td>Override Case Listedness Calculation Function (Note: Default function shall be used if left BLANK)</td>
<td>If this configured in Common Profile Switches -&gt; Database -&gt; Modify Database, the configured function is executed. (Note: Default function shall be used if left BLANK).</td>
</tr>
<tr>
<td>Override Case Causality Calculation Function (Note: Default function shall be used if left BLANK)</td>
<td>If this configured in Common Profile Switches -&gt; Database -&gt; Modify Database, the configured function is executed. (Note: Default function shall be used if left BLANK).</td>
</tr>
</tbody>
</table>

To find out the time zone offset for the time zone regions, you may execute the following query:

```sql
SELECT tzname, tz_offset(tzname) offset, tzabbrev
FROM gv$timezone_names;
```

Configuring Assessments
This screen enables you to configure the case processing fields and items for assessments. Select System Configuration -> System Management to view the Common Profile Configuration screen.
Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing -> Assessments section, click the Assessments folder in the left panel.

The field names associated with Assessments Configuration appear in the right panel.

Field Descriptions The following table lists the fields available under Assessments Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display warning when Case Level Assessment does not match with Event Level Assessment</td>
<td>The available options are Yes and No.</td>
</tr>
<tr>
<td>Criteria for case level causality assessment</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Derive the case level causality based on the As Determined event level causality.</td>
</tr>
<tr>
<td></td>
<td>■ Manually select case level causality.</td>
</tr>
<tr>
<td>Criteria for case level Seriousness determination</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Derive the case level seriousness based on the events. If any event is serious, case level will be serious.</td>
</tr>
<tr>
<td></td>
<td>■ Manually select case level seriousness.</td>
</tr>
<tr>
<td>SUSAR Criteria</td>
<td>Enables you to enter an SUSAR criteria as an SQL query.</td>
</tr>
<tr>
<td></td>
<td>An SUSAR is identified as a Serious, Unexpected, Related Case.</td>
</tr>
<tr>
<td></td>
<td>Note: The SQL should not exceed 2000 characters.</td>
</tr>
</tbody>
</table>

Use the following procedure to Configure the Case Processing Options

1. Select the required option for Display warning when Case Level Assessment does not match with Event Level Assessment.
2. Select the required option for Criteria for case level causality assessment.
3. Select the required option for Criteria for case level Seriousness determination.
4. Enter the SUSAR Criteria.
5. Click Save to save the changes made.

**Configuring Auto Archiving**

This screen enables you to configure the auto-archiving. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

The default rule requires that the following options must be completed before a case is auto-archived:

- All Action Items Closed
- All Reports Submitted or Marked required for Non-Submission
- All Events are encoded
- All Letters are sent
- All Cases are locked

Apart from this default rule, you can also configure additional rules/criteria for auto-archiving cases from this screen.

- Workflow State (Configurable by the user) - This option enables you to select Workflow States. Cases that fall in the specified workflow states can be auto-archived.
- Advanced Conditions selection (Configurable by the user) - This option enables you to specify advanced conditions. Cases that meet the specified advanced conditions, can be auto-archived.

This feature enables you to define rules for automatically archiving those cases that meet the defined rules.

To view the list of field names associated with the Case Processing -> Auto Archiving section, click the Auto Archiving folder in the left panel.

The field names associated with Auto Archiving Configuration appear in the right panel.
Field Descriptions  The following table lists the fields available under Auto Archiving Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow States</td>
<td>The Select button enables you to select workflow states from a list of workflow states. The selected workflow states are displayed in the text box. Cases that belong to these workflow states are marked to be auto-archived.</td>
</tr>
<tr>
<td>Advanced Condition</td>
<td>Enables you to specify advanced conditions for auto-archiving cases. Cases that meet the advanced conditions are marked to be auto-archived. Refer to Advanced Conditions for details on creating advanced conditions.</td>
</tr>
<tr>
<td>Case Archiving Comment</td>
<td>Enables you to enter a pre-defined case close comment, of up to 200 characters. The information entered in this field is displayed in the Case Routing and Case Archive notes.</td>
</tr>
<tr>
<td>Execution Period (in Days)</td>
<td>Enables you to define how often the cases will be archived. Note: You can enter up to 99 days only. If no value is entered, the cases will not be auto-archived.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure the auto archiving options:

1. Select the workflow states for auto-archiving cases from Workflow States.
2. Create the advanced conditions for archiving cases in Advanced Condition.
3. Enter the Case Archiving Comment as a pre-defined case close comment.
4. Enter how often the cases will be archived, as per number of days, under Execution Period.
5. Click Save to save the changes made.
**Configuring Case Numbering**

This screen enables you to configure the case processing fields and items for case numbering. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing -> Case Numbering section, click the Case Numbering folder in the left panel. The field names associated with Case Numbering appear in the right panel.

### Field Descriptions

The following table lists the fields available under Case Numbering Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date to use for numbering year placeholder</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Use initial receipt date of the case entered for the automatic system numbering.</td>
</tr>
<tr>
<td></td>
<td>■ Use date on the local machine for the automatic system numbering.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure the case numbering options.

1. Select the required option for Date to use for numbering year placeholder.
2. Click **Save** to save the changes made.

**Configuring Lot Number**

A common profile switch determines whether a user can override an un-validated lot number and enter them in the case form.
The following table lists and describes the fields available under **Lot Number Processing**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Users to enter non-configured Lot Numbers</td>
<td>Enables you to select whether or not to allow users to enter non-configured lot numbers. Select Yes to allow, and No to disallow.</td>
</tr>
<tr>
<td>Use Centralized Lot Number Validation</td>
<td>Enables you to select whether or not to allow centralized lot number validation. Select Yes to use, and No to not use this option.</td>
</tr>
<tr>
<td>Lot Number Web Service Configuration XML File</td>
<td>Enables you to select and/or edit (if required) the Lot Number Web Service Configuration XML File. The file path textbox is a read-only field, which displays the path of the uploaded file. This field stores the configuration of the Centralized Lot Number Web Service in XML format. The Edit button is enabled only after the XML file has been successfully uploaded.</td>
</tr>
<tr>
<td>Lot Number Web Service XSLT</td>
<td>Enables you to select and/or edit (if required) the Lot Number Web Service XSLT File. This field stores the XSLT associated with the Centralized Lot Number Web Service. The file path textbox is a read-only field, which displays the path of the uploaded file. The Edit button is enabled only after the XSLT file has been successfully uploaded.</td>
</tr>
</tbody>
</table>

**Yes** is the default. This enables the user to select the options for the Lot Number Validation as current functionality. This message box displays the following message:

*No matching lot number was found.*

If centralized lot search is used, the system hides the Lookup button since a list is automatically returned and displayed.

- **No**: The system does not permit the user to keep the existing value. The user can only obtain it from a Look up dialog that lists the available Lot Numbers.
The system hides the Keep button.

A common profile switch determines whether lot validation uses Argus or a centralized lot validation.

- No (default): This enables the user to select the options for the Lot Number Validation as current functionality from within the Argus Product Families Lot Numbers

- Yes: This enables the system to query outside the Argus Safety system through a web service return the following parameters for Lot Number Validation
  
  - Argus sends the user-entered lot number to central system for validation/look-up and retrieves a response to act on.
  
  - The message format for the retrieved lot is as follows:
    
    `<Lots>`
    `<Lot>`
    `<Lot Number>`: Lot number
    `<Expiration>`: Lot expiration date
    `<Custom name=name metadata=text>`: Custom data to a lot number

- If more than one lot number is returned, the system displays a lot selection dialog.

**The Custom Node**

- The metadata attribute is as labels in the selection dialog that displays the data. The name attribute is used to identify the case form field to be populated with the data in the node.

- Clients can use an XSLT document to map the custom data to case fields present on the active case form page.

If an error occurs during the web service transaction, a message box will appear with the proper error message.
Configuring Dictionary Browser

This screen enables you to configure the case processing fields and items for MedDRA Browser.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

A switch in Argus enables you to use either local MedDRA Coding or Central System MedDRA Coding (Web Service Method).

- Local (Default): Current functionality of Dictionary browser using Local Dictionary within the Database.
- Web Services: Returns the MedDRA hierarchy via the configured Web Services.

This enables the User Local MedDRA if term is not found by Web Service function.

To view the list of field names associated with the Case Processing -> Dictionary Browser section, click the Dictionary Browser folder in the left panel. The field names associated with Dictionary Browser are in the right panel.

**Field Descriptions** The following table lists the fields available under Dictionary Browser Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Term Selection in Dictionary Browser</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- Select any term to code if multiple are returned for the search</td>
</tr>
<tr>
<td></td>
<td>- Select the Primary SOC term for encoding if multiple terms are returned from the search</td>
</tr>
</tbody>
</table>
Use the following procedure to configure the Dictionary Browser.

1. Select the required option for Date to use for numbering year placeholder.
2. Click **Save** to save the changes made.

**Configuring WHO Drug**

Argus supports WHO-Drug encoding using a locally installed version of the WHO-Drug dictionary through the WHO-Drug browser.

- A switch in Argus enables you to use either local WHO-Drug Coding or Central System WHO-Drug Coding (Web Service Method) under the Dictionary browser category
  - Local (Default): Uses the current functionality of WHO-Drug browser that uses the Local Dictionary in the Database
  - Web Service: Returns the WHO-Drug fields via the configured Web Services
  - The system enables the User Local MedDRA if term is not found by Web Service

**Configuring Performance**

This screen enables you to configure the case processing fields and items for performance.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the *Case Processing* -> *Performance* section, click the *Performance* folder in the left panel. The field names associated with *Performance* appear in the right panel.
Field Descriptions  The following table lists and describes the fields available under Performance Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to process field level validation</td>
<td>Enables you to configure the frequency of field level validation. Select <strong>Only on case save</strong> to validate only when a case is saved. Alternatively, select <strong>Every page update</strong> to validate fields whenever a page is updated.</td>
</tr>
<tr>
<td>Where to store temporary case information during data entry</td>
<td>Enables you to select the location where you can save the temporary case information during data entry. You can select the location to be On the database in web case table or On the fileserver cache directory.</td>
</tr>
<tr>
<td>Use Oracle Text for duplicate search querying</td>
<td>Enables you to select Oracle Text for duplicate search querying. Click <strong>Yes</strong> to enable this feature.</td>
</tr>
<tr>
<td>Refresh Oracle Text Index interval (in Minutes)</td>
<td>Enables you to configure the interval (in minutes) between each refresh of an Oracle Text Index. This feature is useful while searching for duplicate cases. It is advisable to enter a high interval for low number of cases and vice versa.</td>
</tr>
<tr>
<td>Start Time for Oracle Text Refresh</td>
<td>Enables you to specify the time when the Oracle text will be refreshed.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure performance.

1. Select the required option for **When to process field level validation**, as applicable.
2. Select the required option for Where to store temporary case information during data entry, as applicable.
3. Select the required option for **Use Oracle Text for duplicate search querying**, as applicable.

4. Enter the time difference between each refresh (in minutes), under **Refresh Oracle Text Index interval (in Minutes)**.

5. Enter the time (in military format) when the Oracle text refresh will begin, under **Start Time for Oracle Text Refresh**.

6. Click **Save** to save the changes made.

**Configuring Documentum**

The system enables you to configure to choose Document Management from the Common Profile Switches: Document Management

- You may select from the following:
  - Documentum: Cabinet Name and Document Type textboxes are only enabled when the "Documentum" radio option is selected. These text boxes allow upto 255 characters.

- Docbase and Domain are textbox fields. These fields can be a maximum of 255 characters.

- Configure the following for Document Management:
  - E2B Reports
  - Expedited Paper Reports
  - Periodic Reports
- Attachments saved within the cases
- E2B Reports:
  - If the E2B switch is enabled and the user transmits an E2B Report (Before submission to the Gateway), the system stores the E2B XML Message in Documentum.
  - When the Report Submission is successful and the report is marked as submitted in Argus, the system updates a flag in the Documentum database to designate the same.
- Expedited Reports
  - If the Expedited switch is enabled and the user submits an expedited report, the Argus Safety Service inserts the report into Documentum as a PDF file.
  - When the Report Submission is successful and the report is marked as submitted, the system updates a flag in the Documentum database to signify the same.
- Periodic Reports:
  - If the Periodic Switch is enabled and a Periodic Report is approved in Argus, an Argus Safety Service exports the report as a PDF file and saves it in the Documentum database.
  - When the Report Submission is successful and the report is marked submitted, the system updates a flag in the Documentum database to indicate the same.
- Attachments:
  - When this switch is enabled, a new button is available on the Argus Attachments screen, LAM Attachments Section label Attach Documentum Link.
  - The Argus Bookin dialog has an additional drop down option for attaching to Documentum.
  - When the Links Switch is enabled, the system stores all Argus Attachments in the Documentum database.
  - Clicking the Attach Documentum Link button opens a search dialog to enable the user to search the Documentum database for a document. This document is then linked as an attachment within Argus.
– When the user clicks the Attach Documentum Link button, the following occurs:

– The system presents a search dialog to enable the user to search for a document in the Documentum database.

– The user must select a Table to Search. This list is a distinct Table List from the Documentum_table_info Table.

– After the user selects a Table, the system populates the Column drop down with all the columns available for that table based on configuration from the same table.

– When the user selects the Full Search option, the system performs a like search in Documentum.

■ If LDAP is enabled, the system automatically send the login information from Argus to Documentum.

■ After selecting a document from the Search results, the system saves the URL for the Argus attachment.

■ If the user clicks the URL, Argus automatically opens the document from Documentum.

■ Argus refers to two (2) that enables you to specify which tables/columns can be searched in Documentum and which Table Fields to display in the Search Results.

– documentum_table_info - This table holds the table / fields the user will be able to search.
  
<table>
<thead>
<tr>
<th>Type_Name</th>
<th>Attribute_Name</th>
<th>Attribute_Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table to Search</td>
<td>Field in the Table to Search</td>
<td>Type of field being searched.</td>
</tr>
</tbody>
</table>

– Documentum_display_info - This table stores the Return Search Parameters.

<table>
<thead>
<tr>
<th>Type_Name</th>
<th>Attribute_Name</th>
<th>Sort_Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table to Search</td>
<td>Field in the Table to Search</td>
<td>The order in which the fields will be displayed</td>
</tr>
</tbody>
</table>

– The Document Management (Central or Documentum) database gets a new document each time a document attachment is added as a new attachment. Existing documents are modified for changes.

– The system does not create a new document in the Document Management (Central or Documentum) database each time a case / event is saved in Argus or Affiliate

– When cases are copied, the document copy has the same DOC ID (Object ID) as the original case. If the Document is modified after the cases are copied, the system gets a new DOC ID only for the case attachments that were modified.

– The icon is similar to the Additional Info requirements for attachment types

– When the user clicks the attachment to open it, the system retrieves the attachment from Documentum

– When events from the Affiliate are accepted in Argus as Argus cases, the system keeps the DOC ID(Object ID) from the Affiliate Event

– Attachments can be entered to the case / affiliate event via
Affiliate Events
Bookin in Argus or Affiliate
Case Form / Affiliate Event Form
Intake WL

Error Messages
- If the system cannot connect to the document system, it displays the following message:

Argus was unable to connect to the document management system. Please contact your Administrator for more details.

- If the document system does not return any rows, the system returns a dialog with the following message

No documents returned.

- Select System Configuration -> System Management to view the Common Profile Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the Case Processing -> Documentum section, click the Documentum folder in the left panel. The field names associated with Documentum appear in the right panel.

Field Descriptions The following table lists the fields available under Documentum Management:

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Login</td>
<td>Use Common Login Password</td>
<td>Users use a common login password to access the system</td>
</tr>
<tr>
<td></td>
<td>Docbase</td>
<td>The name of the document database.</td>
</tr>
<tr>
<td></td>
<td>Domain</td>
<td>The name of the domain where the database resides.</td>
</tr>
<tr>
<td>Enable Storage of E2B Reports in Document Repository</td>
<td>Documentum</td>
<td>Enables the system to store E2B reports in the document repository.</td>
</tr>
<tr>
<td></td>
<td>Argus</td>
<td>Enables the system to store E2B reports in the Argus document repository.</td>
</tr>
<tr>
<td></td>
<td>Cabinet Name</td>
<td>The storage location of the E2B reports.</td>
</tr>
<tr>
<td></td>
<td>Document Type</td>
<td>The type of document that is being stored.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure Documentum

1. Select the Common Login to configure the login for the user.
2. Select the option for Enable Storage of E2B Reports in Documentum.
3. Select the option for Enable Storage of submitted expedited reports in Documentum.
4. Select the option for Enable Storage of submitted expedited reports in Documentum and additionally the searching and attaching files already existing in Documentum to a case.
5. Select the option for Enable Storage of submitted periodic reports in Documentum.
6. Click Save to save the changes made.

Local Labeling
This section enables you to configure the common profile switches for Local Labeling and includes discussions of the following:
- Configuring Local Labeling
- Configuring Local Labeling LAM
**Configuring Local Labeling**  The Local Labeling Configuration screen enables you to modify the options available through local labeling. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the Local Labeling section, click the Local Labeling folder in the left panel. The configurable fields associated with Local Labeling appear in the right panel.

---

**Field Descriptions**  The following table lists and describes the fields available under Local Labeling:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number of Cases returned in local labeling dialog: default X | This field enables the user to configure the number of cases that are returned in the local labeling dialog.  
  Example: If the value is entered as 20 then 20 cases are returned in the local labeling dialog. |
| Action to be taken after timeout                         | The available options are:  
  ■ Discard  
  ■ Submit |
| Timeout for assessment data lock (in minutes)            | This field enables the user to enter the minutes after which the time-out for assessment data lock is applicable. |

Use the following procedure to configure local labeling

1. Enter the number in Number of Cases returned in local labeling dialog: default.
2. Select the option for Action to be taken after timeout.
3. Enter the value in minutes for Timeout for assessment data lock (in minutes).

4. Click Save to save the changes made.

Configuring LAM The Local Labeling LAM Configuration screen enables you to modify the options available through local labeling for LAM.

Field Label Updates The Argus Console Field Labels option enables the user to modify the field labels for the Argus Affiliate Event Information form.

- The existing Argus fields are under the Argus Safety folder structure.
- Please refer to the tables in the LAM Information section for the details about the Help Text for the fields.
- The system enables the user to hide the field on the LAM form.
- The system prints the Affiliate field labels.
- The system tracks all field label updates in the audit log.

Field Validation Updates Argus Affiliate enables the user to configure Field Validations for Mandatory and Warning for the LAM Event fields.

- The existing Argus fields are under the Argus Safety folder structure.
- Please refer to the table for LAM Event Info for the fields in the Field Validations.
- The Affiliate fields for advanced conditions are only visible for field validations. They are not visible to the rest of the application.
- The system prints the information for the configured field validations.
- The system tracks all updates to field validations in the audit log.
- The system displays the standard Justifications dialog to enable the user to enter the justifications for overriding the warnings, but does not permit the user to save the case for a mandatory error.

Select System Configuration -> System Management to view the Common Profile Configuration screen

Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the Local Labeling LAM section, click the Local Labeling folder in the left panel.

- The LAM sub-folder is displayed in the left panel.
- Click on LAM sub-folder to configure the LAM options.
- The configurable fields associated with Local Labeling Lam appear in the right panel.
Field Descriptions

The following table lists and describes the fields available under Local Labeling LAM:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Scheduling when Labeling Changes from the Local Labeling Screen</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Report Scheduling will not be executed when the Local Labeling is changed</td>
</tr>
<tr>
<td></td>
<td>■ Report Scheduling will occur for those Licenses where the Labeling has changed</td>
</tr>
<tr>
<td>Re-evaluate all scheduled and generated reports related to a case when the labeling is changed from the Local Labeling dialog</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ The system will not re-evaluate generated reports</td>
</tr>
<tr>
<td></td>
<td>■ Re-evaluate general reports.</td>
</tr>
<tr>
<td>Report Scheduling for LAM</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Perform live scheduling on screen</td>
</tr>
<tr>
<td></td>
<td>■ Perform scheduling using AG service</td>
</tr>
</tbody>
</table>

Use the following procedure to configure local labeling for LAM.

1. Select the option for Allow hiding of the Local Labeling dialog from Users.
2. Select the option for Report Scheduling when Labeling Changes from the Local Labeling Screen.
3. Select the option for Re-evaluate all scheduled and generated reports related to a case when the labeling is changed from the Local Labeling dialog.
4. Click Save to save the changes made.

Network Settings

The settings for Proxy set up can be configured under Network Settings > Proxy.
The following table lists the fields available:

<table>
<thead>
<tr>
<th>Configuration Parameter</th>
<th>Valid Values</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSLStartMode</td>
<td>Automatic</td>
<td>If the remote port is set to the standard plain text port of the protocol (where applicable), the class will behave the same as when SSLStartMode is set to sslExplicit. In all other cases, SSL negotiation will be implicit (sslImplicit).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Implicit</td>
<td>The SSL negotiation starts immediately after the connection is established.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Explicit</td>
<td>The class first connects in plaintext, and then explicitly starts SSL negotiation through a protocol command such as STARTTLS.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>No SSL negotiation, no SSL security. All communication will be in plaintext mode.</td>
<td></td>
</tr>
</tbody>
</table>

Auto Detect Proxy

Checking this field lets the application detect the proxy automatically if applicable.
User Interface

This section enables you to configure the common profile switches for User Interface.

<table>
<thead>
<tr>
<th>Configuration Parameter</th>
<th>Valid Values</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy Type</td>
<td>None - No proxy (Default)</td>
<td>Tunnel - Connect through a tunneling proxy. ProxyPort is set to 80</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOCKS4 - Connect through a SOCKS4 Proxy. ProxyPort is set to 1080</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOCKS5 - Connect through a SOCKS5 Proxy. ProxyPort is set to 1080</td>
<td></td>
</tr>
<tr>
<td>Proxy Host</td>
<td>Holds the Name or IP address of</td>
<td>Proxy Port TCP Port for the Proxy Host</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Proxy serve</td>
<td>Proxy Domain/UserName</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Proxy Password may be used to connect and authenticate to the given Proxy</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server. This field expects the password to be in encrypted state, use</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cryptography Key Editor to encrypt the password.</td>
<td></td>
</tr>
</tbody>
</table>
Configuring User Interface

The User Interface Configuration screen enables you to configure the user interface, as per the options available. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the User Interface section, click the User Interface folder in the left panel. The configurable fields associated with User Interface appear in the right panel.

![Common Profile - User Interface](image)

Configuring Reporting

The Reporting Configuration screen enables you to modify the options available for reporting. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting folder in the left panel. The configurable fields associated with Reporting appear in the right panel.
Field Descriptions  The following table lists the fields available under **Reporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow User to regenerate reports</td>
<td>The available options are Yes and No.</td>
</tr>
<tr>
<td>Determine the minimum length of the routing comment text length on report routing dialog</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ No routing comment will be required</td>
</tr>
<tr>
<td></td>
<td>■ Minimum length of text required</td>
</tr>
</tbody>
</table>

Use the following procedure to configure reporting.

1. Select the option for Determine the minimum length of the routing comment text length on report routing dialog.
2. Enter the numeric value in the **Minimum length of text required** text-box, if applicable.
3. Click **Save** to save the changes made to this screen.

**Configuring E2B**  This screen enables you to configure the E2B fields and items for E2B. Select System Configuration -> System Management to view the Common Profile Configuration screen

**Tip:**  The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the **E2B** section, click the **E2B** folder in the left panel. The field names associated with **E2B** appear in the right panel.

**Field Descriptions**  The following table lists the fields available under **E2B**:
Use the following procedure to configure E2B

1. Enable the check-box option for **Drug assessment method (used by E2B/ESM module)**, if required.

2. Select the option for **Blind status during E2B report generation**.

3. Select the option for **Perform length check of Argus fields against E2B standard**.

4. Select the option for **Default viewing format of the E2B report (used in E2B (R2) reports)**.

5. Select the option for **Default DTD**.

6. Select the required radio button under **Onset Date Calculation**, as applicable.

7. Enter the comments for the automatically generated notes, when an E2B is accepted, under **Auto Accept Notes**.
8. Click **Save** to save the changes made to this screen.

**Configuring eMDR** The eMDR Reporting Configuration screen enables you to modify the options available for eMDR reporting.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel. The eMDR sub-folder is displayed in the left panel. Click this sub-folder to configure the reporting options. The configurable fields associated with eMDR appear in the right panel.

**Field Descriptions**

The following table lists and describes the fields available under eMDR:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Reporting Destination for draft eMDR generation</td>
<td>Displays all Reporting Destinations in the drop-down list. It is used only when the user generates a draft eMDR using the Draft icon or Medical Review eMDR View Draft options.</td>
</tr>
<tr>
<td>Default Timeframe for draft eMDR generation</td>
<td>Displays a time frame that the Draft report generation required for populating G7 (gtypeofreport). Without this information, eMDR throws a validation error and the report cannot be generated. The default setting for this parameter is 5. The allowed values for this parameter are 5, and 30. Based on the value entered, the corresponding NCI code is populated for data element Type of Report (G7) in eMDR.</td>
</tr>
<tr>
<td>File attachments allowed for eMDR</td>
<td>Verifies the files that are attached to an eMDR. Only configured file types are allowed to be attached to an eMDR.</td>
</tr>
<tr>
<td>Default view for eMDR</td>
<td>Specifies the default view of eMDR in ICSR viewer.</td>
</tr>
</tbody>
</table>

**Configuring eVAERS** The eVAERS Reporting Configuration screen enables you to modify the options available for eVAERS reporting.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel. The **eVAERS** sub-folder is displayed in the left panel.

Click this sub-folder to configure the reporting options. The configurable fields associated with eVAERS appear in the right panel.

**Field Descriptions**

The following table lists and describes the fields available under eVAERS:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default view for eVAERS</td>
<td>Enables you to select either XML View or HL7 view as the default view for eVAERS.</td>
</tr>
</tbody>
</table>
Expedited Reports Configuration  The Expedited Reporting Configuration screen enables you to modify the options available for expedited reporting. When configuring expedited reporting rules, be aware of the following:

- If the user does not have permission to access Advanced Conditions on the Expedited Reporting Rules, the system does the following:
  - Displays the advanced condition name instead of displaying a blank.
  - Does not permit the user to modify or view advanced condition details.
  - Disables the Adv Condition button.

- The system enables the user configure the Blinding Study Products option for those included in the case (default unchecked).
  - The system track updates to this field in the audit log.
  - The Reporting Rules reports print the new options

- For cases where expedited reports are due, the user can force-distribute expedited reports even if processing is incomplete.

- The reporting rules have a Forced Distribute XXX days before due check box. The default is unchecked.
  - If the user checks the Force Distribute option, the # of days before due field is entered and automatically checks the Auto Distribute check box on the reporting rule (grayed out).
  - The user can enter the number of days from 0 - # of days defined within the time frame.
  - If the user enters a value greater than the defined time frame, the system displays the following message:
    - Please enter a value less than the Time Frame defined for the Reporting Rule.
  - If the user has not checked Force Distribute, the system disables the days before due.

- The system tracks updates made to the new Argus Console fields in the audit log.

- The system prints the new fields on the Reporting Rules report.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:**  The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting folder in the left panel. The Expedited sub-folder opens in the left panel.
Click on **Expedited** sub-folder to configure the expedited reporting options. The configurable fields associated with **Expedited Reporting** open in the right panel.

**Field Descriptions**

The following table lists and describes the fields available under **Expedited Reporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Active moiety report scheduling evaluation (a report scheduled against a product/license that shares ingredients with a product in a case) | The available options are:  
- Enable  
- Disable (default) |
| Allows Bulk Reporting screen to show Unlocked Cases for Final Report | The available options are:  
- Report by Form and Bulk Report By Case will filter final reports by Locked Cases only  
- Bulk Report By Form and Bulk Report By Case will allow selection of unlocked cases to be submitted as Final |
| Allows Bulk Reporting screen to show Generated Reports Only | Enables the administrator to allow the Bulk Reporting screen to display only the generated reports. |
| Nomenclature System on EU Device Vigilance Form | Nomenclature system (Preferable GMDN)” box of EU Device Vigilance Form. By default, this common profile switch is set to ‘GMDN’. |
| Default name of Regulatory Agency for Draft Expedited English Reports | This enables the user to select the Default Name of the Regulatory agency from the drop-down list. |
| Text to display as comment when a downgrade report is scheduled | This enables the user to enter the text to display when a downgrade report is scheduled. |
### Field/Control Name | Description
--- | ---
Auto Distribution Transmission Comments | Enables the user to enter transmission comments of up to 2000 characters, for Expedited Reports Transmission. These comments are auto-distributed, based on Expedited Reporting Rules or Reporting Destinations.
Auto Distribution Submission Comments | Enables the user to enter submission comments of up to 2000 characters, for Expedited Reports Transmission. These comments are auto-distributed, based on Expedited Reporting Rules or Reporting Destinations.
Print Case Version of Expedited Reports (x.y.z) | This switch enables the user to enable or disable the printing of the case version of expedited reports.
SQL mapping for CIOMS/CERFA/MHRA Spontaneous/EU EMEA Spontaneous/Spanish Clinical/Spanish Spontaneous Literature Report Source (Parameters: P_CASE_ID) | For more details on the default mapping, refer to the Mapping Document.
Allow Generation of report | If the *Allow generation of report* is set to Only when previously scheduled reports are submitted or marked for *submission not required* (default), then follow-up reports are not generated if the previously scheduled report are not yet submitted or not marked as *Submission not required*. If the *Allow generation of report* is set to Even when previously scheduled reports are neither submitted nor marked for *submission not required*, then follow-up reports are generated even if the previously scheduled report are not yet submitted or not marked as *Submission not required*.

Use the following procedure to configure expedited reports.

1. Select the option for Active moiety report scheduling evaluation (a report scheduled against a product/license that shares ingredients with a product in a case).
2. Select the option for enables Bulk by Form to show Unlocked Cases for Final Report.
3. Select the option for Default name of Regulatory Agency for New Draft Expedited Reports from Analysis Tab of the Case Form from the drop-down text-box.
4. Enter the text in the Text to display as comment when a downgrade report is scheduled text-box, if applicable.
5. Enter the transmission comments in **Auto Distribution Transmission Comments**.
6. Enter the submission comments in **Auto Distribution Submission Comments**.
7. Select whether to enable or disable printing the case version of expedited reports in **Print Case Version of Expedited Reports (x.y.z)**.
8. Click **Save** to save the changes made to this screen.
**BIP Reporting**  Argus Safety uses the BI Publisher reporting technology for the PMDA (R3) Paper reports and Flexible Aggregate reports (DSUR, PBRER and PMAR). This screen contains the common fields that are needed for integrating the BI Publisher server with Argus Safety.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting folder in the left panel. The BIP Reporting sub-folder is displayed in the left panel.

Click this sub-folder to configure the reporting options. The configurable fields associated with BIP Reporting appear in the right panel.

**Field Descriptions**

The BIP Reporting fields are grouped into *Common* and *Aggregate* reporting. The following table lists and describes the fields available under these sections:

**Common**

The fields under this section are common to both PMDA (R3) Paper Reports and Flexible Aggregate Reporting. These fields are critical to authenticate Argus Safety with BI Publisher.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIP Common User</td>
<td>Enables you to enter the name of the BIP common user.</td>
</tr>
<tr>
<td>BIP Common User Password</td>
<td>Enables you to enter the password of the BIP common user.</td>
</tr>
</tbody>
</table>

**Aggregate Reporting**

The fields under this section are applicable only to Flexible Aggregate Reports.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Persist data in BIP Aggregate Temp Tables | Enables you to select whether to persist data in BIP Aggregate Temporary Tables. The available options are:  
- Yes  
- No |
| Number of days for which data of BIP Aggregate Temp Tables should be persisted | Enables you to specify the number of days for which data in BIP Aggregate Temporary Tables should be persisted. |

**Expedited BfArM Reports Configuration**  The Expedited BfArM Reporting Configuration screen enables you to modify the options available for expedited BfArM reporting.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

To configure the fields associated with the Reporting section, click the Reporting folder in the left panel. The Expedited- BfArM sub-folder is displayed in the left panel.
Click on the **Expedited-BfArM** sub-folder to configure the expedited BfArM reporting options. The configurable fields associated with **Expedited - BfArMReporting** appear in the right panel.

**Field Descriptions**
The following table lists and describes the fields available under **Expedited - BfArMReporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Causality Value on BfArM Report</strong></td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ beh.Azrt</td>
</tr>
<tr>
<td></td>
<td>■ Hersteller</td>
</tr>
<tr>
<td></td>
<td>■ Arznel.Komm</td>
</tr>
<tr>
<td><strong>Value of field</strong></td>
<td>The available options are:</td>
</tr>
<tr>
<td>“Grunderkrankung” on the BfArM/PEI</td>
<td>■ Do not output suspect and concomitant product indication in this field</td>
</tr>
<tr>
<td>form</td>
<td>■ Output additional suspect and concomitant product Events &amp; Indications.</td>
</tr>
</tbody>
</table>

Use the following steps to configure the expedited BfArM reports.

1. Select the option for Causality Value on BfArM Report.
2. Select the option for Value of field “Grunderkrankung” on the BfArM/PEI form.
3. Click **Save** to save the changes made to this screen.

** Expedited Canada Reports Configuration** The Expedited Canada Reporting Configuration screen enables you to modify the options available for expedited Canada reporting. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.
To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel. The **Expedited-Canada** sub-folder is displayed in the left panel.

Click on the **Expedited-Canada** sub-folder to configure the reporting options. The configurable fields associated with **Expedited - Canada Reporting** appear in the right panel.

### Field Descriptions

The following table lists and describes the fields available under **Expedited-Canada Reporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL used to populate the &quot;Health Canada assigned company identification number&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;Establishment License Number&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;Device Identification No&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;Age of Device&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;How long was the device in use?&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>Offset from GMT used to calculate Canada date/time fields (in hours)</td>
<td>This switch enables the GMT offset to the Submitted dates getting printed in Canadian Device Form.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;If &quot;preliminary&quot; only, anticipated date for the final report&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
<tr>
<td>SQL used to populate the &quot;Name of Health Care Facility&quot; field on the Canadian Device report form</td>
<td>This field enables the user to enter the associated SQL syntax.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure expedited Canada reports.

1. Enter the SQL syntax for SQL used to populate the “Is there an ongoing clinical trial for this drug in Canada” field on the Canadian Expedited ADR report form.

2. Enter the SQL syntax for SQL used to populate the “Is there a clinical trial application for this drug under review in Canada” field on the Canadian Expedited ADR report form.

3. Enter the SQL syntax for SQL used to populate the “Is there a new drug submission for this drug under review in Canada” field on the Canadian Expedited ADR report form.

4. Enter the SQL syntax for SQL used to populate the “Report ADR occurred in Phase I-IV Study” field on the Canadian Expedited ADR report form.

5. Enter the SQL syntax for SQL used to populate the “Report ADR occurred in Phase I-III Study” field on the Canadian Expedited ADR report form.

6. Click **Save** to save the changes made to this screen.

**Expedited CIOMS Reports** The Expedited CIOMS Reporting Configuration screen enables you to modify the options available for expedited CIOMS reporting. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel.
The **Expedited- CIOMS** sub-folder is displayed in the left panel. Click on the **Expedited-CIOMS** sub-folder to configure the expedited CIOMS reporting options.

The configurable fields associated with **Expedited - CIOMSReporting** appear in the right panel.

### Field Descriptions

The following table lists the fields available under **Expedited- CIOMS Reporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIOMS Form Selection</td>
<td>This enables the user to select the CIOMS form to be used across the application for Expedited Reporting / Periodic Reporting.</td>
</tr>
<tr>
<td>CIOMS report format to use</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Standard</td>
</tr>
<tr>
<td></td>
<td>■ Custom</td>
</tr>
<tr>
<td></td>
<td>When Custom is selected, a second version of the CIOMS form is used. This form is almost identical to the Standard form.</td>
</tr>
<tr>
<td></td>
<td>The only difference is that the Custom form includes superscripts in the label text for boxes 15, 16, 18 and 19. The superscript is simply an asterisk (*) to draw the user’s attention to the following footnote also included in the Custom form:</td>
</tr>
<tr>
<td></td>
<td>*Boxes 15, 16, 18, and 19 on page 1 contain first dose regimen information for suspected product #1 and #2. Suspected Drug(s) information is continued on Additional Information page, if applicable.</td>
</tr>
<tr>
<td></td>
<td>Thus, the Custom form simply provides the user the option to clearly identify fields that have overflow information on the Additional Information page.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure the expedited CIOMS reports.

1. Select the Print Patient ID, Study ID, Center ID in the "26. REMARKS" section of the CIOMS form checkbox to print these fields in the CIOMS form.

2. Select the Print Medically Confirmed in the "26. REMARKS" section of the CIOMS form checkbox to print this field in the CIOMS form.

3. Select the Print World Wide Number in the "26. REMARKS" section of the CIOMS form checkbox to print this field in the CIOMS form.

4. Select the option for CIOMS report format to use.

5. Select the relevant CIOMS form, from CIOMS Form Selection.

6. Click Save to save the changes made to this screen.

Expedited MedWatch Reports Configuration The Expedited MedWatch Reporting Configuration screen enables you to modify the options available for expedited MedWatch reporting.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

Tip: The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the Reporting section, click the Reporting folder in the left panel. The Expedited-MedWatch sub-folder is displayed in the left panel.

Field Descriptions

The following table lists the fields available under Expedited MedWatch Reporting:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value for Field E4 on MedWatch</td>
<td>Select the applicable value from the available options.</td>
</tr>
<tr>
<td>Data to print on follow up MedWatch Device form</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- All information (initial + follow-up) is displayed. (Previous Behaviour).</td>
</tr>
<tr>
<td></td>
<td>- Only Display changed information from the initial report.</td>
</tr>
<tr>
<td>Number from LM_REF_TYPES.REF_TYPE_ID for Reference Type containing Legacy Case Number (to print MedWatch forms)</td>
<td>This field enables the user to select the required option from the drop-down list.</td>
</tr>
<tr>
<td>SQL used to print the BLA #</td>
<td>Enables you to enter the SQL query used to print the BLA#.</td>
</tr>
<tr>
<td>SQL used to print Unique Identifier (UDI #) in MedWatch Device Form</td>
<td>Enables you to enter the SQL query used to print the UDI# in MedWatch Device Forms.</td>
</tr>
<tr>
<td>License number on MedWatch Drug Report</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- Print License # only for the scheduled license on MedWatch Drug Report</td>
</tr>
<tr>
<td></td>
<td>- Print all available license numbers for Drug as determined by the scheduled license</td>
</tr>
<tr>
<td>License number on MedWatch Drug Report</td>
<td>This field enables the user to select the option for License number on MedWatch Drug Report.</td>
</tr>
<tr>
<td>SQL mapping for MedWatch Literature Box 3. Report Source (Parameters: P_CASE_ID)</td>
<td>SQL mapping for the field: “This type includes cases from literature” for MedWatch. For more details on the default mapping, refer to the Mapping Document.</td>
</tr>
<tr>
<td>Value for Field G8 on MedWatch</td>
<td>Select the applicable value from the available options.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure expedited MedWatch reports.
1. Select the option for the **Value for Field E4 on MedWatch**.

2. Select the option for the Data to print on follow up MedWatch Device form.

3. Select the required option for Number from LM_REF_TYPES.REF_TYPE_ID for Reference Type containing Legacy Case Number (to print MedWatch forms) from the drop-down list box.

4. Select the option for License number on MedWatch Drug Report.

5. Add an SQL for BLA# and UDI#, if there is a need to change the default logic for these fields in MedWatch report.

6. Click **Save** to save the changes made to this screen.

**Configuring MedWatch**

The MedWatch Configuration screen enables you to modify the customizable fields on the MedWatch form. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To view the list of field names associated with the MedWatch Configuration section, click the MedWatch Configuration folder in the left panel.

The field names associated with MedWatch Configuration appear in the right panel.

**Field Descriptions**

The following table lists and describes the fields available under MedWatch Configuration:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firm Name as it Should Appear at the Top of Each Page</td>
<td>Enables the user to enter the name of the reporting firm on the MedWatch form.</td>
</tr>
<tr>
<td>Use Manufacturer of the License Used for Report scheduling</td>
<td>Enables the user to use the manufacturer of the license that was used for report scheduling, by checking this checkbox.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure the MedWatch form options.

1. Enter the Firm Name as it Should Appear at the Top of Each Page.
2. Enter the Date of FDA Approval to appear on the first page.
3. Enter the Disclaimer to appear at the bottom of the first page.
4. Enter the Default text to appear on Block H10.
5. Click **Reset MedWatch Numbering** to reset the sequence number that appears on the MedWatch form, for the manufacturer.

### Periodic Reports Configuration

The Periodic Reporting Configuration screen enables you to modify the options available for periodic reporting.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of FDA Approval to Appear on the First Page</td>
<td>Enables the user to enter the FDA approval date of the manufacturer.</td>
</tr>
<tr>
<td>Disclaimer to appear at the Bottom of the First Page</td>
<td>Enables the user to enter a brief disclaimer.</td>
</tr>
<tr>
<td>Default text to appear on Block H10</td>
<td>Enables the user to enter default text.</td>
</tr>
<tr>
<td>Address to be printed at the bottom of Second page of MedWatch Device Form</td>
<td>Enables the user to enter the address to be printed at the bottom of Second page of MedWatch Device Form. The default address is as follows: Department of Health and Human Services Food and Drug Administration Office of Chief Information Officer Paperwork Reduction Act (PRA) Staff <a href="mailto:PRAStaff@fda.hhs.gov">PRAStaff@fda.hhs.gov</a></td>
</tr>
<tr>
<td>Reset MedWatch Numbering</td>
<td>Enables the user to reset the sequence number that appears on the MedWatch form, for the manufacturer.</td>
</tr>
<tr>
<td>Mfr. Site FDA Number</td>
<td>Displays the FDA number for the Manufacturer Site which submitted the MedWatch 3500 Device report in the year.</td>
</tr>
<tr>
<td>Year</td>
<td>Displays the year of report submission.</td>
</tr>
<tr>
<td># of Reports</td>
<td>Displays the number of submitted reports for products associated with a Manufacturing Site in that year</td>
</tr>
<tr>
<td>Reset Number</td>
<td>Enables the user to reset the Sequence Number.</td>
</tr>
</tbody>
</table>

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel. The **Periodic** sub-folder is displayed in the left panel.

Click on the **Periodic** sub-folder to configure the periodic reporting options. The configurable fields associated with **Periodic Reporting** appear in the right panel.
**Field Descriptions**
The following table lists and describes the fields available under **Periodic Reporting**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Determine Primary Event for use in ICH PSUR/CTPR report | The available options are:  
  - Primary Event (Left Most Diagnosis or the left-most Event if there is no Diagnosis on the Case Form).  
  - Most severe event for the product (First left most Diagnosis Related Serious Event with most weight on Diagnosis then relatedness and then seriousness). |
| Listedness grouping logic for ICH PSUR/CTPR report output | The available options are:  
  - Primary Event (refer to Inclusion criteria of event for a product in the PSUR/CTPR switch).  
  - Case level Listedness |
| Seriousness grouping logic for ICH PSUR/CTPR report output | The available options are:  
  - Primary Event (refer to Inclusion criteria of event for a product in the PSUR/CTPR switch).  
  - Case level seriousness |
### Field/Control Name Description

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Inclusion Criteria for cases in the ICH PSUR/CTPR report                          | The available options are:  
  - Evaluate seriousness, listedness, relatedness, fatal across all diagnoses/events against product  
    - When this option is selected, the case inclusion criteria logic in ICH PSUR/CTPR scans all the diagnoses in the case and matches all the Seriousness, Listedness, Relatedness, Fatal values for the diagnosis in the case against the product(s) for which the report is being run, with the corresponding values selected by the user in the Report configuration.  
    - When there are no diagnosis in the case, the system scans all the events in the case and matches all the Seriousness, Listedness, Relatedness, Fatal values for the events in the case against the product(s) for which the report is being run, with the corresponding values selected by the user in the Report configuration.  
    - When multiple products are configured in the report, a match of all the Seriousness, Listedness, Relatedness and Fatal values against even one product-diagnosis is considered as a match for including the case.  
  - Evaluate case inclusion based on following seriousness, listedness, causality option groups - Case Inclusion criteria for the ICH PSUR/CTPR report based on Seriousness OR Case Inclusion criteria for the ICH PSUR/CTPR report based on Causality OR Case Inclusion criteria for the ICH PSUR/CTPR report based on Listedness. |
| Determine Possible Causality from the causality score                             | This field enables the user to enter a numeric value. |
| Determine Probable Causality from the causality score                             | This field enables the user to enter a numeric value. |
| On PSUR, NDA, IND, Medical Review List Reports                                    | The available options are:  
  - Use Initial Receipt Date for date range search  
  - Use Safety Date for date range search |
| Print footnote ‘Non-Serious Listed’ for non-serious listed cases in ICH PSUR report | The available options are:  
  - Yes  
  - No |
| Assessment of Listedness and Causality when both Licenses and Studies are selected in CTPR | The available options are:  
  - Based on selected liscenses  
  - Based on selected studies |

Use the following procedure to configure periodic reports.

1. Select the option for Inclusion Criteria for cases in the ICH PSUR report.
2. Select the option for Print footnote "Non Serious Listed" for non-serious listed cases in ICH PSUR report.
3. Select the option for Inclusion criteria of event for a product in the PSUR.
4. Enter the value for Determine Possible Causality from the causality score.
5. Enter the value for Determine Probable Causality from causality score.
6. Select the option for On PSUR, NDA, IND, Medical Review List Reports.
7. Click **Save** to save the changes made to this screen.

**Scheduling Reports Configuration** The Scheduling Reports Configuration screen enables you to modify the options available for scheduling reporting. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **Reporting** section, click the **Reporting** folder in the left panel. The **Scheduling** sub-folder is displayed in the left panel.

Click on the **Scheduling** sub-folder to configure the scheduling report options. The configurable fields associated with **Scheduling Reports** appear in the right panel.

![Scheduling Reports Configuration Screen](image)

**Field Descriptions**
The following table lists and describes the fields available under **Schedule Reports**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Scheduling</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>- Report Scheduling will be run by the Middle Tier Service</td>
</tr>
<tr>
<td></td>
<td>- All report scheduling will be done locally on the client machine</td>
</tr>
<tr>
<td>Enable separate scheduling of device</td>
<td>The available options are:</td>
</tr>
<tr>
<td>reporting rules from drugs and vaccines</td>
<td>- Yes</td>
</tr>
<tr>
<td></td>
<td>- No</td>
</tr>
<tr>
<td>Report Scheduling Causality Operand</td>
<td>Enables the user to select from the causality operands AND/OR to use for</td>
</tr>
<tr>
<td></td>
<td>scheduling a report.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure scheduling.

1. Select the option for **Report Scheduling**.
2. Select the option for Enable separate scheduling of device reporting rules from drugs and vaccines.
3. Select the operand to use for scheduling a report from **Report Scheduling Causality Operand**.
4. Click **Save** to save the changes made to this screen.

**Configuring Security**

The Security Configuration screen enables you to modify the options available for security. Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **Security** section, click the **Common Profile-> Security** folder in the left panel. The configurable fields associated with **Security** appear in the right panel.

**Field Descriptions**

The following table lists the fields available under **Security**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of previous passwords that cannot be repeated</td>
<td>Enables you to configure the number of passwords that can be allowed. For example, if you enter 4 in this field, it configures the system to enable up to 4 previous passwords that cannot be used as passwords again.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure security.

1. Enter the value for the number of unique previous passwords in **Number of previous passwords that cannot be repeated**.
2. Enter the value for the number of non-alpha characters in **Number of non-alpha characters in password**.
3. Enter the value for the minimum number of characters for a password in **Minimum number of characters in the password**.
4. Enter the value for the number of consecutive failed login attempts before account is locked out in **Number of consecutive failed login attempts before account is locked out**.
5. Click **Save** to save the configured values.
6. Click **LDAP** to configure the LDAP fields.

The configurable fields associated with **LDAP** appear in the right panel.

**Field Descriptions**
The following table lists and describes the fields available under **LDAP**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of non-alpha characters in password</td>
<td>Enables you to configure the number of non-alpha characters that should exist in a password. Non-alpha characters include characters such as @, $, etc. Note: To avoid bad configuration, we recommend that the value of this switch is kept as 0 or 1 only.</td>
</tr>
<tr>
<td>Minimum number of characters in the password</td>
<td>Enables you to configure the minimum number of characters that a password must have. For example, if you enter 8 in this field, it configures the system to ensure that every password contains at least 8 characters.</td>
</tr>
<tr>
<td>Use Secure property for cookies</td>
<td>Enables you to select whether to use secure property for cookies.</td>
</tr>
<tr>
<td>Number of consecutive failed login attempts before account is locked out</td>
<td>Enables you to configure the number of consecutive failed login attempts that can be allowed before an account is locked out. For example, if you enter 3, it means that up to 3 consecutive failed login attempts are allowed. If the fourth consecutive login attempt also fails, the account gets locked out.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure security:

1. Select the option for Enable LDAP at system level.
2. Click **Yes** to enable the LDAP Search Domain Account. This displays the **LDAP Search Domain Account** dialog.
The following table describes the fields of the LDAP Search Domain Account dialog:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Secure Socket Layer</td>
<td>If your LDAP Server is configured to use SSL for communication, please check this box. Use of SSL enables for a Secure communication between the client and the server using secure keys.</td>
</tr>
<tr>
<td>Force Anonymous Binding for Search</td>
<td>When setting up the LDAP Server, you have the option to force users to bind (authenticate) to the LDAP Server prior to being able to search the LDAP Tree. If this option has been setup in your LDAP server, this option must be checked.</td>
</tr>
<tr>
<td>UserDN</td>
<td>During the setup of the LDAP server, the distinguished name and tree structure is created for users to be configured under. Enter in the defined structure as defined in your LDAP server into this box. This is required only if the server is setup for Force Anonymous Binding for Search”.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter in the password for the User entered in the UserDN box for the bind to the server.</td>
</tr>
<tr>
<td>Server Name</td>
<td>Enter in the LDAP Server name or IP Address to which LDAP Authentication needs to occur on.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Enter the port on which the LDAP Authentication Services are enabled on the LDAP Server (Default Value: 389).</td>
</tr>
<tr>
<td>BaseDN</td>
<td>Enter in the topmost distinguished name of your tree defined on the LDAP Server for which you would like to search for users under.</td>
</tr>
<tr>
<td>Time Out (Sec)</td>
<td>Enter a value in seconds, which will tell Argus how long to wait for a response from the LDAP Server during any authentication before timing out (Default Value: 10).</td>
</tr>
<tr>
<td>LDAP Search Key</td>
<td>Enter the key to authenticate the user name against in the LDAP Tree structure. For Example, when using Microsoft Active Directory, to authenticate using the Windows Username (Not Full Name), enter in sAMAccountName.</td>
</tr>
</tbody>
</table>
If you select the **Use Secure Socket Layer (SSL)** checkbox, the **Port Number** is auto-populated with the value **636**.

If this checkbox is not selected, the **Port Number** is auto-populated with the value **389**.

A generic LDAP server can accept anonymous as well as non anonymous binding, based on the configuration.

If the **Force anonymous binding for search?** checkbox is not selected, both **UserDN** and **Password** are enabled.

3. Enter the LDAP username and password in the **UserDN** and **Password** fields, respectively.

4. Enter the values for **Server Name**, **Port Number**, **Base DN**, **Time Out** and **LDAP Search Key**, as required.

   - The field length for **Port Number** and **Time Out** is 5 characters, while the **Server Name**, **BaseDN**, **LDAP Search Key**, **UserDN** and **Password** can be up to 255 characters.

5. Click **Save** to save the changes made to this screen.

**Configuring Cryptography within Common Profile > Security**

Common Profile > Security > Cryptography contains two key settings:

1. Configured hashing algorithm to use - This setting determines the Hashtag algorithm that will be used in encrypting passwords.

2. *De-optimizer counter for hashtag routine* - This setting determines the strength of encryption (for example, the higher the value of this setting, the stronger will be the encryption, and vice-versa). The default/recommended value is **1000**.

**Configuring Single Sign-on**

A common profile switch determines whether the system uses the Single Sign-on function. The Enable Single Sign-on checkbox, enables you to configure the system to use the single sign-on feature.

Before enabling the single sign-on feature, be aware of the following:

- If the user enables the Single Sign-on feature, the user must enter Single Sign-on the HTTP Header element Argus application uses for authentication.
  - This field can contain a maximum of 40 characters
  - If the Single Sign-on feature is enabled and the user does not enter the Single Sign-on HTTP Header, the system displays the following error message:

- Please enter the Single Sign-on HTTP Header or disable the Single Sign-on feature.

1. The following new entries which are common across all enterprises have been added in Argus Console -> System Management (Common Profile Switches) -> Single Sign-On:

   A new checkbox called **Use Oracle Access Server SDK for LDAP Validation** under Single Sign-On tree will become available for selection only when 'Enable Single Sign-On' is checked.

   This configuration is used to identify use of Oracle ASDK for user action confirmation, ESM login and EOSU Login functionality.
If this checkbox is checked, Oracle ASDK is used for action confirmation, ESM Login and EOSU Login when Argus Safety is configured for Single Sign-On.

If this checkbox is not checked, LDAP server information is used from Argus Safety database for user action confirmation, ESM Login and EOSU Login.

2. A new textbox called Oracle Access Server Login URL has been added under the Use Oracle Access Server SDK for LDAP Validation checkbox.

This is the base URL which is be passed to Oracle ASDK for user validation against Oracle Access Manager.

3. A new textbox called Oracle Access Server Login URL has been added under the Use Oracle Access Server SDK for LDAP Validation checkbox.

This is an HTTP Header variable for retrieving the short org ID which is to be passed with ASDK Login URL.

4. If the Use Oracle Access Server SDK for LDAP Validation checkbox is checked, the application ignores any LDAP configuration present in Argus Safety database and it is not possible to select LDAP Server Alias for any user from Argus configuration.

The following table lists dialog boxes in the Argus Application that must require passwords. In such cases, the system Single Sign-on feature redirects the password to Argus for validation. When single sign-on is enabled, the system locks the user account if the user enters and incorrect password three consecutive times. The Administrator must unlock the account to enable the user to log in to the application.

<table>
<thead>
<tr>
<th>Function</th>
<th>Section</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Locking</td>
<td>Activities | Lock</td>
<td>Locking a case</td>
</tr>
<tr>
<td>Case Unlocking</td>
<td>Activities | Lock</td>
<td>Unlocking a case</td>
</tr>
<tr>
<td>Case Closing</td>
<td>Activities | Close</td>
<td>Closing a case</td>
</tr>
<tr>
<td>Case Unclosing</td>
<td>Activities | Close</td>
<td>Unclosing a case</td>
</tr>
<tr>
<td>Case Unblinding</td>
<td>General | Blinding Status</td>
<td>Breaking a blind</td>
</tr>
<tr>
<td>E2B Incoming Accept</td>
<td>Reports | Incoming E2B Reports</td>
<td>Accepting E2B Reports</td>
</tr>
<tr>
<td>E2B Incoming Reject</td>
<td>Reports | Incoming E2B Reports</td>
<td>Rejecting E2B Reports</td>
</tr>
<tr>
<td>E2B Incoming Follow-up</td>
<td>Reports | Incoming E2B Reports</td>
<td>Accepting E2B Follow-up Reports</td>
</tr>
<tr>
<td>E2B Incoming Follow-up</td>
<td>Reports | Incoming E2B Reports</td>
<td>Rejecting E2B Follow-up Reports</td>
</tr>
<tr>
<td>E2B Incoming Nullification Accept</td>
<td>E2B Incoming Nullification</td>
<td>Accepting E2B Nullification Reports</td>
</tr>
<tr>
<td>E2B Incoming Nullification Reject</td>
<td>E2B Incoming Nullification</td>
<td>Rejecting E2B Nullification Reports</td>
</tr>
<tr>
<td>LAM Incoming</td>
<td>Local Affiliate Incoming Review</td>
<td>Accepting an Affiliate Event</td>
</tr>
<tr>
<td>Workflow Routing</td>
<td>Workflow Routing on Password on Route</td>
<td>Workflow Routing on Password on Route</td>
</tr>
</tbody>
</table>

Oracle Access Server SDK Support for LDAP Validation in Single Sign-On Environment
Argus Safety has been enhanced to support action confirmation (user id/password) using Oracle Access Server SDK.

If customers do not want to store the LDAP information in Argus database for single sign-on environment, this new feature of Argus Safety can be used to validate a user's actions through ASDK.

This feature is available only while using Oracle Access Manager as the Single Sign-On tool.

The following is a list of places where the Argus Safety web dialog which requires action confirmation to perform respective actions, has now been enhanced to validate a user using Oracle ASDK:

1. Case Lock/Unlock
2. Case Routing
3. Case Delete/Undelete
4. Case Archiving
5. LAM Routing
6. Study Unblinding
7. ESM Login
8. EOSU Login

There is no change in the user experience while performing actions which requires password validation for logged-in user.

The following modules launched in the Argus Application, continue to use Single Sign-on feature:

- Argus Insight
- Argus Affiliate
- Argus J

The following modules do not use the Single Sign-on feature:

- End of Study Unblinding
- Argus Safety Services
- Argus Interchange Services (ESM)
- Argus Interchange Mapping (ESM Mapping Utility)

Error Messages

Once the user is configured, the system automatically logs the user into the Argus Application without requiring reauthentication on the Argus Login application. If there is an authentication error, the system displays the current login page so the user can log in manually.

Configuring SMTP

This screen enables you to configure SMTP.

Currently there are multiple issues such as, Outlook related problems with AG Service due to new security features introduced by Microsoft. Due to these security enhancements, a new method to submit emails from AG Service has been implemented using the SMTP Protocol.
Select **System Configuration -> SMTP Configuration** to view the SMTP configuration pop-up dialog. The pop-up dialog opens as shown.

Field Descriptions  The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server IP or Name</td>
<td>Enables the user enter the SMTP server name / IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>Enables the user to enter the port number to use for SMTP server.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Enables the user to select the Authentication mode for SMTP configuration</td>
</tr>
<tr>
<td>SMTP User Name</td>
<td>This is the username that the AG Service authenticates with for SMTP Emailing.</td>
</tr>
<tr>
<td>SMTP Password</td>
<td>This is the password that the AG Service authenticates with for SMTP Emailing.</td>
</tr>
<tr>
<td></td>
<td>This field is required when Basic Authentication is selected in Authentication.</td>
</tr>
<tr>
<td>Enable SMTP</td>
<td>When this checkbox is checked, SMTP is used by AG Service to send emails.</td>
</tr>
</tbody>
</table>

Use the following procedure to modify SMTP.

1. Enter the SMTP **Server IP or Name**.
2. Enter the **Port** number to use for SMTP server.
3. Select the **Authentication** mode for the SMTP configuration, from the drop-down list.
4. Enter the **SMTP User Name**.
5. Enter the **SMTP Password**.
6. Select **Enable SMTP?** to ensure that the AG Service implements SMTP to send e-mails.
7. Click **OK** to save the changes made.

**Note:** If Argus Safety needs to use the proxy set up for SMTP configuration, ensure that the Proxy setting is configured under System Configuration > System Management > Network Settings > Proxy.
Configuring Workflow Items

The Workflow Items screen enables you to modify the options available for Workflow Items.

Select System Configuration -> System Management to view the Common Profile Configuration screen.

**Tip:** The Common Profile folder appears in a tree-view on the left panel. The components are categorized as folders. Each folder contains all the field labels associated with that section.

To configure the fields associated with the **User Interface** section, click the **Common Profile->Workflow** folder in the left panel. The configurable fields associated with **Workflow** appear in the right panel.

This section enables you to configure the total number of hours remaining for the present workflow state as well as the Total Number of the hours remaining for the case lock.

- The first element displays the number of hours remaining for the case to be processed with the current workflow state.
- The second element displays the number of hours remaining for the entire workflow for the case till Case Approval (Case Lock).
- If the time remaining is less than the specified value in % **for Yellow Indicator on the Case form for Dynamic Workflow**, the elements are highlighted in yellow.
- If the time remaining is more than the specified value in % **for Yellow Indicator on the Case form for Dynamic Workflow**, the elements are highlighted in green.
- If the time remaining has exceeded the allocated time for the case process, the value is displayed in red, with the time displayed in negative.
- The exceptions to this feature are those cases, which are archived and locked.
The **Worklist > New** and **Worklist > Open** also display a ! status beside **Priority**, denoting that the time remaining has exceeded the allocated time.

The total number of units is calculated by navigating across the possible routes the case can traverse. In case a case has to traverse through multiple possible routes, the preferred route is selected.

**Field Descriptions** The following table lists the fields available under **Workflow**:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Routing</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Case form to close after use performs a manual routing</td>
</tr>
<tr>
<td></td>
<td>■ Case form to remain open</td>
</tr>
<tr>
<td>Display Locked/All cases on the worklist</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ Display option on the Worklist screen to view Locked Cases requiring follow-up only. (Default)</td>
</tr>
<tr>
<td></td>
<td>■ Display all the cases at the time</td>
</tr>
<tr>
<td>Minimum length of the routing comment text length</td>
<td>The available options are:</td>
</tr>
<tr>
<td></td>
<td>■ None</td>
</tr>
<tr>
<td></td>
<td>■ Text field</td>
</tr>
<tr>
<td>Due Soon Duration (in Days) for Worklist Calculation</td>
<td>Enter the number of days in which the worklist calculation is due.</td>
</tr>
<tr>
<td>Due Soon Red Indicator (in Days) for Worklist Display</td>
<td>Enter the number of days in which the red indicator is to due to be displayed for the worklist.</td>
</tr>
<tr>
<td>% for Yellow Indicator on the Case form for Dynamic Workflow</td>
<td>Enter the percentage for the yellow indicator on the case form for dynamic workflow. This field cannot have a value more than 99.</td>
</tr>
<tr>
<td>Enable Dynamic Workflow Timing</td>
<td>Select this checkbox to view the dynamic workflow indicators on the case form.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure workflow items.

1. Select the option for **Case Routing**.
2. Select the option for **Display Locked/All cases on the worklist**.
3. Enter the **Minimum length of the routing comment text length** in the text box.
4. Select the option for **Display date for cases in the worklist**.
5. Enter the number of days in which the worklist calculation is due in **Due Soon Duration (in Days) for Worklist Calculation**.

6. Enter the number of days in which the red indicator is to due to be displayed for the worklist in **Due Soon Red Indicator (in Days) for Worklist Display**.

7. Enter the percentage for the yellow indicator on the case form for dynamic workflow in **% for Yellow Indicator on the Case form for Dynamic Workflow**.

8. Select the **Enable Dynamic Workflow Timing** checkbox to view the dynamic workflow indicators on the case form.

9. Click **Save** to save the changes made to this screen.

**Configuring Workflow**

When a case is received by the company and initial details have been entered and saved into Argus Safety, its status in the system becomes 'New' or 'Data Entry'. Various actions may be required before a case makes the transition from one workflow state to another.

**Example:** The case may require review, letters may need to be issued, the case may need to be reported elsewhere in the company, or regulatory reports need to be submitted to regulatory authorities. The case can be closed after all outstanding actions have been carried out and it flows through its life cycle.

For each stage in case processing, Argus Safety enables responsibility for cases to be assigned to specific user or group of users. Click the following link for information about how worklist permissions have changed.

**Worklist Updates**
The Worklist is driven by the group permissions defined for each user.

- Granular permissions have replaced the current worklist options for the following worklist elements in group permissions:
  - Worklist - New
  - Worklist - Open
  - Worklist - Reports
  - Worklist - Action Items
  - Worklist - Coding Action Items
  - Worklist - Contacts
  - Worklist - Bulk Transmit
  - Worklist - Bulk Print
  - Worklist - Bulk E2B Transmit
  - Worklist - Local Labeling
  - Worklist - Coding Status
  - Worklist - Letters
  - Worklist - Intake (default is disabled)

- If the worklist is disabled during the upgrade, then all the sub-elements are disabled; otherwise, all are enabled.

- The default for **New Group Creation** is enabled.
- The User Group Permissions Report has been updated to reflect granular permissions.

**Configuring Case Workflow**

Configuring case workflow involves configuration of:
- Workflow States
- Workflow Rules

**Configuring Workflow States** This screen enables you to configure the workflow states. The following illustration shows the fields associated with this section.

![Workflow States Configuration](image)

**Field Descriptions**

The following table lists and describes the fields available under Total Number of Rows:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Name</td>
<td>Displays the name of a workflow state.</td>
</tr>
<tr>
<td>State Description</td>
<td>Displays a brief description about the workflow state.</td>
</tr>
<tr>
<td>Site</td>
<td>Displays the site associated with a workflow state.</td>
</tr>
</tbody>
</table>

**Tip:** Click Add New to add a new workflow state to the list of existing workflow states.

Use the following to modify workflow states

1. Enter the name of the workflow state under State Name.

**Tip:** This name is displayed as Case Status in the General Information section of the Case Form.
2. Enter the description of the workflow state under **Description**.

3. Select the site to be associated with the workflow state from the **Site** drop-down list.

4. The drop-down list is populated with the configured user sites.

5. Click **Save** to save the changes made.

**Configuring Workflow Rules**  This screen enables you to configure workflow rules. The following illustration shows the fields associated with this section.

![Workflow Rules Screen](image)

**Field Descriptions**

The following table lists the Field Descriptions for this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Defines the original state for the transition.</td>
</tr>
<tr>
<td>To</td>
<td>Defines the destination state for the transition.</td>
</tr>
<tr>
<td>Group</td>
<td>Specifies the group which will own the case once it moves from the From state to the To state (via this transition). The drop-down list displays all the configured user groups of Argus.</td>
</tr>
</tbody>
</table>
System Configuration Overview

Normal Time (days)
- The workflow system monitors the time frames of each case in a state with respect to the Normal and Maximum parameters through AG Service.
- If a case has existed in its current state longer than the Normal time specified for the transition, the system raises the priority of the case by one level.

Max Time (days)
- The AG Service evaluates the status of each open case.
- If a case has existed in its current state longer than the Maximum time specified for the transition, the system raises its priority to level one (the highest priority).
- In addition, an email notification is sent to the group’s supervisor, indicating that the case has exceeded its maximum time.
- The email message identifies the Case ID, Current State, Current Owner, and the time it has spent in its current state.

User Defined Attribute 1
- Lets a user define a custom attribute for a workflow rule such as logically grouping workflow rules. Used only for filtering purposes on the same screen.

User Defined Attribute 2
- Enables the user to specify the number of units.

Product Group
- Enables the user to associate a specific Product group as additional criteria for the workflow transition.

Restrict to Workflow Group
- Enables the user belonging to the identified workflow rule group to have case access rights, based on the definitions of only the identified group.

Email
- When checked, the system sends an email notification to the user group address specified in group information whenever a case makes this particular transition.
- By default, the checkbox is unchecked.

Require Password on Route
- If the switch PASSWORD_ON_ROUTING is disabled (0), the password option on the Workflow Dialog is not displayed and the Routing dialog does not ask the user for a password.
- If the switch PASSWORD_ON_ROUTING is enabled (1), the password option on the Workflow Dialog is displayed to users. If the Workflow Rule has the password option checked and the case being routed passes that workflow rule criteria, the password option is displayed on the routing dialog.
- If the Workflow Rule that the case has passed does not have the Password option checked, no password option is displayed on the routing dial.

Lock Case on Route
- Enables the user to lock the case on routing. Users might need to enter a password when routing to the case.

Reason for not being able to route
- Enables the user to enter the description needed by the system to display while routing the case, when the case is ineligible to be routed to any of the configured To State.
### Use the following procedure to modify workflow rules.

1. Select the appropriate **Filter Criteria**.
   - Execute the following steps to apply a filtering criteria to search for specific workflow rules.
   - Select the check boxes to enable the drop-down lists containing a filtering criteria.
   - Select the appropriate filtering criteria from the drop-down lists.
   - Click **Search** to remove the selected criteria or click **Apply Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.

2. The entities in **Total Number of Rows** display the **From** and **To** states, the Advanced Condition, Group, Normal Time/Max Time and Number of User Defined Attributes in the Workflow.

3. Select the rule displayed under **Total Number of Rows** that needs to be modified.

4. The **ModifyWorkflow Rules** section is populated with information about the selected rule.

5. Select the original state of the workflow rule from the **From** drop-down list.

6. Select the destination state of the workflow rule from the **To** drop-down list.

7. Select the group from the **Groups** drop-down list.

8. Select the product from the **Product Group** drop-down list.

9. Select the **Email** checkbox, if required.

10. Select the **Lock Case on Route** checkbox, if required.

11. Select the **Require Password on Route** checkbox, if required.

12. Enter the number of days in the **Normal Time** (days) field.

13. Enter the number of days in the **Max. Time** (days) field.

14. Enter the number of units in the **Units** field.

15. Select the preferred state for the rule from **Preferred State**.

16. Select the relevant **Advanced Condition**, if any from the button.

   **Tip:** Click here for details on Advanced Conditions

17. Enter the reason for not being able to route, if applicable, under **Reason for not being able to route**.

---

### Field/Control Name | Description
---|---
Privileges to others | Specifies the access rights for groups other than To Group’ of the transition have to the case when it follows that transition. The choices are:
  - No Access
  - Read-Only
  - Read/Write (default)
Preferred State | Enables the user to specify the preferred state for the rule.
18. Specify the access levels available to others from the Privilegesto others drop-down list. The options available under this list are No Access, Read-Only and Read/Write.

   **Tip:** Select the No Access option to disallow users outside the transition’s group to open the case when it follows the transition.

   Select the Read-Only option to enable users outside the transition’s group to view the case, but not to modify it.

   Select the Read/Write option to enable users outside the transition’s group to modify the case when it follows the transition.

19. Specify the checklist of items to appear under Checklist.

   **Tip:** The Checklist row cannot be left blank. Click **Add** and **Delete** to add and delete checklist items.

20. Define custom attributes for a workflow rule under User Defined Attribute.

21. Click **Save** to save the changes made.

**Worklist Intake**

This section provides information about the Worklist Intake feature.

**Pending Dialog** The system enables the user to view a list of incoming attachments in Worklist View. In this view, the user can select an attachment for the case creation for Argus and Affiliate cases in the Pending dialog.

The following table lists and describes the fields available for the worklist:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
<th>Bookin Field</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Enables you to view the priority of a case</td>
<td>N/A</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Initial Date</td>
<td>Enables you to view the Initial Receipt Date of the case.</td>
<td>Initial Receipt Date</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Field/Control Name</td>
<td>Description</td>
<td>Bookin Field</td>
<td>Property</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>--------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Intake Date</td>
<td>Enables the user to view the date the system imported the attachment in the Intake Worklist</td>
<td>N/A</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Product Name</td>
<td>Enables you to view the suspect product in questions.</td>
<td>Product Name</td>
<td>Scrollable field label</td>
</tr>
<tr>
<td>Generic Name</td>
<td>Enables you to view the generic name of the suspect product in question.</td>
<td>Generic Name</td>
<td>Scrollable field label</td>
</tr>
<tr>
<td>Event PT</td>
<td>Enables you to view the primary event and verbatim as reported</td>
<td>N/A</td>
<td>Scrollable field label</td>
</tr>
<tr>
<td>Event Verbatim</td>
<td>The following format will be used: Primary Event (Verbatim as Reported)</td>
<td>N/A</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Serious</td>
<td>Enables you to view the Case Level Assessments Serious (Y/N)</td>
<td>N/A</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>F, LT, or H</td>
<td>Fatal (F) or Life Threatening (LT) or Hospitalized (H)</td>
<td>Death for F, Hospitalized for H, Life Threatening for LT</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td></td>
<td>■ If the case is Fatal, print F</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ If the case is Life Threatening, print LT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ If the case is Hospitalized, print H</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ If any of the preceding are present together, Fatal takes precedence followed by LT, followed by H</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ If the case is neither, display No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case Type</td>
<td>Enables you to view report type information.</td>
<td>Report Type</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Study ID</td>
<td>Enables you to view the Study ID for the study cases. This field is empty for cases where the Study ID is not available.</td>
<td>Study ID</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Reporter Type</td>
<td>Enables you to view the reporter type for the primary reporter in the case. This field is empty if the reporter type is not available.</td>
<td>N/A</td>
<td>Non-scrollable field label</td>
</tr>
<tr>
<td>Country</td>
<td>Enables you to view the country of incidence.</td>
<td>Country of Incidence</td>
<td>Scrollable field label</td>
</tr>
</tbody>
</table>
### Worklist Intake View

The following table describes the Worklist Intake View:

<table>
<thead>
<tr>
<th>Argus Site</th>
<th>Folder</th>
<th>Worklist Intake View</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>C:\USINTAKE</td>
<td>All users belonging to the US site can see the case and workflow enterprise users.</td>
</tr>
<tr>
<td>DE</td>
<td>C:\EUINTAKE</td>
<td>All users belonging to the DE, FR, CH site can see the case and workflow enterprise users.</td>
</tr>
<tr>
<td>CH</td>
<td>C:\EUINTAKE</td>
<td>All users belonging to the DE, FR, CH site can see the case and workflow enterprise users.</td>
</tr>
<tr>
<td>FR</td>
<td>C:\EUINTAKE</td>
<td>All users belonging to the DE, FR, CH site can see the case and workflow enterprise users.</td>
</tr>
<tr>
<td>JP</td>
<td>C:\JPINTAKE</td>
<td>All users belonging to the JP site can see the case and workflow enterprise users.</td>
</tr>
</tbody>
</table>

### Worklist

■ The system reads the XML that contains the preceding fields as tags and creates the Worklist based on the tags.
<Cases>
  <Case>
    <PRIORITY>: Single number from 1 - 8. All others to be ignored
    <INITIAL_DATE>: Format of Date DD-MMM-YYYY
    <PRODUCT_NAME>: Text Field up to 70 Characters
    <GENERIC_NAME>: Text Field up to 70 Characters
    <EVENT_PT>: Text Field up to 250 Characters
    <EVENT_VERBATIM>: Text Field up to 250 Characters
    <SERIOUS>: Yes / No. All others are ignored
    <FLTH>: Format of F. All other after that are ignored
    <LT>: Format of LT All other after that are ignored
    <H>: Format of H. All other after that are ignored
    <CASE_TYPE>: Text field of report type
    <STUDY_ID>: Text field of Study ID
    <REPORTER_TYPE>: Text field of Reporter Type
    <COUNTRY_OF_INCIDENCE>: Text field of Country
    <ASSIGNED_TO>: Text field of User
    <GROUP>: Text field of Group
    <SITE>: Text field of Site
  </Case>
</ATTACHMENTS>
  
</ATTACHMENT>
  
  <FILENAME>: Text field of Attachment File Name
  <DOCID>: Document ID from Document Storage System
  <CLASSIFICATION>: Text field of Attachment Classifications
  <DESCRIPTION>: Text field of Attachment Classifications Descriptions

- The text on the worklist prints as specified in the XML and no lookup is performed.
- If any of the Tag elements are empty they will be empty in the Intake Worklist.
- If any fields are not available on the initial case entry, the system ignores them.
- If there are multiple tags for the same element, the system retrieves the first tag element.
- If the values do not match any elements in the Initial Case entry, the system ignores them.
- The minimum fields required for the Attachment to be visible in the Intake Worklist are
  - Filename
  - DocID
- DocID is only required if a central document system is enabled. If DocID is blank then the physical file with the same name as specified in the tag <Filename> is also required in the same folder.

- If there is an error occurs while processing the Worklist, AG Service sends an e-mail to the General E-mail address.

- The system enables you to select only one case at a time when creating cases in the Initial Case entry dialog.
  - When you select an attachment row and click Create case, the system locks the file to prevent others users from booking in the same case.
  - The system displays the following message:
    The case attachment is being currently used by XXXX user.
    where:
    XXXX is the full name of the user who has locked the attachment row
  - The system displays the standard Initial Case Entry where the system populates the fields within the XML Properties to the Initial Case entry dialog and display the PDF file for 40% of the screen (Similar to the New case from Image functionality)
  - If multiple attachments are available, the system opens them. The end user system must be setup to open multiple documents in the same window in Internet Explorer.
  - If the system is setup to use a central document storage system and the user clicks Create Case, the system retrieves the PDF from the central document system.
  - The system adds the attachment to the Initial Case entry dialog and also includes the Classifications and Descriptions for the attachment.
  - If the system is setup to use a central document storage system, Argus stores the document ID from the central document system. The file attachment will not be stored in Argus.

- The system fills all available fields in the Initial Case Entry dialog with data from the XML Messages.

- If you choose to open the cases after book-in, the system keeps the Attachment open in the split screen to enable the user to complete the case data entry.

- If you book in the case from the Worklist Intake and chooses not to open the case from the Initial Case Entry dialog after book in is complete, the system returns to the Worklist Intake dialog.

- When you perform a Duplicate Search and select a Case from the list, you can attach an incoming file to an existing case.
  - The system displays the Accept As Follow-up button and enables it when the user selects a case from the Duplicate search for the current Attachments to be added.
  - When you click Accept as Follow-up, the system opens the selected case and continues to display the Source attachments.
  - The system adds the attachments with the Classification and description (if provided) to the follow up case.
The system opens multiple attachments if they are available. The end user system must be setup to open multiple documents in the same window.

- Once you accept the initial or Follow up case and successfully create the case in Argus / Affiliate, the system generates an Acknowledgement in the OUT folder at the same level. For example, if the incoming folder for Site US is C:\USSITE\Incoming, the system generates ACKS in the C:\USSITE\OUT folder.
  - a. The Message format for the ACK is as follows:
    
    ```xml
    <CASES>
    <CASE>
    <CASE_NUMBER>: Argus Generated Case Number
    <PRODUCT_NAME>: Text Field up to 70 Characters for Primary Suspect Product of Case
    <DATETIME>: The Date and time in the DD-MMM-YYYY hh:mm:ss format when the file was accepted / rejected by the system
    <ATTACHMENTS>
    <ATTACHMENT>
    <FILENAME>: Text field of Attachment File Name
    <DOCID>: Document ID from Document Storage System
    ```

- If you click Copy to copy a case in Argus, the system generates an ACKS and puts it into the out folder for the site the original case belongs to. For example, Case A belongs to US Site and the user copies the case to Case B. The system creates an ACK in the US\Out Folder as configured in the US Site.

Rejected Cases In Argus Safety, the Workflow Manager or Enterprise User can click Reject Case to reject cases from the Intake Worklist.

- Affiliate Users can reject cases in the Intake Worklist.
  - When you try to reject a case, the system presents the Standard Justification dialog.
  - The Status row displays the following message:
    
    Case Rejected by XXXX on YYYY at MMM due to: ZZZZ
    
    where:
    
    XXX is the User Full Name,
    
    YYYY is the Date when the case was rejected in GMT
    
    MMM is the time in GMT
    
    ZZZ is the justification for rejecting the case as entered by the user.
  - Rejected Date: Date in GMT when the user rejected the case
  - Rejected By: User Full Name who rejected the case.

- The system displays the **Total number of Rows** in the Worklist header section.

- You can select the number of cases to display on the by selecting a value from page size drop-down list on the Worklist dialog.

- The page drop-down list contains the following values:
  - 50
System Configuration Overview

- 100 (default)
- 250
- 500
- 1000
- 2000

- The system displays the number of cases currently in view and updates the range automatically. For example, if you select 100 from the page size drop-down list, the system separates the displaying rows into groups of 100 cases.

- The system enables you to go directly to a range of cases from the Displaying Rows drop-down list.

- The system enables you to scroll through the Worklist page-by-page increments as defined by the Page Size drop-down list.

- The system enables you to sort on ALL the columns in the Worklist view by clicking the header column. The system displays a triangle to show which column is sorted currently.
  - The initial sorted column is Initial Date.
  - The default sort order is ascending
  - Clicking the column header again, toggles between ascending and descending order.

- The system maintains the worklist view with the sorting and filtering options defined by the user.

- The Intake Worklist enables you to filter on each element.

- The system enables you to filter on any element when you click the Filter button.
  - The system provides a Type Ahead feature to enables users to filter on any text/date element.
  - The system enables you to Close the filtering options by clicking the X icon on the filtering options.
  - If filtering criteria are specified, the Filter icon has the paper clip icon to indicate there are filtering elements.
  - The system permits a Like search (e.g. if you search for Cure, it returns all elements starting with Cure).
  - The system enables wild card searches . For example, if the user searches for %Cure, the system returns all elements containing Cure
  - Clicking the Search button enables you to filter for the reports in the list of reports.
  - These are filtering options are available from Worklist-specific views and when you drill down for cases or reports.

- The system saves all user preferences for future use.

- Clicking the Search button enables you to filter the elements on the dialog.

User Site Updates and Access Management You can configure the Path for the File Intakes per Site (Argus and LAM) in the Site configuration
When you click the **Browse** button, the system enables you to browse to the Folder for the Site where the XMLS and the PDFs are stored.

The Path length is up to 255 characters.

The current Worklist options are replaced with granular permissions for Worklist elements in the Group Permissions as per the following:

- Worklist Intake (default is disabled)
- The Audit Log tracks the updates made to Site Configuration
- The User Site print out displays the File Intake Path.

**Configuring System Numbering**

This screen enables you to specify the case numbering preferences. Select **System Configuration -> System Numbering** to view the LAM System Numbering screen.

The screen appears as shown.

**Field Descriptions**

The following table lists and describes the fields for this section.
<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually Number Cases</td>
<td>Enables the user to manually number the cases on booking or while copying the case, using the save as' option on the case form.</td>
</tr>
<tr>
<td>Automatically Number Cases</td>
<td>On selection, the system automatically numbers the cases as defined by the user in the numbering format.</td>
</tr>
<tr>
<td>Start at</td>
<td>Enables the user to initialize the counter of the sequence number.</td>
</tr>
<tr>
<td>Separate sequence for each site</td>
<td>Enables the user to separate the sequence numbering for cases on site by site basis. If there are cases being entered from two different sites then each site will have different sequencing of case numbers.</td>
</tr>
<tr>
<td>Separate sequence for each report type</td>
<td>Enables the user to separate the sequence numbering for cases by the report type of the case.</td>
</tr>
<tr>
<td>Separate sequence for each year</td>
<td>Enables the user to reset the sequence numbering for cases after each year based on the initial receipt date of the case.</td>
</tr>
<tr>
<td>Separate sequence for each month</td>
<td>Enables the user to reset the sequence numbering for cases after each month based on the initial receipt date of the case.</td>
</tr>
<tr>
<td>Separate sequence for each product abbreviation</td>
<td>Enables the user to reset the sequence numbering for cases for each different product abbreviation.</td>
</tr>
<tr>
<td>Numbering Format</td>
<td>Enables the user to select the numbering format by selecting the different placeholders. Define the numbering format by typing in custom keywords to print on every case number and selecting different placeholders. [YY][MM]-[#] is the default format.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>Placeholders are used to pickup values from the database to be used in the Case numbering format. The possible values populated in this list are:</td>
</tr>
<tr>
<td># - Number</td>
<td>defines the digits to be used as the sequence number in the format. The field is used to display the sequence number on the case numbers.</td>
</tr>
<tr>
<td>CC - Country Code</td>
<td>When selected, this uses the A2 code for the country of incidence for the case number.</td>
</tr>
<tr>
<td>DD - Day</td>
<td>When selected, this uses the date of the Initial receipt date' field of the case.</td>
</tr>
<tr>
<td>MM - month</td>
<td>When selected, this uses the month of the Initial receipt date' field of the case.</td>
</tr>
<tr>
<td>P - When selected</td>
<td>this uses either of the two values: If report type is Spontaneous' or other' during booking: the system uses the value of the Product Abbreviation' field specified in the Product configuration for the selected Primary suspect product.</td>
</tr>
<tr>
<td>If report type is of the type report from study' during booking: the system uses the Product Abbreviation' field specified in the study configuration.</td>
<td></td>
</tr>
<tr>
<td>SSS - User Site</td>
<td>When selected this uses the Site abbreviation of the site belonging to the user who booked in the case.</td>
</tr>
<tr>
<td>TTT - Report Type</td>
<td>When selected this uses the report type abbreviation of the report type selected during bookin of the case.</td>
</tr>
<tr>
<td>YY - Year</td>
<td>When selected, this uses the year of the Initial receipt date' field of the case.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure LAM system numbering.
1. Select the **Numbering** feature as required. This can be manual numbering or automatic numbering of cases.

2. Select the **Sequencing Options** as required.
   
   **Tip:** For the complete explanation of the sequencing options refer to the Field Descriptions

3. Select the Numbering Format.
   
   **Tip:** To customize the **Numbering Format**, use the **placeholder** values.
   
   **Example:** To select Country Code, Month and Year (as values to be incorporated from the database) as the Case numbering format, execute the following steps.
   
   - Click on **Country Code**. This appears in the **Numbering Format** field.
   - Click on **Month**. This appears in the **Numbering Format** field next to the Country Code.
   - Click on **Year**. This appears in the **Numbering Format** field next to the Country Code and Month.

   The final data listed in the **Numbering Format** field is the Case Numbering Format.

4. Click **Save** to save the changes made.

**Configuring Field Properties**

This section enables you to change field label names and hide or display fields in the Case Form.

Select **System Configuration -> Field Properties** to view the Case Form Field Configuration screen shown in the following illustration.
Field Descriptions

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>Enables the user to view the field name. This is a read-only field.</td>
</tr>
<tr>
<td>Field Form Label</td>
<td>Enables the user to enter the field label names for those fields that can be edited.</td>
</tr>
<tr>
<td>Help Text</td>
<td>Enables you to enter help text for fields that can be edited.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Enables you to make a field read-only in the Product tab, when the Argus user chooses Drug option on the Product screen.</td>
</tr>
</tbody>
</table>
### Field/Control Name Description

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Enables the user to make a field Read only in the Product tab, when the Argus user chooses <em>Device</em> option on Product screen.</td>
</tr>
<tr>
<td>Vaccine</td>
<td>Enables the user to make a field Read only in the Product tab, when the Argus user chooses <em>Vaccine</em> option on Product screen.</td>
</tr>
<tr>
<td>Hidden</td>
<td>Enables the user to hide or unhide a field by selecting the radio button. Select <strong>Yes</strong> to hide the field on case form; select <strong>No</strong> to unhide the field on case form.</td>
</tr>
<tr>
<td>E2B Field</td>
<td>When checked, displays which fields are required for E2B.</td>
</tr>
<tr>
<td>Max Length</td>
<td>Displays the maximum data length allowed for the fields. This information is displayed for all fields except for Date and Codelist fields.</td>
</tr>
<tr>
<td>Null Flavors</td>
<td>This drop-down list displays the Null Flavor sets that are configured in Null Flavor codelist. Null Flavors are displayed in the Case Form field as per Null Flavor set associated.</td>
</tr>
<tr>
<td><em>Safe Length</em></td>
<td>Allows the user configure the safe length for all fields except for Date and Codelist fields. Safe length is populated by default for E2B R2 fields which have been extended as per the E2B R3 Regulation. This field is not used in the application for this release.</td>
</tr>
</tbody>
</table>

Use the following to modify case form field names.

1. Select the folder (or section) in the left pane, for which the field names are to be modified.

2. The places the list of field labels associated in the right panel.

3. Click on the **Field Name** to be modified.

4. The system highlights the selected row is highlighted and puts the details about this field in the **Modify** section at the bottom of the screen.

5. Enter the new field name in **Field Form Label**.

   **Tip:** This label will appear in the Case Form section.

6. Select the **Hidden** preference. Select **Yes** if you want to hide the field on the Case Form.

7. Click this checkbox to indicate which fields are required for E2B.

8. Select any or all of the following options **Drug**, **Device** or **Vaccine** as **Read Only** based on your requirement.

9. Click **Save** to save the changes made.

**Note:** Label Changes will not be reflected in Argus Case Form unless IIS is reset.
Adding User Defined Fields

User defined fields of type Text, Date, and Number may be added to a Case Form. Follow the steps listed below to add a user defined field to a Case Form and/or confirm that the Case Form supports user-defined fields:

1. In Argus Console, navigate to System Configuration > Field Labels.
2. In the left-hand section, select a Case Form by clicking on its name.
3. In the right-hand section with a title bar matching the selected Case Form, scroll down till the words "User Defined.." are visible in the Field Name column.
4. Click on the desired Field Name.
5. In the lower, right-hand section, make the appropriate corrections and save any changes.

Note: Oracle Argus Safety controls the total number of User Defined Fields on any given Case Form by only allowing a single occurrence of each sequence number. Therefore, if "User Defined Number 1" is used, "User Defined Text 1" and "User Defined Date 1" cannot be activated. If a Date and/or Text field is desired the user must select from the fields that have a higher sequence number such as User Defined Date 2, User Defined Date 3, etc., thus always ensuring that the sequence number is unique.

Configuring User Defined Fields

The Argus Safety administrator can customize a user-defined field as a drop-down list. These drop-down lists may contain customized lookup data which can be independent of Argus data.

Use the following procedure to create a user-defined field.

1. Identify the User Defined field in the CMN_FIELDS table.
2. Create a custom table containing lookup information.
3. Create a custom index and specify the required values for the table.
4. Update the record in the CMN_FIELDS table for the User Defined Field.
5. Create a Role and Synonym for the table.
6. Restart IIS.
7. Verify the update made in the application.

Consider the following example that show a sample set of scripts required to configure User Defined Fields as a drop-down list. Assume the requirement is for a User Defined Field (UDF) with the following features:

| Requirement: A User Defined field SOURCE_OF_INFORMATION to be created, with its drop-down values as Fax, E2B, Letter, Email and Telephone under Case Form -> General Tab -> General Information. |

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>SOURCE_OF_INFORMATION</td>
</tr>
<tr>
<td>Field Type</td>
<td>Numeric (Text field type would not work)</td>
</tr>
<tr>
<td>Drop-down Values</td>
<td>Fax, E2B, Letter, Email and Telephone</td>
</tr>
</tbody>
</table>
Use the following procedure to create a user-defined field:

1. Login to Argus -> Argus Console -> System Configuration -> Field Labels.
2. Select User Defined Number <N> at desired page from tree shown in the left pane.
3. Choose No at Hidden.
4. Check Selectable.
5. Click Add and specify items stored in the drop-down in both English and Japanese if the field is multi-language, otherwise specify only in the English text box.

Go to General tab -> General Information and check that the configured user-defined fields display the updated drop-down text.
This chapter allows administrators to configure and maintain code lists in Argus Safety through Argus and the Flexible Data Re-categorization feature. These are detailed in the following sections:

- Configuring Code Lists > Argus
- Configuring Code Lists > Flexible Data Re-Categorization

## Configuring Code Lists > Argus

Code List items appear at several locations in the Case Form. It is essential to configure relevant Code List items in order to ensure that case entry in Argus Safety is done according to your company’s policies. Before configuring Code List items, the Administrator should consult the company’s policies and the terminology used by the company.

To ensure that the Administrator does not have to enter excessive amounts of data during Code List configuration, Argus Safety is shipped with factory data for many of the Code List items.

**Tip:** The following Code List Items have been described to familiarize you with the Code List configuration.

- For the complete set of Code Lists refer to the Argus Console->Code List section.
- The default help text associated with each code list item is displayed at the bottom of the left panel.

<table>
<thead>
<tr>
<th>Code List Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autosignals</td>
<td>This screen helps in capturing Auto Signal information. Users can define the criteria that triggers Autosignal within Argus</td>
</tr>
<tr>
<td>Batch Reports</td>
<td>This screen helps in capturing Batch Reports information.</td>
</tr>
<tr>
<td>Letters</td>
<td>The screen helps in configuring the system to create and schedule letters automatically, according to pre-defined business rules.</td>
</tr>
<tr>
<td>Justification</td>
<td>This screen helps in capturing justification information.</td>
</tr>
<tr>
<td>Electronic Transmission</td>
<td>This screen helps in capturing electronic transmission recipient information.</td>
</tr>
<tr>
<td>Recipient</td>
<td></td>
</tr>
<tr>
<td>Literary Citation</td>
<td>This screen helps in capturing information about Literary Citations.</td>
</tr>
</tbody>
</table>
Configuring Code Lists > Argus

Report the Source

This screen helps in capturing Reporting Destination information.

Routes of Administration

This screen helps in capturing Routes of Administration information.

Study Center

This screen helps in capturing Study Center information.

Configuring Autosignals

This screen enables you to capture the Auto Signal information. Using this screen, you can define the criteria that triggers Autosignal within Argus.

Example: If an event is reported within x number of days, an email is sent to the defined individual or workgroup. The system checks for patterns each time new data is entered, and sends e-mails to the appropriate individuals or departments on finding a matching pattern.

Select Code Lists -> Argus to view the Code List Maintenance screen.

Tip: The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

Field Descriptions

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enables the user to enter the name of the Autosignal. This is a required field.</td>
</tr>
<tr>
<td>Number of Occurrences</td>
<td>Enables the user to enter the number of occurrences of the autosignal.</td>
</tr>
<tr>
<td>Occurrences of</td>
<td>Enables the user to enter the number of days for the autosignal.</td>
</tr>
<tr>
<td>Number of days</td>
<td>Displays the number of days for the autosignal.</td>
</tr>
<tr>
<td>As cases are entered</td>
<td>Enables the user to perform autosignal as cases are entered.</td>
</tr>
<tr>
<td>Every N Days</td>
<td>Enables the user to enter the number of days, when autosignal should be executed.</td>
</tr>
<tr>
<td>Email</td>
<td>Enables the user to enter the email address of Argus users to whom the email about autosignal occurrence should be sent.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure Autosignals.

1. Click on the Autosignals folder in the left panel. The associated autosignal data appears in the Total Number of Rows section in the right panel.
2. Click on the **Name** (or row), to view the details associated with the selected autosignal. The details appear in the **Modify Autosignal** section.

You can use the **Autosignals Filter** to make your search specific to an autosignal. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.

4. Once you have selected the **Field**, you can specify whether your search should contain or start with specific alphabets.

5. Enter the search criteria in **Value**.

6. Click **Filter** to apply the selected criteria.

   This displays the search results under **Total Number of Rows**.

   **Tip:** You can alternatively click **Add New** to create a new autosignal.

   Click **Copy** to make an editable copy of an existing autosignal.

   Click **Delete** to delete a selected autosignal.

7. Enter the name of the autosignal in the **Name** field.

8. Enter the number of occurrences of the autosignal in the **Number of Occurrences** field.

9. Select or create an Advanced Condition, if any from the button in the **Occurrences of** field.

   **Tip:** Click here for details on Advanced Conditions

10. Enter the number of days for the autosignal under the **Number of days** field.

11. Select the **As cases are Entered** checkbox to perform autosignal as cases are entered.
12. Enter the number of days when the autosignal should perform under the **Every N Days** field.

13. Enter the e-mail address that receives email about autosignal occurrence in the **Email** field.

14. Click **Save** to save the changes made to this screen.

### Configuring Batch Reports

This screen enables you to configure Batch Reports information.

- Scheduled reports can be automatically generated and stored in the database by Argus Safety Service. This screen displays a list of all the existing Batch Reports.
- By default the Batch reports shown are memorized reports. The Argus user can see the list of scheduled reports for memorized reports, using the Memorized Reports option.
- Select Code Lists -> Argus to view the Code List page.
- Click on the **Batch Reports** folder in the left panel.

The associated report data appears in the **Total Number of Rows** section in the right panel.

**Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

### Field Descriptions

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>This is the unique name for the batch report name.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure Batch Reports

1. **Click on the Report Title** (or row), to view the details associated with that report. The details appear in the Modify Batch Report section.
   - You can use the Batch Reports Filter to make your search specific to a batch report. The filtering criterion is essential as it helps you to search for specific items.
2. **Select the appropriate Field** as the filtering criteria from the drop-down list.
3. **Once you have selected the Field**, you can specify whether your search should contain or start with specific alphabets.
4. **Enter the search criteria in Value**
5. **Click Filter** to apply the selected criteria.
6. **This displays the search results under Total Number of Rows.**

   **Tip:**
   - You can alternatively click Add New to create a new report.
   - Use Copy to make an editable copy of an existing report.
   - Use Delete to delete an existing report.
7. **Enter the Title Name** for the batch report.
8. **Select the Report Type** from the drop-down list.
9. **Select the Group** to which the report must be assigned.
10. **Select the report to be scheduled as Memorized Reports or Reports Regeneration.**
11. **Select the Frequency of generating the report after the specified number of days have elapsed.**
12. **Select the Product for which the report is to generated, from the drop-down list box.**
13. **Select the Report from the drop-down list.**

### Field/Control Name | Description
--- | ---
Report | Enables the user to select a report that has to be scheduled.
Report Regeneration | Memorized report
Product | Enables the user to select a product for which the report is generated.
Frequency: Every Days | Enables the user to enter the number of days after which the report is to be generated. The value has to be -> 0.
Next Run Date | Enables the user to enter the next date from which the report has to be scheduled.
Advanced Condition | Enables the user to select the Advance Condition that satisfies the criteria which will trigger the Signal. You can either select an existing criteria or create a new one.
Report Type | Enables the user to select the type of the report.
Group | Enables the user to select the group to which the report must be assigned.
14. Enter the **Next Run Date**. This is the next date from which the report has to be scheduled.

15. Select the **Advanced Condition** associated with the report configuration.

16. Click Select icon to launch the Advanced Conditions browser.

17. Click **Save** to save the changes made to this section.

**Configuring Letters**

Argus Safety enables the customizing of letter templates in order to correspond with reporters or health officials and keep them updated with case activity. Access to the **Letter Configuration** dialog can be granted to any user or user-group, as found appropriate by the Administrator.

- To automatically generate a letter, the system reads a template that specifies the information that must appear in the letter.
- The template is a file in Rich Text Format (".rtf" format) that contains the letter text and some field identifiers (also called placeholders). The system substitutes information specific to the current case for the placeholders in the template. Thus, a letter containing case-specific information is automatically generated.
- The administrator can set up the system to create and schedule letters automatically, according to pre-defined business rules. This section discusses the creation, modification, and deletion of letter templates.

Select **Code Lists-> Argus** to view the Code List page.

**Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured.

The details of this code list item appear in the right panel.
Configuring letter (RTF) templates

RTF Document can be created using the required placeholders such as:

\[\text{patient_last_name}, \text{product_name}[:n], \text{rec_vacc_date}[:n]:[m], \text{event_prior_hist:primary_event}, \text{reg_report_timeframe}\]

Most of the placeholders have one parameter or two and these are almost always linked to sort order.

Here are some examples of how these placeholders extract data:

For single value columns:

\[\text{age}, \text{case_id}, \text{comments}, \text{case_status}, \text{country_of_inc}\]

For multiple value columns:

\[\text{event_death:primary_event} \] picks data from case_primary_event table
\[\text{event_death}[:n] \] picks data from case_event/lam_event table based on Sort order
\[\text{case_notes}[:n], \text{concentration}[:n], \text{drug_code}[:n]\]

For multiple parameter columns:

\[\text{ingredient}[:n][:m] \] - It lists nth case product and lists its mth ingredient

Field Descriptions

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enables the user to specify the name of the letter as it will appear in the Letters menu.</td>
</tr>
<tr>
<td>Name (J)</td>
<td>Enables the user to specify the Japanese name of the letter as it will appear in the Letters menu.</td>
</tr>
<tr>
<td>Edit Template</td>
<td>Enables the user to open the letter in MS-Word (template) for editing.</td>
</tr>
<tr>
<td>Regulatory Cover Letter</td>
<td>Enables the user to indicate whether this letter template should appear in the Regulatory Rules dialog Cover letter drop-down list box. The available options are: No, Yes – RTF Format, and Yes – PDF Format.</td>
</tr>
<tr>
<td>Schedule - Letter</td>
<td>Enables the user to enter the number of days (from the receipt date) when the letter will be due.</td>
</tr>
<tr>
<td>Schedule - Action</td>
<td>The Action field enables the Administrator to specify the number of days (from the current date) after which the Action Item for following up on this letter will be due.</td>
</tr>
<tr>
<td>Sites</td>
<td>Argus Console provides the ability to configure letters to user sites. Enables users to select single or multiple sites for that letter. The system will only allow users to see letters that are configured to their site.</td>
</tr>
<tr>
<td>Action Items</td>
<td>The action items list is a drop-down list of action item codes from the Action Type List Maintenance.</td>
</tr>
<tr>
<td>Return Email Address</td>
<td>Enables the user to enter a default email address where the mails will be sent. This address is displayed by default in the Activities tab of the Case Form.</td>
</tr>
</tbody>
</table>
Use the following procedure to configure letters.

1. Click on the Letter Configuration folder in the left panel. The associated data appears in the Total Number of Rows section in the right panel.

2. Click on the Name (or row), to view the details associated with that letter. The details appear in the Modify Letter Configuration section.

3. You may use the Letter Configuration Filter to make your search specific to a letter. The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria.

8. This displays the search results under Total Number of Rows.

   **Tip:** You can alternatively click Add New to create a new letter.

   - Use Copy to make an editable copy of an existing letter.
   - Use Delete to delete an existing letter.

9. Click Select to specify the path of the letter template to be used.

   **Tip:** Click Edit Template to save the existent template on to your local drive of the system.

   You can edit this template and repeat the step listed above, to ensure that the updated template is used for letters.

10. Enter the name of the letter, as it will appear, in the Letters Menu section in Enter a new item.

11. Click Add or Delete to configure letter to the user Sites.

12. Select the Action Item from the drop-down list box. The action items list is a drop-down list of action item codes, from the Action Type List Maintenance.

13. Configure the Advanced Condition for the case.

14. Enter the Schedule (days)-Letter. This is the number of days from the receipt date when the letter is due.

15. Enter the Schedule (days)-Action. This is the number of days from the current date, after which the Action Item for the follow up on this letter will be due.

16. Enable the Regulatory Cover Letter option to indicate whether this letter template should appear in the Regulatory Rules dialog.

17. Enter the default e-mail address in Return Email Address.

18. Click Save to save the changes made for this section.
Configuring Justifications

This screen enables you to capture justification information.

Argus Safety users can enter the reasons for overriding system determinations using the Justifications dialog. The Justification items appear on the Action Justification dialog on the screen.

Select Code Lists-> Argus to view the Code List page.

Tip: The code list items are displayed in the left-panel. Click on the required Code List folder to be configured.

The details of this code list item appear in the right panel.

Field Descriptions

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Enables the user to configure the type.</td>
</tr>
<tr>
<td>Justification</td>
<td>Enables the user to enter the justification.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure justification.

1. Click on the Justifications folder in the left panel. The associated report data appears in the Total Number of Rows section in the right panel.
2. Click on the Type (or row), to view the details associated with that justification. The details appear in the Modify Justification section.
3. You may use the Justifications Filter to make your search specific to a justification. The filtering criterion is essential as it helps you to search for specific items.
4. Select the appropriate Field as the filtering criteria from the drop-down list.
5. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.
6. Enter the justification reason in Justification.
7. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.
   Tip: You can alternatively click Add New to create a new justification.
   ■ Use Copy to make an editable copy of an existing justification.
   ■ Use Delete to delete an existing justification.
8. Select the Type from the drop-down list.
9. Enter the Value for the justification.
10. Click Save to save the changes made for this section.

**Configuring Electronic Transmission**

This screen enables you to configure electronic transmission recipient information.

- Details of electronic transmission recipient such as name, title, address etc. are submitted here.
- Select Code Lists-> Argus to view the Code List page.

Tip: The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.
Field Descriptions
The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enables the user to enter the name of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Title</td>
<td>Enables the user to enter the title of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Address</td>
<td>Enables the user to enter the address of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>City</td>
<td>Enables the user to enter the city of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enables the user to enter the state/province of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Country</td>
<td>Enables the user to select the country of the user.</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Enables the user to enter the postal code of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enables the user to enter the phone number of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enables the user to enter the fax of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Email</td>
<td>Enables the user to enter the email of Electronic Transmission Recipient.</td>
</tr>
<tr>
<td>Preferred Method</td>
<td>Enables the user to select the preferred method of transmission from the drop-down list. This can be by fax or by email.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure the electronic transmission recipient.

1. Click on the Electronic Transmission Recipient folder in the left panel. The associated data appears in the Total Number of Rows section in the right panel.
2. Click on the Name Title (or row), to view the details associated with that electronic transmission. The details appear in the Modify Electronic Transmission Recipient section.
3. You may use the Electronic Transmission Recipient Filter to make your search specific to an electronic transmission recipient. The filtering criterion is essential as it helps you to search for specific items.
4. Select the appropriate Field as the filtering criteria from the drop-down list.
5. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.
6. Enter the search criteria in Value.
7. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.

Tip: You can alternatively click Add New to create a new electronic transmission recipient.
- Use Copy to make an editable copy of an existing electronic transmission recipient.
- Use Delete to delete an existing electronic transmission recipient.
8. Enter the **Name** of the electronic transmission recipient.
9. Enter the **Title** of the electronic transmission recipient.
10. Enter the **Address** of the electronic transmission recipient.
11. Enter the **City** of the electronic transmission recipient.
12. Enter the **State/Province** of the electronic transmission recipient.
13. Select the **Country** of the electronic transmission recipient, from the drop-down list.
14. Enter the **Postal Code** of the electronic transmission recipient.
15. Enter the **Phone** of the electronic transmission recipient.
16. Enter the **Fax** of the electronic transmission recipient.
17. Enter the **Email** of the electronic transmission recipient.
18. Select the **Preferred Method** of communication (by fax or email) for the electronic transmission recipient.
19. Click **Save** to save the changes made to this section.

---

**Configuring Event Groups**

This screen enables you to configure Event Groups information.

- The list of terms which are used across labeledness determines are defined in a central location for users. These users can update these event groups (list of terms) when the product configuration updates are required or when MedDRA versions are upgraded when MSSO releases the new MedDRA updates.
- The values entered here and marked as **Display** appear in the Console > Business Configuration > Products and Licenses > Product Family > Datasheet > Add Event Groups section.

---

**Terms tab**

The following table describes the fields associated with Event Groups > Terms tab.
Use the following procedure to configure Terms:

1. Click Event Groups on the left pane of the Code List.
   You can use the Event Group Filter on the right pane, to make your search specific to an event group. The filtering criterion is essential as it helps you to search for specific items.

2. Select the appropriate Field as the filtering criteria from the drop-down list.

3. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.

4. Enter the search criteria in Value.

5. Click Filter to apply the selected criteria.

6. This displays the search results under Total Number of Rows.

   **Tip:**

   You can alternatively click Add New to create a new event group.

   ■ Use Copy to make an editable copy of an existing event group.

   ■ Use Delete to delete an existing event group.

7. Enter the name of the event group under Event Group Name.

8. If it is also required for a Japanese user, enter the Japanese name of the event group under Event Group Name (J).


10. Click Export (or Import) to export (or import, respectively) a file in a valid file format from (or into) your local system. Valid file formats require that the file be in .xls, .xlsx, or .csv formats.

    **Important:** The format of the data in the csv, xls or xlsx file must be as follows:
    It must have only a single column of data. An import file can have ~ 16 K Terms.

    **Field Name** | **Description**
    --- | ---
    Event Group Name | Allows the user to enter a new Event Group name.
    Event Group Name (J) | Allows the user to enter a new Event Group name in Japanese. This screen and its print form will be visible to only the Japanese users.
    Display | Allows the user to display the Event Group in Business Configuration > Products and Licenses > Product Family > Datasheet.
    Terms | The Terms tab contains terms selected from the MedDRA browser. These terms are displayed in the following format for English users: MedDRA Term in English
    | These terms are displayed in the following format for Japanese users: MedDRA Term in English (MedDRA Term in Japanese)
    | The count of the total number of MedDRA terms present for the case is displayed on the header of the Terms tab.
    Term Type | Displays the type of the MedDRA term. This field can contain the MedDRA term type values such as PT, HLT, HLGT or SOC.
The first/header row must have text as "PT" or "HLT" or "HLGT" or "SOC" in upper or lower case.

All the rows below the header row must contain corresponding terms (text) such as PT text or HLT text or HLGT text or SOC text.

11. Click Save to save the changes made to this tab.

**Event Groups tab**

Click the Event Groups tab to configure event groups.

The following screen is displayed:

The following table describes the fields associated with Event Groups > Event Groups tab.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Groups</td>
<td>The Event Group, selected from the Select button &gt; Available Event Groups dialog, is displayed as follows:</td>
</tr>
<tr>
<td></td>
<td>Event Group Name in English</td>
</tr>
<tr>
<td></td>
<td>The event group name is displayed in the following format for Japanese users:</td>
</tr>
<tr>
<td></td>
<td>Event Group Name in English (Event Group Name in Japanese)</td>
</tr>
<tr>
<td></td>
<td>The count of the total number of Event Group Names present for the case is displayed on the header of the Event Groups tab.</td>
</tr>
<tr>
<td>Select button</td>
<td>Click this button to select the relevant event groups from the Available Event Groups dialog.</td>
</tr>
<tr>
<td></td>
<td>This dialog displays the event groups in a tree-format, with the child event groups being paired under the parent event groups.</td>
</tr>
</tbody>
</table>

**SMQ tab**

Click the SMQ tab to configure SMQ terms.

The following screen is displayed:
The following table describes the fields associated with Event Groups > SMQ tab.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMQ</td>
<td>The SMQ term is selected from the Add button &gt; MedDRA Browser dialog.</td>
</tr>
</tbody>
</table>

On clicking the Add button, the MedDRA Browser is displayed, as shown below:

**Export:**
The Export button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses > Product Family > Datasheet

or, from:
ii) Argus Console > Code Lists > Argus > Event Group

MedDRA terms are selected at any level of the MedDRA hierarchy.

On clicking this button, a dialog is displayed, that allows you to select the file type - .csv / .xls / .xlsx file.

On specifying the file type, the selected PT terms are then exported in the Export file.
in the <PT terms> format.

**Import:**
This button is enabled in two scenarios - when MedDRA is opened from:

i) Argus Console > Business Configuration > Products and Licenses > Product Family > Datasheet

or, from:

ii) Argus Console > Code Lists > Argus > Event Group

MedDRA terms are selected at any level of the MedDRA hierarchy.

On clicking this button, a dialog is displayed, that allows you to browse and upload a .csv / .xls / .xlsx file from the desired location on your local machine.

The format of the data in the selected file should be as follows:

It should have only one column of data

The first header/row must display ‘PT’ or ‘HLT’ or ‘HLGT’ or ‘SOC’.

All the rows under the header row should contain corresponding terms such as PT text, or HLT text, or HLGT text, or SOC text.

The MedDRA terms in the file should be matched against the MedDRA terms table at the level specified in the header row. Duplicate terms within the import file should be ignored.

If the user enters a search criteria at any levels of the MedDRA hierarchy and continues to search for terms, the results obtained from the Import will be lost. The user may need to import terms again, using the **Import** button.

**Save:**

The Save button is enabled only on selection of the PT term(s).

---

**Configuring Literary Citations**

This screen enables you to configure information about Literary Citations.

- The information configured in this form is displayed in the Literature Info section of the Case Form.
- Select Code Lists -> Argus to view the Code List Maintenance screen.
Field Descriptions
The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal</td>
<td>Configures the name of the journal where the citation appears. This is a</td>
</tr>
<tr>
<td></td>
<td>required field.</td>
</tr>
<tr>
<td>Author</td>
<td>Configures the name of the author.</td>
</tr>
<tr>
<td>Title</td>
<td>Configures the title of the citation.</td>
</tr>
<tr>
<td>Volume</td>
<td>Configures the volume number of the journal where the citation appears.</td>
</tr>
<tr>
<td>Year</td>
<td>Configures the publication year of the journal where the citation appears.</td>
</tr>
<tr>
<td>Digital Object Identifier</td>
<td>Configures the digital object identifier.</td>
</tr>
<tr>
<td>Pages</td>
<td>Configures the number of pages in the journal where the citation appears.</td>
</tr>
<tr>
<td>Country of Publication</td>
<td>Captures the country of publication of the literature.</td>
</tr>
<tr>
<td>Study/Trial Classification</td>
<td>Captures the Study / Trial classification for the literature.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure literary citations.

1. Click on the **Literary Citations** folder in the left panel. The associated data appears in the **Total Number of Rows** section in the right panel.

2. Click **Journal/Author** (or row) to view the details associated with the literary citation. The details appear in the **Modify Literature** section.

3. You may use the **Literary Citation Filter** to make your search specific to a citation. The filtering criterion is essential as it helps you to search for specific items.
4. Select the appropriate Field as the filtering criteria from the drop-down list.

5. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.

6. Enter the search criteria in Value.

7. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.

   **Tip:** You can alternatively click Add New to create a new citation.

   - Click Copy to make an editable copy of an existing citation.
   - Click Delete to delete a selected citation.
   - Click Print to print the selected information as a PDF.

8. Enter the name of the journal in the Journal field.

9. Enter the name of the author of the citation in the Author field.

10. Enter the title of the citation in the Title field.

11. Enter the Volume Number in the Volume field.

12. Enter the year in the Year field.

13. Enter the digital object identifier in the Digital Object Identifier field.

14. Enter the number of pages in the Pages field.

15. Click Save to save the changes made.

### Configuring Message Type

This screen enables you to configure information about message type.

- The message type specified in this section enables you to specify auto-submission of reports.
- Select Code Lists -> Argus to view the Code List Maintenance screen.
**Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

**Field Descriptions**
The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>Displays the message type for a report.</td>
</tr>
</tbody>
</table>
| Expedited/Periodic | Displays if the message type is expedited or periodic.  
  **Note:** By default, ICHICSR is considered as Expedited, while the other message types are considered as Periodic. |
| Description        | Displays a description about the message type. |
| Auto Submit        | Displays if the report has been auto submitted. |
| Display            | Displays if the report needs to be displayed or hidden. |

Use the following procedure to configure message type.

1. Click on the **Message Type** folder in the left panel. The associated data appears in the **Total Number of Rows** section in the right panel.

2. Click **Message Type** (or row) to view the details associated with the message type. The details appear in the **Modify Message Type** section.

3. You may use the **Message Type Filter** to make your search specific to a message type. The filtering criterion is essential as it helps you to search for specific items.

4. Select the appropriate **Field** as the filtering criteria from the drop-down list.

5. Once you have selected the **Field**, you can specify whether your search should contain or start with specific alphabets.

6. Enter the search criteria in **Value**.

7. Click **Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.

  **Tip:** You can alternatively click **Add New** to create a new message type.

  - Click **Copy** to make an editable copy of an existing message type.
  - Click **Delete** to delete a selected message type.
  - Click **Print** to print the selected information as a PDF.

8. Enter the type of message in the **Message Type** field.

9. Enter the description for the message type in the **Description** field.

10. Select the **English ICSR** or **Japan ICSR** radio button, as applicable.

11. Click the ** Expedited** checkbox if the message type is for an expedited report.

12. Click the **Mark as Auto Submit** checkbox if you wish to mark for auto submission.

13. Click the **Display** checkbox if you wish to display the message type.

14. Click **Save** to save the changes made.
Configuring Reporting Destination

Regulatory reports are submitted to the Reporting Destination. Local company contact information is also provided on this screen.

Use the following procedure to configure reporting destination:

2. Click Reporting Destination on the left pane of the Code List screen.

Agency Information

The Agency Information tab is displayed by default, on selecting Reporting Destination.

Field Descriptions

The fields under the Agency Information tab are described in the following table:

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>Enables the user to enter the address of the regulatory contact in line 1.</td>
</tr>
<tr>
<td>Address 2</td>
<td>Enables the user to enter the address of the regulatory contact in line 2.</td>
</tr>
<tr>
<td>Agency Name</td>
<td>Displays the name of the agency. This is a required field.</td>
</tr>
<tr>
<td>Agency Type</td>
<td>Enables the user to select the agency type.</td>
</tr>
<tr>
<td>Allow WHO Drug reporting</td>
<td>Enables the user to schedule a report for WHO Drug Reporting.</td>
</tr>
<tr>
<td>Allowed Attachment File Type</td>
<td>Enables the user to configure the file types that are allowed to be attached to Case Form.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Enables the user to select the format of attachments.</td>
</tr>
</tbody>
</table>

PDF reports generated by Argus Safety Service to be transmitted via email have a file naming convention as follows:

- If only a single report per attachment option is selected at the Reporting Destination, the PDF file name is as follows:

  `<Reg Authority Name>-<Case Number>-<Follow-up Number>-<Seriousness(Y/N)>-<Unlisted(Y/N)>-<Causality(Y/N)>-<Date in Argus Format>-<Time with Seconds>.<Milliseconds>.pdf`


- If multiple reports are selected per attachment in the Reporting Destination, the PDF file name is as follows:

  `<Reg Authority Name>-<Date in Argus Format>-<Time with Seconds>.<Milliseconds>.pdf`

  Example: `FDA-03-AUG-2003-100302.750.pdf`

City

Enables the user to enter the city of the regulatory contact.

Contact Type

- Manufacturer - Enables the user to select manufacturer as the type of contact
- Importer - Enables the user to select importer as the type of contact
- Distributor - Enables the user to select distributor as the type of contact
<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>Enables the user to enter the country of the regulatory contact.</td>
</tr>
<tr>
<td>Country Code</td>
<td>Enables the user to enter the country code of the regulatory contact.</td>
</tr>
<tr>
<td>Department</td>
<td>Enables the user to enter the name of the department.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enables the user to enter the email address of the agency.</td>
</tr>
<tr>
<td>Email Text Body</td>
<td>- Select - Enables the user to select a .txt or .rtf file to be uploaded.</td>
</tr>
<tr>
<td></td>
<td>Note: The file should be in .txt, or .rtf format.</td>
</tr>
<tr>
<td></td>
<td>After the uploaded file is saved, the Edit button displays a clip button,</td>
</tr>
<tr>
<td></td>
<td>denoting an attachment.</td>
</tr>
<tr>
<td></td>
<td>- Edit - Enables the user to open the uploaded file / text in a word</td>
</tr>
<tr>
<td></td>
<td>document from the server and edit the text inside it. If no file</td>
</tr>
<tr>
<td></td>
<td>was uploaded earlier, a blank document is opened.</td>
</tr>
<tr>
<td></td>
<td>Note: You can save the edited document on the local machine and click</td>
</tr>
<tr>
<td></td>
<td>Select to save the file.</td>
</tr>
<tr>
<td>Ext</td>
<td>Enables the user to enter the extension number of the regulatory contact.</td>
</tr>
<tr>
<td>FAX</td>
<td>Enables the user to enter the FAX Number.</td>
</tr>
<tr>
<td>FAX Cover</td>
<td>Enables the user to enter the FAX Cover.</td>
</tr>
<tr>
<td>First Name</td>
<td>Enables the user to enter the first name of the regulatory contact.</td>
</tr>
<tr>
<td>Last</td>
<td>Enables the user to enter the last name of the regulatory contact.</td>
</tr>
<tr>
<td>Middle</td>
<td>Enables the user to enter the middle name of the regulatory contact.</td>
</tr>
<tr>
<td>Offline Recipient</td>
<td>Enables the user to configure the regulatory agency as an offline agency.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enables the user to enter the phone number of the regulatory contact.</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Enables the user to enter the postal code of the regulatory contact.</td>
</tr>
<tr>
<td>Preferred Method</td>
<td>Enables the user to select the preferred method of agency information.</td>
</tr>
<tr>
<td>Registration #</td>
<td>Enables the user to enter the registration number.</td>
</tr>
<tr>
<td>Report for Investigational Licenses</td>
<td>Enables the user to select if the reports are to be investigational always or only for clinical case or no marketed license.</td>
</tr>
<tr>
<td>Report for Marketed Licenses</td>
<td>Enables the user to select whether reports are to be marketed always or only for the Spontaneous cases or no Investigational.</td>
</tr>
<tr>
<td>Report per Email</td>
<td>Enables the user to enter the number of reports to be received in each email.</td>
</tr>
<tr>
<td>State/Province</td>
<td>Enables the user to enter the state/province of the regulatory contact.</td>
</tr>
<tr>
<td>Title</td>
<td>Enables the user to enter the title of the regulatory contact.</td>
</tr>
<tr>
<td>FAX</td>
<td>Enables the user to enter the fax number of the regulatory contact.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure agency information.

1. Select the **Agency Name** (or row) of the reporting destination displayed under **Total Number of Rows** that needs to be modified. The **Modify** section displays the information about the selected code list.
2. You may use the **Reporting Destination Filter** to make your search specific to an agency. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.

4. Once you have selected the **Field**, you can specify whether your search should **contain** or **start with** specific alphabets.

5. Enter the search criteria in **Value**

6. Click **Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.

   **Tip:** You can alternatively click **Add New** to create a new agency information.
   - Click **Copy** to make an editable copy of an existing agency information.
   - Click **Delete** to delete the selected agency information.
   - Click **Print** to print the selected information as a PDF.

7. Enter the name of the agency in the **Agency Name** field.

8. Select the type of agency in the **Agency Type** field.

9. Enter the department in the **Department** field.

10. Enter the email address in the **Email** field. Multiple e-mail addresses must be separated by a comma (,), and not by a semi-colon (;). If you separate the email addresses by a semi-colon, the transmission service will fail.

11. Select the preferred method from the **Preferred Method** drop-down list. The options available are **Fax** or **Email**.

12. Enter the registration number in the **Registration #** field.

13. Enter the Fax Number in the **FAX** field.

14. Enter the Fax Cover in the **FAX Cover** field.

15. Select the preferred contact type by clicking the checkboxes available under **Contact Type**.

   The options available are **Manufacturer**, **Importer** and **Distributor**.

16. Select the **Offline Recipient** checkbox to configure the regulatory agency as an offline agency.

17. Select the **Title** of the regulatory contact. The options available are **Mr.**, **Miss** and **Mrs**.

18. Enter the first name of the regulatory contact under the **First Name** field.

19. Enter the middle name of the regulatory contact under the **Middle** field.

20. Enter the last name of the regulatory contact under the **Last** field.

21. Enter the postal contact address of the regulatory contact under the **Address 1** field.

22. Enter the phone number of the regulatory contact under the **Phone** field.

23. Enter the extension number of the regulatory contact under the **Ext** field.
24. Enter the country code to be dialed in calling up the regulatory contact under the **Country Code** field.

25. Enter the fax number of the regulatory contact under the **FAX** field.

26. Enter the fax extension number of the regulatory contact under the **Ext** field.

27. Enter the country code required in faxing up the regulatory contact under the **Country Code** field.

28. Enter the name of the city where the regulatory contact lives in the **City** field.

29. Enter the name of the state/province where the regulatory contact lives in the **State/Province** field.

30. Enter the name of the country where the regulatory contact lives in the **Country** field.

31. Enter the postal code of the place where the regulatory contact lives in the **Postal Code** field.

32. Enter the number of reports that need to be sent in every email to the regulatory contact in the **Report per Email** field.

33. Select the format of the attachments being sent with the emails through the **Attachments** drop-down list.

   The formats available to be sent as attachments are PDF or RTF formats.

34. Click **Text** or **RTF** to save and view a letter attachment in text or RTF format.

   This enables the user to select the email body in Text or RTF format.

35. Select how the report is to be marketed from the **Report to be marketed** drop-down list.

36. The options in this list are **Always** or **Spontaneous** or **No Investigational**.

37. Select the **Allow WHO Drug Reporting** checkbox to schedule the report for WHO Drug Reporting.

38. Select the type of reports as Investigational always or Only for clinical case or No marketed license from the **Report for Investigational** drop-down list.

39. Click **Save** to save the changes made.

**Local Company Contact**

This section lists the Field Descriptions and configuration steps for the **Local Company Contact** tab.

**Field Descriptions**

The fields the following table lists and describes the fields on the **Local Company Contact** tab.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>Displays the name of the company. This is a required field</td>
</tr>
<tr>
<td>Sender Type</td>
<td>Enables the user to select the sender type</td>
</tr>
<tr>
<td>Department</td>
<td>Enables the user to enter the name of the department</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enables the user to enter the email address of the agency</td>
</tr>
<tr>
<td>Lab Code</td>
<td>Enables the user to enter the lab code</td>
</tr>
</tbody>
</table>
Use the following procedure to configure the local company contact.

1. Select the **Agency Name** (or row) of the reporting destination displayed under **Total Number of Rows** that needs to be modified. The **Modify** section is populated with information about the selected code list.

2. You can use the **Reporting Destination Filter** to make your search specific to a company. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.

4. Once you have selected the **Field**, you can specify whether your search should contain or start with specific alphabets.

5. Enter the search criteria in **Value**

6. Click **Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.

   **Tip:** You can alternatively click **Add New** to create a new company contact.

   - Click **Copy** to make an editable copy of an existing company contact.
   - Click **Delete** to delete a selected company contact.
   - Click **Print** to print the selected information as a PDF.

7. Enter the name of the company in the **Company Name** field.

8. Select the type of sender in the **Sender Type** drop-down list.
9. Enter the name of the department under the Department field.
10. Enter the email address of the agency under the Email Address field.
11. Enter the lab code of the agency under the Lab Code field.
12. Select the type of event term on preferred reports from the Event Term on Preferred Reports drop-down list. The options available under this list are Preferred and Lower Level.
13. Select the Title of the regulatory contact. The options available are Mr., Miss and Mrs.
14. Enter the first name of the regulatory contact under the First Name field.
15. Enter the middle name of the regulatory contact under the Middle field.
16. Enter the last name of the regulatory contact under the Last field.
17. Enter the postal contact address of the regulatory contact under the Address field.
18. Enter the phone number of the regulatory contact under the Phone field.
19. Enter the extension number of the regulatory contact under the Ext field.
20. Enter the country code to be dialed in calling up the regulatory contact under the Country Code field.
21. Enter the fax number of the regulatory contact under the FAX field.
22. Enter the fax extension number of the regulatory contact under the Ext field.
23. Enter the country code required in faxing up the regulatory contact under the Country Code field.
24. Enter the name of the city where the regulatory contact lives in the City field.
25. Enter the name of the state/province where the regulatory contact lives in the State/Province field.
26. Enter the name of the country where the regulatory contact lives in the Country field.
27. Enter the postal code of the place where the regulatory contact lives in the Postal Code field.
28. Click Save to save the changes made.

Configuring EDI

This section lists the field descriptions and configuration steps for the EDI tab.

Use the following procedure to configure reporting destination:
2. Select Reporting Destination on the left pane of the Code List screen. The screen appears as shown below.
Field Descriptions
The following table lists and describes the fields on the EDI tab.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SGML/XML</td>
<td>Enables the user to select whether to send the report in SGML or XML format. When SGML is disabled and XML is selected, it is populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Agency Identifier</td>
<td>Enables the user to enter the routing ID configured in Cyclone for the sender community.</td>
</tr>
<tr>
<td>Identification Code</td>
<td>Enables the user to enter the agency Duns code, a unique identification code that identifies the trading partner.</td>
</tr>
<tr>
<td></td>
<td>This field is disabled for the E2B (R3), eVAERS, and eMDR profile. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Code Qualifier</td>
<td>Enables the user to enter the code qualifier here. The code qualifier is used to interpret the identification code.</td>
</tr>
<tr>
<td></td>
<td>This field is disabled for the E2B (R3), eVAERS, and eMDR profile. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Message Profile</td>
<td>Enables the user to select a message profile. The available options now include the ICH-ICSR V3.0 MESSAGE TEMPLATE - PMDA template.</td>
</tr>
<tr>
<td>Mark as Auto Submit</td>
<td>Enables the user to mark the report for auto submission.</td>
</tr>
<tr>
<td>Auto Accept ICSR's</td>
<td>Click this checkbox to auto accept ICSR's. This checkbox is visible only when case numbering is set to Automatic.</td>
</tr>
<tr>
<td>Submission date for ICSR's</td>
<td>Enables the user to select the submission date for ICSRs. It is blanked out and disabled if user selects the eVAERS or eMDR profile in the EDI Tab.</td>
</tr>
<tr>
<td>ACK Profile</td>
<td>Enables the user to select the acknowledgement profile. This field is disabled for the eMDR and eVAERS profile. The PMDA E2B R2 Ack profile is also available now.</td>
</tr>
<tr>
<td>Primary Receive Agency</td>
<td>Enables the user to select the primary receiving agency.</td>
</tr>
<tr>
<td>Imported Cases are assigned to</td>
<td>Enables the user to select the country, where the imported cases need to be assigned.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This list comprises the configured Argus sites. The default value is the site of the importing user.</td>
</tr>
<tr>
<td>Initial Workflow State</td>
<td>Enables the user to configure the initial workflow state of the case.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This list comprises Argus workflow states, with the default value being blank. If you select blank as the workflow state, it is treated as a new case being booked-in.</td>
</tr>
</tbody>
</table>
The system enables the user to configure the XML Source Classification and the PDF Source Classifications used for classifications defined while the Source E2B File / PDF for Initial Intake or E2B Differences report is classified.

When a case is accepted as an initial or follow-up case, the system attaches the source XML and the Initial Selection PDF to the case on the Additional Info tab.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML Source Classification</td>
<td>The system enables the user to configure the XML Source Classification and the PDF Source Classifications used for classifications defined while the Source E2B File / PDF for Initial Intake or E2B Differences report is classified. When a case is accepted as an initial or follow-up case, the system attaches the source XML and the Initial Selection PDF to the case on the Additional Info tab.</td>
</tr>
<tr>
<td>Selection Source Classification</td>
<td>Enables the user to select the source classification from the drop-down.</td>
</tr>
<tr>
<td>Transmit E2B Attachments</td>
<td>Click this checkbox to transmit E2B attachments. If this checkbox is checked in the Reporting Destination Code List, case form attachments are sent to the specified reporting destination.</td>
</tr>
<tr>
<td>Attachment Classification</td>
<td>Enables the user to select the attachment classification.</td>
</tr>
<tr>
<td>Identification Code</td>
<td>Enables the user to enter the company Duns code, a unique identification code that identifies the trading partner. This field is disabled for the E2B (R3), eVAERS, and eMDR profile.</td>
</tr>
<tr>
<td>Company Identifier</td>
<td>Enables the user to enter the company identifier</td>
</tr>
<tr>
<td>Code Qualifier</td>
<td>Enables the user to enter the code qualifier here. The code qualifier is used to interpret the identification code. This field is disabled for the E2B (R3), eVAERS, and eMDR profile.</td>
</tr>
<tr>
<td>File Name</td>
<td>Enables the user to enter the file name</td>
</tr>
<tr>
<td>SGML Declaration File</td>
<td>Enables the user to enter the SGML Declaration File. This field is disabled for the E2B (R3), eVAERS, and eMDR profile.</td>
</tr>
<tr>
<td>Maximum # of reports to include in the msg</td>
<td>Enables the user to enter the maximum number of reports that will be transmitted in one message. This field is disabled for the E2B (R3), eVAERS, and eMDR profile and set to 1. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Method</td>
<td>Enables the user to select a method here. This field contains E2B ESTRI Gateway and E2b Media values.</td>
</tr>
<tr>
<td>EDI Header Required</td>
<td>Enables the user to generate the EDI Header. This field is disabled for the E2B (R3), eVAERS, and eMDR profile. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>XML Version</td>
<td>Enables the user to enter the XML Version. This field is disabled for the E2B (R3) and eMDR profile and set to 1.0. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>&quot;URL for Message Schema&quot;</td>
<td>Enables the user to enter the path where the message schema resides on the internet or enter full path if it is located on the disk. This field is disabled for the E2B (R3), eVAERS, and eMDR profile. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Encoding</td>
<td>Enables the user to select the character set encoding used in XML. This field is disabled for the E2B (R3), eVAERS, and eMDR profile and set to UTF-8. Populated with default values and is displayed in the read-only mode for the PMDA E2B R3 profile.</td>
</tr>
<tr>
<td>Allowed Attachment File Size (in MB)</td>
<td>Enables the user to specify allowed attachment file size (in MB).</td>
</tr>
<tr>
<td>Allowed Report Size (in MB)</td>
<td>Enables the user to specify allowed Report size (in MB).</td>
</tr>
</tbody>
</table>
Use the following procedure to configure EDI:

1. Select the Agency Name (or row) of the reporting destination displayed under Total Number of Rows that needs to be modified. The Modify section is populated with information about the selected code list.

2. You may use the Reporting Destination Filter to make your search specific to an EDI. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate Field as the filtering criteria from the drop-down list.

4. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.

5. Enter the search criteria in Value

6. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.

   **Tip:** You can alternatively click Add New to create a new EDI.
   - Click Copy to make an editable copy of an existing EDI.
   - Click Delete to delete a selected EDI.
   - Click Print to print the selected information as a PDF.

7. Select the format in which the report is to be sent by selecting the SGML and XML radio buttons.

8. Click the Mark as Auto Submit checkbox if you wish to mark the report for auto-submission.

9. Select the country where the imported cases need to be assigned.

10. Select the initial workflow state of the case.

11. Enter the routing ID configured in Cyclone for the sender community under the Agency Identifier field.
12. Enter the Agency Duns code under the **Identification Code** field.
13. Enter the Code Qualifier under the **Code Qualifier** field.
14. Select the message profile from the **Message Profile** drop-down list.
15. Select the acknowledgement profile from the **ACK Profile** drop-down list.
16. Enter the Agency Duns Code in the **Identification Code** field.
17. Enter the Company Identifier in the **Company Identifier** field.
18. Enter the Code Qualifier in the **Code Qualifier** field.
19. Enter the name of the file in the **File Name** field.
20. When a case is accepted as an initial or follow-up case, the system attaches the source XML and the Initial Selection PDF to the case on the Additional Info tab.
21. Select the SGML file in the **SGML Declaration File** drop-down list.
22. Enter the maximum number of reports that need to be included in the message under the **Maximum # of reports to include in the msg** field.
23. Select the method from the **Method** drop-down list. This list contains options like **E2B - Gateway**, **Physical Media**, and **XML Transmission**.
24. Click the **EDI Header** checkbox to generate an EDI Header.
25. Enter the version of XML in which it is coded in the **XML Version** field.
26. Enter the path where the message DTD resides on the internet or enter full path if it is located on the disk under the "**URL of Message DTD**" field.
27. Select the character set encoding used in XML in the **Encoding** drop-down list.
28. Enter the path where the ACK DTD resides on the internet or enter the full path if it is located on the disk in the "**URL of ACK DTD**".
29. Click **Auto Accept ICSR's** to auto accept ICSR's.
30. Click **Transmit E2B Attachments** to transmit E2B attachments.
31. Click **Save** to save the changes made.

Use the following procedure to configure reporting destination.


   **Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

2. Select **Reporting Destination**. The screen appears as shown below.
Configuring the Base Directory Path

A new database only (not shown in the UI) global level common profile switch `BASE_DIR_PATH_FOR_GATEWAY_FOLDERS` is available for providing the base path for all incoming, outgoing and E2B attachments folders.

Users can configure the base directory path of a machine or network shared path through this switch. This path is suffixed with values provided in new configurations and all incoming, outgoing and E2B attachment folders are created under base directory only. This profile switch is mandatory for the Oracle cloud customers whereas it is optional for the on-premise customers. With this optional set up, on-premise customers can retain their existing folder structure when upgrading from older version of Argus Safety. Cloud customers would need to reconfigure their gateway folders based on the new architecture. When the `BASE_DIR_PATH_FOR_GATEWAY_FOLDERS` is set, make sure to create the base directory path along with the enterprise name.

For example,

If `BASE_DIR_PATH_FOR_GATEWAY_FOLDERS` is set to `C:\BASE_DIR` for the enterprise `ENT_DEFAULT`, then the folder `C:\BASE_DIR\ENT_DEFAULT` is created. IF the Incoming Folder is set to `AGECNCY\Incoming`, Outgoing Folder to `AGECNCY\Outgoing` and ISCR Outgoing Attachment Folder to `AGECNCY\OutAttachment`, the actual incoming folder path would be `C:\BASE_DIR\ENT_DEFAULT\AGECNCY\Incoming`. The same standard applies for the outgoing and attachment folder too.

If the `BASE_DIR_PATH_FOR_GATEWAY_FOLDERS` is not set, the Incoming, Outgoing and Attachment folders could have the complete directory path.

SMTP

This section lists the Field Descriptions and configuration steps for the SMTP tab.
Field Descriptions

The following tables lists and describes the fields on the SMTP tab.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Enables the user to enter the email address of the sender.</td>
</tr>
<tr>
<td>CC</td>
<td>Enables the user to enter the email addresses to send email as CC.</td>
</tr>
<tr>
<td>BCC</td>
<td>Enables the user to enter the email addresses to send email as BCC.</td>
</tr>
<tr>
<td>Delivery Receipt</td>
<td>Enables the user to check this box to receive a delivery receipt.</td>
</tr>
<tr>
<td>Read Receipt</td>
<td>Enables the user to check this box to receive a read receipt.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure SMTP.

1. Select the **Agency Name** (or row) of the reporting destination displayed under **Total Number of Rows** that needs to be modified. The **Modify** section is populated with information about the selected code list.

2. You may use the **Reporting Destination Filter** to make your search specific to an SMTP. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.

4. Once you have selected the **Field**, you can specify whether your search should **contain** or **start with** specific alphabets.

5. Enter the search criteria in **Value**

6. Click **Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.
7. Enter the email address of the sender under the **From** field.

8. Enter the email addresses to send email as CC under the **To** field. Multiple e-mail addresses must be separated by a comma (,), and not by a semi-colon (;). If you separate the email addresses by a semi-colon, the transmission service will fail.

9. Enter the email addresses to send email as BCC under the **BCC** field. Multiple e-mail addresses must be separated by a comma (,), and not by a semi-colon (;). If you separate the email addresses by a semi-colon, the transmission service will fail.

10. Click the **Delivery Receipt** checkbox to receive a delivery receipt.

11. Click the **Read Receipt** checkbox to receive a read receipt.

12. Click **Save** to save the changes made.

13. Click **Save** to save the changes made.

### Configuring Routes of Administration

This screen enables you to configure the Route of Administration information. This describes the route of drug administered to the patient. This data is reflected in Expedited and Periodic regulatory reports.

- The values entered here and marked under **Display** appear in the in the **Route of Administration** list on the **Products** tab.
- Select Code Lists -> Argus to view the Code List Maintenance screen.

---

**Tip:** You can alternatively click **Add New** to create a new SMTP.

- Click **Copy** to make an editable copy of an existing SMTP.
- Click **Delete** to delete a selected SMTP.
- Click **Print** to print the selected information as a PDF.
Tip: The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

Click on the Routes of Administration folder in the left panel. The associated data appears in the Total Number of Rows section in the right panel.

Field Descriptions
The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration Route</td>
<td>Displays information about the route of administration. It displays information about how the drug was administered. This is a required field.</td>
</tr>
<tr>
<td>Short Name</td>
<td>Displays the short name of the administrator route.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays a description of the administrator route.</td>
</tr>
<tr>
<td>Display</td>
<td>Enables the user to display the record in the Administrator Route in the Products screen.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure routes of administration.

1. Click the Administration Route (or row) to view the details associated with the administration route. The details appear in the Modify Administration Route section.
2. You may use the Routes of Administration Filter to make your search specific to a route. The filtering criterion is essential as it helps you to search for specific items.
3. Select the appropriate Field as the filtering criteria from the drop-down list.
4. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.
5. Enter the search criteria in Value.
6. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.
   Tip: You can alternatively click Add New to create a new route.
   - Click Copy to make an editable copy of an existing route.
   - Click Delete to delete a selected route.
   - Click Print to print the selected information as a PDF.
7. Enter information about the administration route in the Enter Administration Route field.
8. Enter a short name about the administration route in the Short Name field.
10. Select the Display checkbox to display the record in the Add field in the Products screen.
11. Enter the description about the administration route in the **Enter Description** field.

12. Click **Save** to save the changes made.

**Configuring Study Center**

This screen enables you to configure the Study Center information. This screen is used to enter information regarding each Study Center. The Study Centers defined in this dialog appear on a drop-down list in the **Clinical Studies Information** dialog under the **Centers** tab in **List Maintenance**. You can create a Study Center with the same Center ID but with a different name and address. When you select the studies in the Study Look and Center Lookup in the Console, the system concatenates the Center Name (Center ID) in the look-up dialog.

- Investigators for each Center can also be added via this dialog.
- Select Code Lists -> Argus to view the Code List Maintenance screen.
- Click on the **Study Center** folder in the left panel. The associated data appears in the **Total Number of Rows** section in the right panel.

**Field Descriptions**

The following table lists and describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center ID</td>
<td>Enables the user to enter the Center ID.</td>
</tr>
<tr>
<td>Name</td>
<td>Enables the user to enter the name of the center.</td>
</tr>
<tr>
<td>Address</td>
<td>Enables the user to enter the address of the center.</td>
</tr>
</tbody>
</table>

**Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.
Use the following procedure to configure study center.

1. Click the **Center ID** (or row) to view the details associated with the administration route. The details appear in the **Modify Study Center** section.

2. You may use the **Study Center Filter** to make your search specific to a center. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.

4. Once you have selected the **Field**, you can specify whether your search should **contain** or **start with** specific alphabets.

5. Enter the search criteria in **Value**.

6. Click **Filter** to apply the selected criteria. This displays the search results under **Total Number of Rows**.

   **Tip:** You can alternatively click **Add New** to create a new center.
   - Click **Copy** to make an editable copy of an existing center.
   - Click **Delete** to delete a selected center.
   - Click **Print** to print the selected information as a PDF.

7. Enter the ID of the center in the **Center ID** field.

8. Enter the name of the center in the **Name** field.

9. Enter the address of the center in the **Address** field.

10. Select the **Copy from Reporters** checkbox to copy the information from Reporters.

11. Enter the name of the investigator in the **Investigators** field.

   **Tip:** Click **Add** to add a new investigator. Click **Delete** to delete a selected investigator record.

12. Enter the phone number of the investigator in the **Phone** field.

13. Enter the fax number of the investigator in the **Fax** field.

14. Enter comments, if any, under the **Notes** field.

15. Click **Save**.

### Configuring Holiday Calendar

This screen enables you to configure the Holiday Calendar information. The Code List allows the user to define holidays at country level.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy from Reporters</td>
<td>Enables the user to copy the information from Reporters.</td>
</tr>
<tr>
<td>#</td>
<td>Displays the row count of the number of investigators.</td>
</tr>
<tr>
<td>Investigator</td>
<td>Enables the user to enter the name of the investigator.</td>
</tr>
<tr>
<td>Phone</td>
<td>Enables the user to enter the phone number of the investigator.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enables the user to enter the fax number of the investigator.</td>
</tr>
<tr>
<td>Notes</td>
<td>Enables the user to enter comments or remarks.</td>
</tr>
</tbody>
</table>
The Country of Reporting Destination will be matched with the Country in the Holiday Calendar to identify the holidays to be adjusted for the Reporting Destination.

Go to Code Lists > Argus to view the Code Lists page and click the Holiday Calendar folder in the left panel.

The associated report appears in the Total Number of Rows section in the right panel.

**Tip:** The code list items are displayed in the left-panel. Click on the required Code List folder to be configured. The details of this code list item appear in the right panel.

**Field Descriptions**

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holiday Name</td>
<td>This field displays the unique name for the holiday name.</td>
</tr>
<tr>
<td>Date</td>
<td>This field displays the date on which the holiday has been scheduled.</td>
</tr>
<tr>
<td>Description</td>
<td>This field displays a description of the holiday.</td>
</tr>
<tr>
<td>Country</td>
<td>This field displays the name of the country (or countries) with which the holiday is associated.</td>
</tr>
</tbody>
</table>

Use the following procedure to configure study center.

1. Click the **Holiday Name** (or row) to view the details associated with that Holiday Calendar. The details appear in the **Modify Holiday Calendar** section.

2. You may use the **Holiday Calendar Filter** to make your search specific to a Holiday Calendar record. The filtering criterion is essential as it helps you to search for specific items.

3. Select the appropriate **Field** as the filtering criteria from the drop-down list.
4. Once you have selected the Field, you can specify whether your search should contain or start with specific alphabets.
5. Enter the search criteria in Value.
6. Click Filter to apply the selected criteria. This displays the search results under Total Number of Rows.

**Tip:** You can alternatively click Add New to create a new Holiday Calendar record.
- Click Copy to make an editable copy of an existing Holiday Calendar record.
- Click Delete to delete an existing Holiday Calendar record.

7. Enter the Holiday Name for the Holiday Calendar.
8. Enter the Date for the record.
9. Enter the Country (or countries) with which the holiday must be associated.
10. Enter the Description for the Holiday Calendar record.
11. Click Save.

**Other Code List Items**

The following table lists and describes additional code list items that you should be aware of.

<table>
<thead>
<tr>
<th>Code List Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accidental Exposure</td>
<td>Enables you to capture Accidental Exposure information. Accidental Exposure is in the Dosage regimen section of the Products tab as a drop-down list.</td>
</tr>
<tr>
<td>Action Taken</td>
<td>Enables you to capture Action Taken information. Action Taken information is required to capture information about steps taken when an adverse drug event occurs. The values that you enter in this field are read-only, and appear in the Dosage Regimen section on the Action Taken drop-down in Case Form &gt; Products tab.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Enables you to capture Action Type information that describes the action type required for the case. Values entered in this field are read-only, and appear in the Code/Description list of the Activities tab.</td>
</tr>
<tr>
<td>Age Group</td>
<td>Enables you to capture Age Group information. An Age Group is the range of lower and upper age limits. Patients are categorized in different age groups. This data appears in Expedited and Periodic regulatory reports. The values that you enter in this field appear on the Patient Information Screen, and in the Age Group drop-down list.</td>
</tr>
<tr>
<td>Age Unit</td>
<td>Enables you to capture Age Unit information. An Age Unit displays time in periods such as Year, Month, Day, Hours, and so on. This data appears in the Expedited and Periodic regulatory reports. It also appears in the Age Unit drop-down, Gestation Period unit, and Device Age unit fields on the Patient Information screen, as per the settings made to the Age unit, Gestation Period unit, and Device Age unit flags in the Age unit codelist.</td>
</tr>
<tr>
<td>Code List Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Always Serious Term List</td>
<td>Enables you to select the report types you would like the always serious to run against. You can select specific Product Families to have the always serious terms run against.</td>
</tr>
<tr>
<td>Anatomical Location</td>
<td>Enables you to capture information about the location where vaccinations are given. This data appears in the expedited and periodic regulatory reports. The values that you enter in these fields appear on the Anatomical Location drop-down list on the Vaccine screen.</td>
</tr>
<tr>
<td>Attachment Classifications</td>
<td>Enables you to capture the attachment classification that is used to describe attachment types. The values that you enter in these fields appear in the Attachment Classification section on the Additional Information screen. Attachment Classification that are marked as ‘E2B Additional Doc’ can be configured to be sent as attachments while transmitting E2B (R2) and E2B (R3) reports.</td>
</tr>
<tr>
<td>Attachment Keywords</td>
<td>Enables you to capture information about the attachment keywords that are used to define an attachment type. The values appear in the Attachment Keywords section on the Additional Information screen.</td>
</tr>
<tr>
<td>Birth Type</td>
<td>Enables you to capture birth type information when capturing pregnancy information. This data appears in multiple regulatory reports and in the Birth Type drop-down list on the Pregnancy information screen.</td>
</tr>
<tr>
<td>Case Classifications</td>
<td>Enables you to capture Case Classification to help categorize cases. This information does not impact any report or screen, but is used during case searches to narrow the results set.</td>
</tr>
<tr>
<td>Causality Category</td>
<td>Enables you to capture information about the causality type. This data appears in expedited and periodic regulatory reports and on the Event Causality drop-down list in the Event Assessment section on the Event screen.</td>
</tr>
<tr>
<td>Causality Method</td>
<td>Enables you to capture Causality Method information. It appears on the Case Form Event Assessment tab. The E2B report uses this information to determine the drug assessment method.</td>
</tr>
<tr>
<td>Causality Source</td>
<td>Enables you to capture Causality Source information. It appears on the Case Form Event Assessment tab. The E2B report uses this information to determine the drug assessment source.</td>
</tr>
<tr>
<td>Clinical Reference Type</td>
<td>Enables you to capture information about the clinical reference type. The Clinical Reference Type appears as a drop-down list in Study Configuration.</td>
</tr>
<tr>
<td>Condition Type</td>
<td>Enables you to capture information about the condition of the patient such as historical condition, current condition, historical drug, illness at the time of vaccination etc. This data appears in expedited and periodic regulatory reports and in the Condition Type drop-down list on the Other Relevant History screen.</td>
</tr>
<tr>
<td>Contact Type</td>
<td>Enables you to capture information about the type of contact (such as Follow-up, Investigator). The values appear in the Contact Type drop-down list in the Contact Log section of the Activity Tab.</td>
</tr>
</tbody>
</table>
Countries Enables you to capture information about the country where the adverse event occurred. If you enter A2, A3, or the numeric country code, the system automatically populates the Country field with the name of the country.

You can also check a checkbox called 'Group 2 Country' (unchecked by default) to enable administrators to add a Group 2 Country. This is required when the Due Date for expedited reports differ from country to country, as per their regulations.

For Group 1 countries, the Due Date is based on the Aware Date received globally for the case. For Group 2 countries, the Due Date is based on the aware date when the affiliate or a company representative of that country received information about the case. Obtain the country name and country codes from the ISO 3166 country code specification.

You may receive the following error messages:
- "A duplicate country name already exists!" -- The country name you entered already exists in the system.
- "A duplicate A2 code already exists!" -- The A2 code you entered already exists in the system.
- "A duplicate A3 code already exists!" -- The A3 code you entered already exists in the system.
- "A duplicate country number exists!" -- The country number you entered already exists in the system.
- "Please enter a valid code (A2)." -- The two-character code is not specified.
- "Please enter a valid code (A3)." -- The three-character code is not specified.

Date Ranges Enables you to capture date range information as follows:
- Description -- Enables you to enter a description of the date range.
- Duration -- Enables you to specify the exact duration as opposed to a range of dates. Must be used in conjunction with Amount and Units. When you select "Duration," the system disables the "Range" radio button.
- Amount -- The numeric value that specifies the length of the time period when combined with a value selected from the Units drop-down list (such as days, weeks, months, years, etc.)
- Units -- The unit of the duration (such as days, months, years)
- Range -- Enables you to select a specific range of dates. Must be used in conjunction with the Start and End fields. When you select "Range," the system disables the "Duration" radio button.
- Start -- The initial date of the date range.
- End -- The last date of the date range.

Delivery Types Enables you to capture information about the type of delivery that occurred during pregnancy. This data appears in expedited and periodic regulatory reports and on the Delivery Types drop-down list on the Pregnancy Information screen.

Device Preliminary Comments Enables you to capture comments about medical devices. Device Preliminary Comments appear on the Product screen when the user selects the Device option.

Device Subcomponents Enables you to capture information about subcomponents that are part of a medical device. This information appears on the Product screen when the user selects the Device option.
Device Type Enables you to capture information about patient device types. This data appears in expedited and periodic regulatory reports.

Dosage Frequency Enables you to capture information about how often medication is given (such as daily, bid, weekly, etc.) This information appears on the frequency drop-down list on the Products screen.

- Frequency -- Enables the user to specify how often the dose is given.
- Number of doses per day -- Enables the user to specify the number of doses administered each day.
- Number of separate dosage -- Enables the user to define the dosage verbatim.
- Number of units in the interval -- Enables the user to define the dosage verbatim.
- Definition of Interval -- The length of time between doses such as year, month, day, week (default), hour, minute.

Dosage Unit Enables you to capture dosage units information. This information is required when capturing the quantity of drug on sale and also appears in expedited and periodic reports.

- Unit Name -- The name of the dosage unit.
- E2B Code -- The E2B code associated with the Dosage Unit.
- Dosage Unit -- When checked, it indicates that the current item is the dosage unit.
- Lab Test Unit -- When checked, it indicates that this is a lab test unit.
- Display -- When checked, it indicates that the Unit Name is displayed in the application.

Ethnicity Enables you to capture Race information of the patients. This information appears in periodic regulatory reports and eVAERS reports.

Evaluation Reason Enables you to capture information about why the product is being evaluated. This information appears in the Evaluation Reason list on the Case Form > Products tab.

Event Frequency Enables you to capture information about the frequency of the event. It includes categories such as intermittent, continuous, and single episode. The values entered in this field appear in the Event Frequency drop-down list on the Event Information screen.

Event Intensity Enables you to capture information about the intensity of the adverse event and includes categories such as mild, moderate, and severe. The values that you enter on this screen appear on the Event Intensity drop-down list on the Event Information screen.

Event Outcome Enables you to capture event outcome information such as Fatal, Abortion due to AE/Infection, and Recovered. This data appears in expedited and periodic regulatory reports and on the Event Outcome drop-down list on the Event Information screen.

Fetal Outcome Enables you to capture information about fetal outcome and includes information such as abnormal development or pre-natal complications. This data appears in expedited and periodic regulatory reports. The values entered here appear on the Fetal Outcomes drop-down list on the Pregnancy Information screen.
<table>
<thead>
<tr>
<th>Code List Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formulation</td>
<td>Enables you to capture information about the formulations (cream, drop, capsule, etc.) available for a product. The values that you enter here, appear on the Formulation drop-down list on the Product screen.</td>
</tr>
<tr>
<td>Gender</td>
<td>Enables you to capture gender information. This information appears in expedited and periodic regulatory reports.</td>
</tr>
<tr>
<td>Ingredients</td>
<td>Enables you to capture information about the ingredients in the product. This includes the ingredient, the concentration, and the units of ingredients used to make the product. This information appears in expedited and periodic regulatory reports.</td>
</tr>
<tr>
<td>Intermediary</td>
<td>Enables you to capture information about intermediaries such as sales representative, licensee, regulatory authority or local affiliate. The values that you enter here, appear on the Intermediary drop-down list on the Reporters screen.</td>
</tr>
<tr>
<td>Interval Units</td>
<td>This codelist is used to maintain the interval units that are used as units for Age, Duration, etc.</td>
</tr>
<tr>
<td>Justifications</td>
<td>Enables you to capture justification information. You can enter reasons for overriding system determinations in the Justifications dialog box. The values that you enter here, appear in the Action Justification dialog.</td>
</tr>
<tr>
<td>Lab Assessment Terms</td>
<td>Enables you to capture the lab result assessment terms that define the terms that describe the patient’s results on various lab tests (such as elevated, depressed, etc). This data is reflected in expedited and periodic regulatory reports. The values that you enter here, appear on the Lab Result Assessment Terms drop-down list on the Laboratory Data screen.</td>
</tr>
<tr>
<td>Lab Test Type</td>
<td>Enables you to capture the lab test type. This defines test type and whether it has normal, high, or low values. It can be coded as defined in the MedDRA dictionary. The values that you enter here, appear on the Lab Test drop-down on the Patient screen.</td>
</tr>
<tr>
<td>Lab Test Units</td>
<td>This codelist is used to maintain the units of measures used in Lab test.</td>
</tr>
<tr>
<td>Languages</td>
<td>This codelist is used to maintain the ISO codes of the languages in which text data entry can be made.</td>
</tr>
<tr>
<td>Literary Citations</td>
<td>Enables you to enter information about literary citations.</td>
</tr>
<tr>
<td>Local Evaluation Comment Type</td>
<td>Enables you to capture the category of a local comment such as French, German, English, etc. The values that you enter here, appear in the Analysis, Local Comment type.</td>
</tr>
<tr>
<td>Location</td>
<td>This codelist is used to maintain the Anatomical locations in which Vaccines are administered.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>Enables you to capture information about the product manufacturer. Manufacturer is required while capturing, adding, or modifying information on manufacturer sites. This data appears in expedited and periodic regulatory reports and on the Manufacturer drop-down list on the Product Configuration screen.</td>
</tr>
<tr>
<td>Medical Status</td>
<td>Enables you to capture medical information about patient status. This data appears in both the expedited and periodic regulatory reports. The values that you enter here appear on the Medical Status drop-down list.</td>
</tr>
<tr>
<td>Message Type</td>
<td>Enables you to enter information about each E2B message type. The system uses the defined message types when it creates an E2B file.</td>
</tr>
<tr>
<td>Code List Item</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Nature of Event</td>
<td>Enables you to capture information about the type of adverse event that occurred.</td>
</tr>
<tr>
<td>Occupations</td>
<td>Enables you to capture information about patient and reporter occupations such as physician, regulatory agent, and journalist. This data appears in both expedited and periodic regulatory reports. The values that you enter here, are marked as ICH Occupation, and appear in the Reporter’s Occupation drop-down list on the General Screen.</td>
</tr>
<tr>
<td>Package Units</td>
<td>Enables you to capture information about product packaging. The package units define the number of units in a package.</td>
</tr>
<tr>
<td>Product Group</td>
<td>Enables you to capture information about a specific Product Group. Users can use the Product group field to categorize Product Families based on therapeutic area. The values that you enter here appear in the drop-down list associated with the Project Group field of the Product Family.</td>
</tr>
<tr>
<td>Project ID</td>
<td>Enables you to capture project ID information used to group similar studies under a single project. The values that you enter in this field appear on the Project ID field drop-down on the Study Configuration.</td>
</tr>
<tr>
<td>Purchased With</td>
<td>This code list is used to maintain the Funds from which Vaccine was purchased.</td>
</tr>
<tr>
<td>Reference Types</td>
<td>Enables you to capture reference type information and defines a list a reference types such as Parent-Child Link, Patient ID, etc. The values that you enter here, appear in the Type drop-down in the References section on the Additional Information tab.</td>
</tr>
<tr>
<td>Relation</td>
<td>This codelist is used to maintain the Reporter relation to the Patient.</td>
</tr>
<tr>
<td>Report Media</td>
<td>Enables you to capture Report Media information. The values that you enter appear on a drop-down field in the Reporter Information section.</td>
</tr>
<tr>
<td>Report Types</td>
<td>Enables you to capture information about report types. The report type describes the type of report and the abbreviation associated with the specific type. This data appears in expedited and periodic regulatory reports. The values that you enter here, appear on the Report Type drop-down list on the General Screen. The Considered cases for report type drop-down list determines whether a case is considered marketed or investigational for a given reporting destination. When creating a new case report type, the selected value is Marketed by default.</td>
</tr>
<tr>
<td>Reporter Information</td>
<td>Enables you to capture reporter information such as First Name, Last Name, Occupation, and so on.</td>
</tr>
<tr>
<td>Reporter Type</td>
<td>Enables you to capture information about the person reporting the adverse event and includes categories such as lawyer, nurse, doctor, etc. The values that you enter here, appear on the Reporter Type drop-down list on the Product screen.</td>
</tr>
<tr>
<td>Reporting Destination Type</td>
<td>Enables you to capture information about the reporting destination. The values that you enter here, appear on the Reporting Destination configuration.</td>
</tr>
<tr>
<td>Routes of Administration</td>
<td>Enables you to capture information about how a drug is administered to a patient such as auricular, cutaneous, dental, and so on.</td>
</tr>
</tbody>
</table>
Configuring Code Lists > Argus

The following table provides information about the Formulation Factory Data:

<table>
<thead>
<tr>
<th>Formulation ID</th>
<th>Formulation</th>
<th>Formulation Name</th>
<th>Formulation Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>38</td>
<td>Aerosol (Spray and Inhalation)</td>
<td>Aerosols</td>
<td>AER</td>
</tr>
<tr>
<td>13</td>
<td>Alternative Form</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Cachet (including wafer)</td>
<td>Cachet</td>
<td>CTS</td>
</tr>
<tr>
<td>2</td>
<td>Capsule</td>
<td>Capsules</td>
<td>CAP</td>
</tr>
<tr>
<td>24</td>
<td>Chewable Tablet</td>
<td>Chewing Tablet</td>
<td>CTB</td>
</tr>
<tr>
<td>25</td>
<td>Drop</td>
<td>Drops</td>
<td>DRO</td>
</tr>
<tr>
<td>32</td>
<td>Dusting Powder</td>
<td>Dusting Powders</td>
<td>DPO</td>
</tr>
<tr>
<td>39</td>
<td>Ear Drops</td>
<td>Ear Drops</td>
<td>EDR</td>
</tr>
<tr>
<td>8</td>
<td>Effervescent Tablet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Enema</td>
<td>Enemas</td>
<td>ENM</td>
</tr>
<tr>
<td>21</td>
<td>Enteric Table</td>
<td>Enteric-coated dosage forms</td>
<td>ENT</td>
</tr>
<tr>
<td>49</td>
<td>External Use</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Extra Formulation</td>
<td>External Preparations of Uncertain Dosage Form</td>
<td>EXT</td>
</tr>
<tr>
<td>40</td>
<td>Eye Drops</td>
<td>Eye Drops</td>
<td>EED</td>
</tr>
<tr>
<td>41</td>
<td>Eye Ointment</td>
<td>Eye Ointments</td>
<td>EOI</td>
</tr>
<tr>
<td>20</td>
<td>Grain</td>
<td>Granules</td>
<td>GRA</td>
</tr>
<tr>
<td>18</td>
<td>Granule</td>
<td>Fine Granules</td>
<td>FGR</td>
</tr>
<tr>
<td>46</td>
<td>Implantation</td>
<td>Inserting Preparations</td>
<td>IMP</td>
</tr>
<tr>
<td>43</td>
<td>Inhalation Gas</td>
<td>Gas Inhalant</td>
<td>INS</td>
</tr>
<tr>
<td>6</td>
<td>Infusion</td>
<td>Infusing Preparations</td>
<td>INF</td>
</tr>
<tr>
<td>9</td>
<td>Inhaler</td>
<td>Inhalants</td>
<td>INH</td>
</tr>
<tr>
<td>5</td>
<td>Injection</td>
<td>Injections</td>
<td>INJ</td>
</tr>
<tr>
<td>48</td>
<td>Jelly</td>
<td>Jellies</td>
<td>JEL</td>
</tr>
<tr>
<td>11</td>
<td>Liquid</td>
<td>External Liquids</td>
<td>LIQ</td>
</tr>
<tr>
<td>33</td>
<td>Lotion (except lotion for eye)</td>
<td>Lotions</td>
<td>LOT</td>
</tr>
</tbody>
</table>
The Flexible data re-categorization feature allows Argus Safety and its associated applications such as Argus Mart and Argus Insight to handle the code list values in a much more flexible manner, as compared to the previously existing Argus Safety Code List database design.

Working with Flexible Data Re-Categorization

The Flexible Data Re-Categorization feature allows applications and customers to store and maintain all types of code list values in a single flat database table structure which shall be easier to maintain. This code list data storage design can be leveraged to easily add new and custom code lists or values by applications as well as customers without adding new database tables and columns. This database structure was added in previous release of Argus Safety.

Argus Console provides a user interface that displays values for different code list languages for the flexible data re-categorization code list feature. This user interface helps add and remove custom languages for an existing code list, present in the flexible data re-categorization code list tables and also the flexibility of adding new code list items through this User Interface (UI).

<table>
<thead>
<tr>
<th>Formulation ID</th>
<th>Formulation (troche and candy too)</th>
<th>Formulation Name</th>
<th>Formulation Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>Lozenge</td>
<td>Lozenges</td>
<td>LOZ</td>
</tr>
<tr>
<td>45</td>
<td>Mouthwash</td>
<td>Throat Washings</td>
<td>MWH</td>
</tr>
<tr>
<td>17</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Nasal Drops/Spray</td>
<td>Nose Drops</td>
<td>NDF</td>
</tr>
<tr>
<td>34</td>
<td>Ointment/Cream</td>
<td>Ointments/Creams</td>
<td>OIT</td>
</tr>
<tr>
<td>31</td>
<td>Oral Drug Unspecified Form</td>
<td>Oral Preparations of Uncertain Dosage Form</td>
<td>POR</td>
</tr>
<tr>
<td>4</td>
<td>Patch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Pill (except tablets)</td>
<td>Pills</td>
<td>PIL</td>
</tr>
<tr>
<td>19</td>
<td>Powder (except DPO)</td>
<td>Powders</td>
<td>POW</td>
</tr>
<tr>
<td>35</td>
<td>Shampoo</td>
<td>Shampoos</td>
<td>SHP</td>
</tr>
<tr>
<td>22</td>
<td>Slow Release Capsules</td>
<td>Slow-release Capsules</td>
<td>SRC</td>
</tr>
<tr>
<td>30</td>
<td>Slow Release Granule</td>
<td>Slow-release Granules</td>
<td>SRG</td>
</tr>
<tr>
<td>29</td>
<td>Slow Release Tablet</td>
<td>Slow-release Tablets</td>
<td>SRT</td>
</tr>
<tr>
<td>27</td>
<td>Solution (except Syrup)</td>
<td>Solutions for Oral Use</td>
<td>SOL</td>
</tr>
<tr>
<td>44</td>
<td>Spin Cap</td>
<td>Spin Cap</td>
<td>SPC</td>
</tr>
<tr>
<td>36</td>
<td>Spray (except Inhalation)</td>
<td>Sprays</td>
<td>SPR</td>
</tr>
<tr>
<td>3</td>
<td>Suppository</td>
<td>Rectal Suppositories</td>
<td>SUP</td>
</tr>
<tr>
<td>7</td>
<td>Syrup</td>
<td>Syrups</td>
<td>SYR</td>
</tr>
<tr>
<td>1</td>
<td>Tablet</td>
<td>Tablets</td>
<td>TAB</td>
</tr>
<tr>
<td>37</td>
<td>Tape (including Poultice)</td>
<td>Tapes</td>
<td>TAP</td>
</tr>
<tr>
<td>16</td>
<td>Unknown</td>
<td>Uncertain</td>
<td>XXX</td>
</tr>
</tbody>
</table>

Configuring Code Lists > Flexible Data Re-Categorization

<table>
<thead>
<tr>
<th>Formulation ID</th>
<th>Formulation Name</th>
<th>Formulation Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
<td>Lozenges</td>
<td>LOZ</td>
</tr>
<tr>
<td>45</td>
<td>Throat Washings</td>
<td>MWH</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Nose Drops</td>
<td>NDF</td>
</tr>
<tr>
<td>34</td>
<td>Ointments/Creams</td>
<td>OIT</td>
</tr>
<tr>
<td>31</td>
<td>Oral Preparations of Uncertain Dosage Form</td>
<td>POR</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Pills</td>
<td>PIL</td>
</tr>
<tr>
<td>19</td>
<td>Powders</td>
<td>POW</td>
</tr>
<tr>
<td>35</td>
<td>Shampoos</td>
<td>SHP</td>
</tr>
<tr>
<td>22</td>
<td>Slow-release Capsules</td>
<td>SRC</td>
</tr>
<tr>
<td>30</td>
<td>Slow-release Granules</td>
<td>SRG</td>
</tr>
<tr>
<td>29</td>
<td>Slow-release Tablets</td>
<td>SRT</td>
</tr>
<tr>
<td>27</td>
<td>Solutions for Oral Use</td>
<td>SOL</td>
</tr>
<tr>
<td>44</td>
<td>Spin Cap</td>
<td>SPC</td>
</tr>
<tr>
<td>36</td>
<td>Sprays</td>
<td>SPR</td>
</tr>
<tr>
<td>3</td>
<td>Rectal Suppositories</td>
<td>SUP</td>
</tr>
<tr>
<td>7</td>
<td>Syrups</td>
<td>SYR</td>
</tr>
<tr>
<td>1</td>
<td>Tablets</td>
<td>TAB</td>
</tr>
<tr>
<td>37</td>
<td>Tapes</td>
<td>TAP</td>
</tr>
<tr>
<td>16</td>
<td>Uncertain</td>
<td>XXX</td>
</tr>
</tbody>
</table>
However, this UI does not allow users to perform any modification for the languages which are maintained via the Console Code List feature. Any changes done to the values through this user interface are audit logged.

The Flexible Data Re-Categorization feature allows administrators to manage and display the existing and new code list items.

**Flexible Code Lists**

To access Flexible Data Re-Categorization:

1. Go to Argus Console > Code Lists > Argus > Flexible Data Re-Categorization.

   The following screen is displayed:

   ![Flexible Code List Maintenance Screen](image)

   The following table describes the fields associated with this section:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code List Name</td>
<td>This is the unique name of code list which can be used in the application and reporting for fetching the values of a code list. This is mostly derived from the source Argus Safety code list names. However, it can be different in some scenarios as per the customer need.</td>
</tr>
<tr>
<td>Code List Description</td>
<td>This is the description of code list which can be used to define the purpose of this code list.</td>
</tr>
<tr>
<td>Source</td>
<td>Argus: All the code lists which are part of Argus Safety factory configuration and can be edited using standard Argus console code list UI show the source as 'Argus'. Custom: Any code lists added as part of factory data which cannot be modified from Argus console standard code list UI are considered as custom. Any code list added by customers has source as 'Custom'.</td>
</tr>
</tbody>
</table>

2. This page is used to add the new code list items in Argus Safety and view the existing Argus code lists.

   Click **Add New** to add a new flexible code list item.
To make any changes, users can select a code list, modify values in the given text boxes, and save those changes for modification.

Click Delete to delete an existing flexible list item.

Click Copy to copy an existing flexible list item.

3. Click Save to save the new or existing flexible code list item information.

Flexible Re-Categorization

To access Flexible Re-Categorization:

1. Go to Argus Console > Code Lists > Argus > Flexible Re-Categorization.

The following screen is displayed:

The following table describes the fields associated with this section.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code List Name</td>
<td>This is a drop-down list that displays all the available flexible code lists for selection.</td>
</tr>
</tbody>
</table>
### Field Name Description

| Attribute Name | This is the language Decode context for selected code list which can have language code and other properties of code lists. The following are possible values for this field for the factory data rows which will be populated based on the current code list factory data. Customer can add more language/type values for the new code list items that they create from flexible re-categorization screen, based on their usage:  
  i. en: English display value for a code list item  
  ii. jp: Japanese display value for a code list item  
  iii. E2B: E2B code value for this code list item  
  iv. RPT: Display value for Reports  
  v. ISOA2: A2 country code for the country code list items  
  vi. ISOA3: A3 country code for the country code list items  
  vii. EN_ABBRV: This is used for defining abbreviation values.  
  viii. SM: This decode context is used by Argus Mart while populating data into the SM tables.  
  ix. UCUM_CODE: UCUM code value for this code list item. This is used in E2B (R3) and eVAERS reports.  
  x. E2B_R3: E2B (R3) value for this code list item. This is used in E2B (R3) and eVAERS reports.  
  xi. VAERS_CODE: VAERS Code value for this code list item. This is used in eVAERS and VAERS report mapping.  
  xii. NCI_CODE: NCI code value for this code list item. This is used in eVAERS reports. |
| Code List Display Value | This the re-categorized display value for the code. This display value shall be based on a code list, code, and language combination. |
| Add Attribute | Enables you to add a language attribute. |
| Remove Attribute | Enables you to remove a language attribute. |
| Attribute Name | This is the language Decode context for selected code list which can have language code and other properties of code lists. |
| Code | This is the first column in the grid for all flexible code lists. This column displays the internal id for the existing 'Code' list value. For custom code list, the application always populates the code columns with system generated unique sequence value for the selected code list. It is possible for customers to provide a custom 'Code' value for any of the new rows. This value is always unique for a code list. |
| <All Language Attributes> | All the language attributes are displayed as a new column in the grid with Primary attribute being the first one after the Code column. |
| Right-click > Make Primary | Allows you to make the selected language attribute as the primary attribute. The primary attribute column is moved as the first attribute in the grid after the 'Code' column. This configuration is available every time the user opens the same flexible code list. |
| Right-click > Make Preferred | Allows you to mark the selected cell values corresponding to selected language attribute as Preferred in the database. Preferred values are displayed with an asterisk (*) in the grid for easy identification. At any given time, only one value can be marked as preferred within matching values for a language attribute. |
2. This page is used to view existing code list and to add or remove attributes in those code lists.

   Click **Add New** to add a new entry into the custom code lists.

   Click **Copy** to copy a pre-existing flexible code list entry to a new entry.

3. Click **Edit**. The grid cells of corresponding row become editable for all the attributes added in that code list by the user.

   On clicking **Edit**, a green tick mark is displayed, along with a red colored, cross icon.

   Click the green tick mark to temporarily save the grid values (until saved into database by clicking Save button). The selected row comes out of Edit mode.

   Click the red colored cross icon to discard any changes made to the selected row. The selected row comes out of Edit mode.

   On changing the value of a preferred cell, its preferred status is removed upon saving the grid values.

4. Click **Delete** to allow the users to delete an entry from the flexible code lists. The Delete icon is enabled for only custom code lists, for which protected flag is set to 0 in CODE_LIST_CODE_ATTRIBUTES table. Click this icon to delete all the attribute values corresponding to the selected row from the database.

5. The **Display** checkbox is checked by default (except for hidden entries), for a new row added into the flexible code list.

6. Click **Save** to save all the changes made on flexible code list screen.

The following Code Lists are used/provided for BIP Aggregate Reports:

1. **REPORT_TEMPLATE**: This code list is used for managing various BIP report templates available in the system (OOB + Custom) and assign an Argus periodic configuration (ICH PSUR or CTPR) using which user want to execute this report template. Whenever a new report template is added in BIP, this code list should be modified for providing report template name, its path and corresponding Argus configuration.

2. **ADHOC_LINE_LISTING**: All the LISTNAME added in adhoc_line_listing code list are available in the UD Summaries tab of periodic reports configuration for attaching the memorized reports to a particular line listing section of periodic report. User can renames these using flexible re-categorization user interface. System provides four adhoc line listings by default which can be increased using this code list if you have more adhoc line listing sections in your report. Once configured, use Argus UI for attaching the UD summaries with line listings of your custom report.

3. **SOC_DISPLAY_ORDER**: Use this code list to reorder the printing of SOC in various tabulations.

---

### Field Name | Description
---|---
Export to Excel | Enables you to export all the values of selected code list into an excel file.
Batch Attribute Update | A collapsible interface, this option displays the list of all attributes available for the selected code list in Flexible re-categorization screen. It also provides a text box called Code List Value, where users can enter the required display value of the code list for the selected attribute.
4. **AGGREGATE_REPORT_FORMAT**: Use this code list to define the report formats which you want to use with BIP reports execution. Make sure to use only those formats which are supported by BI Publisher.

5. **DOSAGE_STRING_FORMAT**: This code list can used to restrict/add the dosage string formats which should be available while BIP report execution. More dosage string formats can be added with the help of custom code. The following dosage string formats are provided out of box which print values for dosage string as mentioned in the EN attribute.

<table>
<thead>
<tr>
<th>Code</th>
<th>EN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do</td>
<td>Dose</td>
</tr>
<tr>
<td>DoFo</td>
<td>Dose, Formulation</td>
</tr>
<tr>
<td>DoFoFr</td>
<td>Dose, Formulation, Frequency</td>
</tr>
<tr>
<td>DoFoFrRt</td>
<td>Dose, Formulation, Frequency, Route</td>
</tr>
<tr>
<td>DoFoRt</td>
<td>Dose, Formulation, Route</td>
</tr>
<tr>
<td>DoFr</td>
<td>Dose, Frequency</td>
</tr>
<tr>
<td>DoRt</td>
<td>Dose, Route</td>
</tr>
</tbody>
</table>

6. **UNIQUE_PATIENT_ID_FORMAT**: This code list is used to restrict/add the dosage string formats which should be available while BIP report execution. More dosage string formats can be added with the help of custom code. The following dosage string formats are provided out of box which print values for dosage string as mentioned in the EN attribute.

<table>
<thead>
<tr>
<th>Code</th>
<th>EN</th>
</tr>
</thead>
<tbody>
<tr>
<td>CePt</td>
<td>Center, Patient</td>
</tr>
<tr>
<td>InPt</td>
<td>Investigator, Patient</td>
</tr>
<tr>
<td>Pt</td>
<td>Patient</td>
</tr>
<tr>
<td>StCeInPt</td>
<td>Study, Center, Investigator, Patient</td>
</tr>
<tr>
<td>StCePt</td>
<td>Study, Center, Patient</td>
</tr>
<tr>
<td>StCnCeInPt</td>
<td>Study, Country Name, Center, Investigator, Patient</td>
</tr>
<tr>
<td>StCnCePt</td>
<td>Study, Country Name, Center, Patient</td>
</tr>
<tr>
<td>StCoCeInPt</td>
<td>Study, Country ISO Code, Center, Investigator, Patient</td>
</tr>
<tr>
<td>StCoCePt</td>
<td>Study, Country ISO Code, Center, Patient</td>
</tr>
<tr>
<td>StInPt</td>
<td>Study, Investigator, Patient</td>
</tr>
</tbody>
</table>

7. **LABELING_ALGORITHM**: Use this code list to define new labeling algorithm with the help of custom code. Please see labeling algorithms for more information on out of the box algorithms.

8. **EVENTSERIOUSNESS**: This code list is provided as part of factory data and is used for printing the actual value of seriousness defined against a serious event.

9. **ORGAN_IMPAIRED_HLT**: This code list is added for defining the high level terms which needs to be scanned through to find out if event reported falls under organ impairment section or not. This can be used in custom reports.
10. BIP_DFLT_VALUES: This code list used for configuring the default values for some of the important fields which are used in various grouping and tabulations. For example, how to handle/print an event without and SOC. Value configured in this code list corresponding to SOC will be used in PBRER/DSUR tabulation for events with undefined SOC.

The following Code Lists are used in reports, such as E2B(R3), eVAERS, VAERS, and eMDR reports:

<table>
<thead>
<tr>
<th>Code List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGE_UNIT</td>
<td>This code list enables you to capture Age Unit information. An Age Unit displays time in periods such as Year, Month, Day, Hours, and so on with E2B and UCUM code information.</td>
</tr>
<tr>
<td>CAUSALITY_SOURCE</td>
<td>This code list lets you capture the source from which the causality information was derived.</td>
</tr>
<tr>
<td>CAUSALITY_CATEGORY</td>
<td>This code list lets you capture the category of the causality information with the EU_CODE attribute.</td>
</tr>
<tr>
<td>CAUSALITY_METHOD</td>
<td>This code list lets you capture the method by which the causality information was derived.</td>
</tr>
<tr>
<td>* CODE_SYSTEM</td>
<td>For the current release, this codelist is not used in the application (Case Form, Reports).</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>This code list maintains the list of Countries with the ISO A2, ISO A3, and EEA attributes.</td>
</tr>
<tr>
<td>DEVICE_AGE_UNIT</td>
<td>This code list enables you to capture Device Age Unit information. Device Age Unit displays time in periods such as Year, Month, Day, and Hours with eMDR code information.</td>
</tr>
<tr>
<td>DOSE_UNITS</td>
<td>This code list is used to maintain the units of measures used in Dose with E2B and UCUM code information.</td>
</tr>
<tr>
<td>ETHNIC_GROUP</td>
<td>This code list is used to maintain information about Ethnicity data of Patient or Parent such as Hispanic or Latino, Not Hispanic or Latino with NCI Codes information.</td>
</tr>
<tr>
<td>ETHNICITY</td>
<td>This code list is used to maintain Race information along with NCI Codes information.</td>
</tr>
<tr>
<td>EVALUATION_REASON</td>
<td>This code list is used to maintain the List of reasons for not evaluating devices with NCI Codes information.</td>
</tr>
<tr>
<td>FORMULATION</td>
<td>This code list enables you to capture information about the formulations (cream, drop, capsule, and so on) available for a product with NCI Codes information.</td>
</tr>
<tr>
<td>GENDER</td>
<td>This code list is used to maintain the Gender with E2B and NCI Codes information.</td>
</tr>
<tr>
<td>INTERVAL_UNITS</td>
<td>This code list is used to maintain the interval units that are used as units for Age, Duration, and so on.</td>
</tr>
<tr>
<td>LAB_TEST_UNITS</td>
<td>This code list is used to maintain the units of measures used in Lab test.</td>
</tr>
<tr>
<td>LANGUAGES</td>
<td>This code list is used to maintain the ISO codes of the languages in which text data entry can be made.</td>
</tr>
<tr>
<td>LOCATION</td>
<td>This code list is used to maintain the Anatomical locations in which Vaccines are administered.</td>
</tr>
<tr>
<td>LOCATION_EVENT_OCCURRED</td>
<td>This code list is used to maintain the locations where the events occurred. This data is used in the eMDR and the MedWatch Device report.</td>
</tr>
<tr>
<td>Code List</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MEDIA_TYPE</td>
<td>This code list maintains the file types that can be sent as attachments in E2B(R3) reports with the ICH, FDA, EMA, and PMDA attributes to indicate if attachment types are allowed for these agencies.</td>
</tr>
<tr>
<td>MILITARYSTATUS</td>
<td>This code list is used to maintain the details of the Military status of the Patient such as Active Duty, Reserve, National Guard, TRICARE Beneficiary, and Other with NCI Codes information.</td>
</tr>
<tr>
<td>NULL_FLAVOR</td>
<td>This code list stores the different null flavors such as UNK, NASK, and ASKU. Null flavor sets are attributes in the Null Flavor codelist which are used to create sets with various combinations of Null Flavors. The Null flavor set can be assigned to Case Form fields in Field Properties Configuration and users can select the Null flavors associated with a Null Flavor set as a part of Case Form data.</td>
</tr>
<tr>
<td>PRODUCT_IDENTIFIER_TYPE</td>
<td>This code list identifies the type of Product name being used such as Medicinal Product Identifier (MPID), Pharmaceutical Product Identifier (PhPID).</td>
</tr>
<tr>
<td>PRODUCT_NAME_PARTS</td>
<td>This code list specifies the name of a product as a separated component such as container name, form name, device name, invented name, scientific name, trademark name, intended use name, scientific name and so on.</td>
</tr>
<tr>
<td>PURCHASED_WITH</td>
<td>This code list is used to maintain the Funds from which Vaccine was purchased.</td>
</tr>
<tr>
<td>RELATION</td>
<td>This code list is used to maintain the Reporter relation to Patient.</td>
</tr>
<tr>
<td>REPORTER_INFORMATION</td>
<td>This code list is used to maintain the Reporter information such as First Name, Last Name, and so on.</td>
</tr>
<tr>
<td>REPORTER_OCCUPATION</td>
<td>This code list is used to maintain the Occupation with NCI Codes and Device Operator information.</td>
</tr>
<tr>
<td>ROUTE</td>
<td>This code list enables you to capture information about how a drug is administered to a patient such as auricular, cutaneous, dental and so on with E2B and NCI Codes information.</td>
</tr>
<tr>
<td>SPANISH_STATES</td>
<td>This code list lets you capture the states of Spain with the STATE_CODE attribute.</td>
</tr>
<tr>
<td>SPECIALIZED_PROD_CATEGORY</td>
<td>This code list is used to maintain details of the Product category details as per FDA specifications such as Convenience Kit of Co-Package, Prefilled Drug Delivery Device/System, Drug/Biologic Combination, and so on with NCI Codes information.</td>
</tr>
<tr>
<td>VACCINATED_AT</td>
<td>This code list is used to maintain the Vaccination Facility Type information.</td>
</tr>
</tbody>
</table>
Accessing Tools

This section explains the report (features and purpose) generated when Tools -> ICSR Length Check is accessed.

When Argus Code List item length is greater than the E2B field length, the data is truncated when maximum length is entered and an E2b report is generated.

Report Features

The report prints the code list items that exceed E2B (R2) length specifications and also lists code list data that has codes not matching with codes required for the E2B (R2) report.

This report does not provide the length check and Code check validations pertaining to E2B (R3), eVAERS, and eMDR reports.

The report contains the following as illustrated:
Viewing the ISCR Length Check Report

This section enables you to view the ICSR Length Check Report.

Use the following procedure to view the ICSR length report.

1. Select Tools > ICSR Length Check.

2. The ICSR Length Check PDF report opens in a separate window.

Tip: This report compares the lengths of the code list elements with the maximum ICSR length allowed for each of the DTD profiles (ICH, FDA, EMA).

It also displays the elements where the length of the code-list element is greater than the allowed ICSR length.
Using Advanced Conditions

This section discusses how to create and use Advanced Conditions. If you do not have access to the advanced conditions on certain screens, the system displays only the Advanced Condition Names you can access (instead of displaying a blank) and does not permit you to modify or view the advanced condition details. The system displays a warning message stating that you do not have permissions to update the advanced conditions. The following screens are affected by this change:

- Expedited Reporting Rules
- Auto Signals
- Batch Reports
- Letters
- Studies
- Case Priority
- Field Validation
- Narrative Templates
- Profile Switches | Auto Archiving

This option is available from the Advanced Conditions icon.

Argus Safety provides a powerful search tool that enables complex queries to be built in order to retrieve data from the system. Detailed knowledge of the database schema is not required.

Complex or non-standard queries are constructed by means of the Advanced Conditions dialog, that enable users to define field level search criteria.

Sets of search criteria (advanced conditions) can be saved and retrieved from the Advanced Conditions dialog. These conditions may then be added, edited, or deleted.

Access rights and permissions can be assigned to individual advanced conditions. You can execute and modify rights to one or more groups on a per-advanced condition basis.
Features within Advanced Conditions

By default, the Advanced Conditions drop-down list enables you to view only the New, None and already selected Advanced Conditions.

1. Select New or None from the drop-down list and click the AC button to create a new advanced condition.
2. Click the lookup icon to filter for existing advanced conditions.
3. Execute the steps below to filter for existing Advanced Conditions:
4. Click Lookup in the Case Search Criteria section. The Advanced Conditions Lookup dialog is displayed.

5. Select one of the following options from the drop-down list under Filter.
   - Contains - Enables you to filter for advanced conditions that contain the entered criteria.
   - Starts With - Enables you to filter for all advanced conditions that start with the entered criteria.
6. Enter the search criteria for the advanced conditions in the text box, as applicable.
7. Click Filter.
   
The advanced conditions matching the specified filtering criteria are displayed.
8. Select an advanced condition from the list, as per your search requirements.
9. Execute any of the actions below, as applicable:
   - Click OK. The selected advanced condition is listed in the Advanced Condition drop-down list.
   - Click AC. The details of the selected advanced condition are displayed in the Advanced Conditions dialog.
Using Advanced Conditions

Use the following procedure when using advanced conditions.

1. Click the Select lookup to view/edit/create the Advanced Condition in the Advanced Condition dialog.

2. **IMPORTANT!!:** Only trusted users should be given access to the Advanced Condition, as users with this access will have complete access to the information in the Argus schema.

3. To use advanced conditions, the following options are available, depending on how the set of criteria is to be used:
   - To use a set of previously saved criteria, select the appropriate set of criteria from the Advanced Condition list
   - To add a new condition to a set of criteria, select the set of criteria from the Advanced list and click the adjoining Advanced Condition icon.
   - To enable the creation of new advanced conditions by associating logical operators (like AND, OR) with items from the Case Form, refer to Creating Advanced Conditions.
   - To create an advanced condition query set from existing advanced condition search criteria, refer to Creating a Query Set of Advanced Conditions.

Creating Advanced Conditions

Use the following procedure to create advanced conditions.

1. Select New from the Advanced Conditions drop-down list or click the Advanced Conditions icon

2. This displays a confirmation dialog.

3. Select whether you wish to create a query set by using previous advanced condition query sets or by creating one through logical operators.
   - Click Yes to create a new advanced condition query set.
   - Click No to create a new advanced condition by associating logical operators (like AND, OR) with items from the Case Form.

4. If you select No, an Advanced Condition Set dialog is displayed.
5. Select a property type from the Properties tree list.

The items available under the folders in the Properties list represent those fields on the Case Form that can be used to perform the search in the advanced conditions.

**Note:** The Advanced Condition Set dialog enables you to search for those entities under the Properties tree-list, which are from either the case data or from the code list. For this, the dialog provides two radio buttons - From Code List and From Case Data.

- Select the relevant entity and one of the radio buttons, as applicable.
- This searches the entity based from the code list or case data, as specified.
- The radio buttons are displayed only if the selected entity belongs to a code list.
- If the selected entity is part of the code list, and the user selects:
  - **From Code List** - If this option is selected, the Value drop-down list displays the list of all values configured in the Code List.
  - **From Case Data** - If this option is selected, the Value drop-down list displays the list of only those values, which are actually present in the cases.
6. In the **Conditions** list, select a condition that must apply to the item selected above.

   The available conditions are "equal to", "contains", "less than", "greater than", "not equal to", "missing", "greater than or equal to", "less than or equal to", "exists", "does not contain" or "begins with".

7. Under **Value**, enter the value which will apply to the property, or select an appropriate value from the list, as applicable.

8. If the condition created in steps 4 through 6 above is to be linked with another condition, select the appropriate logical operator in the list adjoining **Value**.

   **Tip:** The logical operators that can be used to link the existing condition to a new condition are **AND/OR**.

9. Click **Add** to add the newly created condition to the advanced condition.

10. Repeat steps 3 through 7 to add more conditions to the advanced condition.

11. When each of the required conditions for the advanced condition is entered, click **Save**.

12. Enter a name for the advanced condition and click **OK**.
Note: To enable other users to use the advanced condition, the Share with other users check box should be selected. More about sharing advanced conditions

- If an Advanced Condition is not shared with other users, it does not appear in the Advanced Condition list for any user except the Administrator and the user that created it.

- If the Advanced Condition is shared, all users can view the advanced condition, but they cannot modify it.
  - Not allowed if the Advanced Condition is in use in the system.
  - The Console manages access to the Advanced Condition Library screen.
  - The Advanced Condition Library option has been added to enable or disable (default) access to the following screen:

Access Management -> Argus -> Groups> Menus> Utilities (subarea) section

IMPORTANT!! Customers should cleanup the aggregate case series data (such as cfg_adv_cond_hitlist and related tables) from the Advanced Condition Library which are no longer used or are not likely to be required in future.

With each periodic execution, the number of aggregate case series can keep growing in the system and it is up to the customers to manage these case series either by deleting them manually or by deploying an Oracle job.

Tip: To enter a customized date range, select Custom Date Range from the list. Enter an appropriate date range in the custom date range dialog and click OK.

Creating a Query Set of Advanced Conditions

The user can configure the Action Items type to be scheduled based on the Advanced Conditions rules as shown in the following.

New Action Type Fields and Field Description

<table>
<thead>
<tr>
<th>Field/Control Name</th>
<th>Description</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Action</td>
<td>Defines the Action Item as a Query Action used to generate the letter and used as a placeholder.</td>
<td>Checkbox</td>
</tr>
<tr>
<td>Advanced Conditions</td>
<td>Enables the user to configure an Advanced Conditions Rule for creating the Query Type Action Item in the case.</td>
<td>User Selectable</td>
</tr>
<tr>
<td>User Group</td>
<td>Enables the user to define a User group (undeleted user groups in Access Management) for the Action Item created in the case.</td>
<td>Type Ahead</td>
</tr>
<tr>
<td>Letter Placeholder Content</td>
<td>Enables the user to enter Letter Text that prints in the letter using the Open Query placeholder.</td>
<td>Text (1000 characters)</td>
</tr>
</tbody>
</table>
Be aware of the following:

- The Advanced Conditions, User Group, Letter Placeholder Content, and Due In fields are enabled only if Query Action is checked.
- The system tracks any changes made to the profile switch in the audit log.
- The *Action Type* report prints any additional fields.
- The system has a profile switch to enable the user to generate open queries when he/she saves the case.
  - **No (Default)** - When the user clicks *No*, the system *does not* generate open queries in the case when the user saves the case.
  - **Yes** - When the user clicks *Yes*, the system generates *all* action items with a query action type based on the advanced conditions defined for the Action Taken due in *xxx* days for User group *yyy*
    
    where:
    - *xxx* is the number of action items defined + the System Date for the defined user group
    - *yyy* is the user group
  - The system tracks changes made to the *Profile Switch* in the audit log.

Use the following procedure to create a query set of advanced conditions.

1. Select **New** from the *Advanced Conditions* drop-down list or click the Advanced Conditions icon
2. A dialog that prompts for the creation of an advanced condition query set opens.
3. Click **Yes** to create a set of advanced conditions by linking together those advanced conditions that have been defined previously.
4. The Advanced Condition Set dialog opens.
   
   In this dialog, previously-created advanced conditions can be linked together using set operators like **UNION**, **MINUS**, and **INTERSECT**.
5. Click Add to add an advanced condition to the query set. A new row opens in the advanced condition selection area. In this row, select an appropriate advanced condition from the Advanced Condition list.

**Tip:** To modify, open, or delete advanced conditions, click Open in the Advanced Conditions dialog. A list of all the advanced conditions will be displayed. In this list, select the appropriate advanced condition and click Open to open or modify it, or Delete to delete it.

To view or modify the SQL statement associated with an advanced condition, click Show SQL. Make the required modifications to the SQL statement, if necessary. The SQL supports the list of parameters as defined in the profile switch Comma separated list of allowable parameters for custom advanced conditions.

6. Select an appropriate set operator from the Set Operator list. This set operator will link this advanced condition to the next advanced condition.

7. To add the next advanced condition to the query set, click Add.

8. Repeat steps 5 through 7 for each advanced condition that must be entered in the query set.

**Tip:** If the required advanced condition is not already present in the list, it can be created by selecting (New) from the list.

- If an existing advanced condition requires modification, select it and click Edit.
- The advanced condition can be edited by a user only if it was created by that user.

9. When each of the advanced conditions for the query set is entered, click Save.

10. Enter a name for the advanced condition and click OK.
**Tip:** To view or modify the SQL statement associated with an advanced condition, click **Show SQL**. Make the required modifications to the SQL statement, if necessary.

### The Hit List Tab

The **Hit List** tab in the Advanced Condition Set dialog can be used to search for cases that match the query set criteria.

1. Click **Find Now** in the **Hit List** tab of the Advance Conditions dialog. This runs a search based on the selected query set criteria and displays a list of cases (if any) that satisfy the advanced condition query set.

2. Perform these operations to do the following:

<table>
<thead>
<tr>
<th>To...</th>
<th>Click...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manually add an existing case to the hit list</td>
<td>Add and enter the <strong>Case ID</strong></td>
</tr>
<tr>
<td>Remove a case from the hit list</td>
<td>Remove</td>
</tr>
<tr>
<td>Save the hit list result for future use</td>
<td>Store Hit List</td>
</tr>
<tr>
<td>Retrieve results of the saved hit list</td>
<td>Retrieve Hit List</td>
</tr>
<tr>
<td>Save the hit list as a text file</td>
<td>Export</td>
</tr>
<tr>
<td>View SQL for Query</td>
<td>Show SQL</td>
</tr>
<tr>
<td>Run a Query</td>
<td>Find Now</td>
</tr>
</tbody>
</table>
The chapter provides best practices for setting up the Argus Safety application to use the ICH E2B(R3), eVAERS, eMDR, and PMDA E2B(R3) reports. It contains the following sections:

- Section, "Configuring Argus Safety for ICSR Reports (HL7)"
- Section, "Attachments in HL7 Reports"
- Section, "Creating and Managing Amendments for eVAERS and E2B (R3) report"
- Section, "Null Flavor Handling in HL7 Reports"
- Section, "Best Practices in a Multi-Tenant Environment"

Configuring Argus Safety for ICSR Reports (HL7)

HL7 reports include the ICH E2B(R3), eVAERS, eMDR, EMA E2B(R3), and PMDA E2B(R3) reports built using HL7 v.3.0. This section contains the following topics:

- Configuring Reporting Destination for HL7 ICSR Reports
- Customizing Profiles
- Configuring ICSR Validation using the New Framework
- Configuring Codelists
- PMDA E2B (R3) Flex Codelist
- Business Configuration Updates
- System Configuration Updates
- Optional Upgrade Scripts for Data Migration to New Fields

Configuring Reporting Destination for HL7 ICSR Reports

The Reporting Destination must be configured with the appropriate profile based on the report type to be sent to the Agency:

1. Configuring Profiles for Message and Acknowledgement

   Message and Acknowledge profile must be selected as follows for different report types:

<table>
<thead>
<tr>
<th>Agency</th>
<th>Message Profile</th>
<th>Acknowledgement Profile</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBER</td>
<td>CBER eVAERS V1.0 MESSAGE</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>TEMPLATE</td>
<td></td>
</tr>
</tbody>
</table>
2. Path for Incoming and Outgoing Messages

The Path for Incoming and Outgoing Messages or Acknowledgements must be specified in:
- Codelist -> Reporting Destination -> EDI tab -> Incoming folder
- Codelist -> Reporting Destination -> EDI tab -> Outgoing folder

3. Attachment and Report File Size Configuration

The attachment file and overall file size of the reports are checked for HL7 reports during report generation or transmission. The file size and attachment size limit can be configured using the parameters in the Reporting Destination Code list.

The recommended size for various report types are:

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Allowed attachment file size (in MB)</th>
<th>Allowed report size (in MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>eVAERS</td>
<td>15 MB</td>
<td>20 MB</td>
</tr>
<tr>
<td>eMDR</td>
<td>15 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ICH E2B R3</td>
<td>15 MB</td>
<td>20 MB</td>
</tr>
<tr>
<td>PMDA R3</td>
<td>N.A.</td>
<td>AS1: 10 MB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AS2: 50 MB</td>
</tr>
<tr>
<td>EMA</td>
<td>15 MB</td>
<td>20 MB</td>
</tr>
</tbody>
</table>

For more information on changes required in the file types, refer to the Console guide for the Common profile switch for the file types allowed for the report forms.

4. ICSR Report Submission Date Configurations

The existing profile switch based system level ICSR submission date options have now been moved to reporting destination level for all ICSR submissions. Hence, set the appropriate value for the respective destinations for both R2 and R3 reports.
Customizing Profiles

Perform the following steps to customize profiles:

1. **Creating a Custom Profile:**
   
   Standard profiles must be copied to modify mappings or add new elements. You can copy a profile using the Copy button in Interchange Mapping.

2. **Adding extension elements:**
   
   If a new element is required in a profile due to a change in regulations, the extension element can be added to the Custom Profile. The extension element is created using the Insert statement in the CFG_E2B table.

3. **Providing custom export logic for the required data element:**
   
   SQL for the required data element can be modified in the custom profile using the Interchange Mapping.

4. **Updating XSL files**
   
   If the xpath of the element must be changed due to a change in regulations, the corresponding XSL must be altered. The location of XSL files is:
   ```
   \{ArgusInstallPath(FromArgus.ini)}\ \Argus.NET\CommonWebUIComponent\HL7\XSLT\AS\XSLFiles
   ```
   
   Refer E2B(R3) Extensibility guide for guidelines on updating XSL files.

5. **Configuring a Reporting Destination with the Custom profile:**
   
   The custom profile created in step1 must be specified to the required Reporting Destination.

Configuring ICSR Validation using the New Framework

A new ICSR validation framework has been implemented for E2B (R3) based ICSR reports. This provides a robust framework to enhance the ICSR generation validation capabilities to reflect the process by which they are executed by the regulatory authorities.

Currently, only PMDA E2B (R3) is using the new framework for validations by default. All required factory data validation have been provided for PMDA E2B R3 template profile only.

If you want to enable the new framework for other R3 based ICSR profiles (ICH and eVAERS), load/add the required validations using the UI and update the back-end...
profile level flag (CFG_PROFILE.APPLY_CONF_RULE=1).

Configuring Codelists

Oracle recommends you configure Codelist data using the Flexible Data Re-categorization codelist to ensure legacy Vaccine data is properly represented in reports.

eMDR Specific Codelist Updates

Occupation

The Occupation codelist is provided with Factory data along with NCI_Codes. If Companies already have entered data in this codelist and if this data has been used in the Device cases prior to upgrading to the 8.x release, Oracle recommends you do the following:

- Update the NCI codes for the existing data in Occupation codelist using Flexible Data Re-categorization codelist.
- Set Display to No, for the new factory data provided in Occupation codelist using Standard Codelist.

eVAERS Specific Codelist Updates

Since the values allowed for few fields in eVAERS are different from VAERS report, Oracle recommends you configure the existing codelist values with appropriate NCI_CODE in the Flexible Data Re-categorization Codelist so that appropriate data is sent in eVAERS reports.

Relation to Patient

Relation codelist is now provided with additional Factory data along with NCI_Codes as per CBER guidelines on eVAERS. If there are legacy cases with data that is similar to the values provided in the table, Oracle recommends you update the NCI codes for these codelist values as per NCI_CODE column.

<table>
<thead>
<tr>
<th>Codelist List Value</th>
<th>NCI_CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine Provider</td>
<td>C102430</td>
</tr>
<tr>
<td>Patient/Parent</td>
<td>C16960 or C42709</td>
</tr>
</tbody>
</table>

Anatomical Location

Anatomical Locations codelist is now provided with Factory data along with NCI_Codes. If Companies already have entered data in this codelist and if this data has been used in the Vaccine cases prior to upgrading to the 8.0 release, Oracle recommends you do the following:

- Update the NCI codes for the existing data in Anatomical Location codelist using Flexible Data Re-categorization codelist.
- Set Display to No, for the new factory data provided in Codelist -> Anatomical Location.

Ethnicity

Ethnicity codelist is now provided with Factory data along with NCI_Codes. If Companies already have entered data in this codelist and if this data has been used in the Vaccine cases prior to upgrading to the 8.0 release, Oracle recommends you do the following:
- Update the NCI codes for the existing data in Ethnicity codelist using Flexible Data Re-categorization codelist.
- Set Display to No, for the new factory data provided in codelist -> Ethnicity.

**Vaccination Facility**

Vaccination Facility codelist provides distinct options for facility types. However prior version of application had factory data as follows in LM_VACCINATED_AT table. If there are legacy cases with any data same as the value provided in the below table, Oracle recommends you update the NCI codes for these codelist values as per NCI_CODE column.

<table>
<thead>
<tr>
<th>Codelist List Value</th>
<th>NCI_CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private Doctor’s Office/Hospital</td>
<td>C16988 or C16696</td>
</tr>
<tr>
<td>Public Health Clinic/Hospital</td>
<td>C51282 or C16696</td>
</tr>
<tr>
<td>Military Clinic/Hospital</td>
<td>C51282 or C114861 or C16696 or any other appropriate NCI_CODE</td>
</tr>
</tbody>
</table>

**PMDA E2B (R3) Flex Codelist**

**License Category**

Data for the License category codelist has been synchronized as per the PMDA E2B (R3) regulation. The E2B (R2) codes have been mapped to the appropriate values with the following exceptions:

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>CATEGORY_J</th>
<th>E2B_R3</th>
</tr>
</thead>
<tbody>
<tr>
<td>During the re-review period (medicines that require pharmacist intervention)</td>
<td>再審審査中に薬剤師に要求</td>
<td>6</td>
</tr>
<tr>
<td>During the PMS period (medicines that require pharmacist intervention)</td>
<td>PMS期間中に薬剤師に要求</td>
<td>7</td>
</tr>
</tbody>
</table>

Update the appropriate E2B (R2) codes for the newly added items to the codelist.

**Study Development Phase (Development Phase)**

Data for Study Development Phase codelist has been synchronized as per the PMDA E2B (R3) regulation. The E2B (R2) codes have been mapped to the appropriate values with the following exceptions:

<table>
<thead>
<tr>
<th>DEV_PHASE</th>
<th>DEV_PHASE_J</th>
<th>E2B_R3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microdose tests, etc.</td>
<td>マイクロドーズ試験等</td>
<td>0</td>
</tr>
<tr>
<td>Phase I/II Trial</td>
<td>第Ⅰ/Ⅱ相</td>
<td>4</td>
</tr>
<tr>
<td>Phase II/III Trial</td>
<td>第Ⅱ/Ⅲ相</td>
<td>5</td>
</tr>
</tbody>
</table>

Update the appropriate E2B (R2) codes for the newly added items to the codelist.
Business Configuration Updates

Setting up the Application Type in Business Configuration -> Products and Licenses (eVAERS specific)

FDA requires the use of a prefix to determine the application type associated with suspect products. For licensed vaccines, you must include the appropriate acronym BLA, STN, or PLA followed by the primary six-digit number. Therefore, Oracle recommends you update the newly added column in Business Configuration-> Products and Licenses-> License-> Application Type with appropriate license types.

Configuring PMDA Specific License Parameters

Configure the following License level parameters that will be used to auto-populate the respective configured values in the Case Form:

Status category of new drug: Use this drop-down list to set the status category of the new drug as per the allowed values from the License category codelist. This configured value is used to auto populate the Case Form -> Analysis -> PMDA -> General-> Category of New Drug. The user can modify the auto populated value in the Case Form.

Risk category of OTC drug: Use this drop-down list to set the Risk category of OTC Drug as per the allowed values from newly added Risk category codelist depending on the value for OTC Product checkbox. This configured value auto populates the Case Form -> Analysis -> PMDA -> General -> Route of acquiring OTC drugs. The user can modify the auto populated value in the Case Form.

Configuring PMDA E2B (R3) Specific Study Parameter

Configure the appropriate Notification number for existing studies in the Study Configuration J pop-up. The value configured here is expected to be transmitted in J2.13.r.1 (Notification Number) tag of PMDA E2B (R3) report.

System Configuration Updates

PMDA E2B (R3) Specific Switches

Some switch based application behaviors may impact the PMDA E2B (R3) report directly or indirectly. Oracle recommends you configure the appropriate switch value as per company specific business needs:

- Profile Switch under Common Profile -> Argus J
  - On Adding/Updating the Case form -> Events -> Description as Reported by an English user, auto populate Description as Reported on the Japanese side with:
    - Option 1: English Verbatim (Default)
    - Option 2: Japanese PT (From Meddra J)
  - Based on the value configured for the above switch, the application auto populates the user entered English verbatim or the Japanese PT in the Japanese verbatim.
b. Allow user to update the *Reason for Downgrade/Nullification report* and *Comments for start date of reporting timeframe* after the case is locked (globally and locally locked):

Option 1: Yes (default)
Option 2: No

Based on the value configured for the above profile switch, *Reason for Downgrade/Nullification report* and *Comments for start date of reporting timeframe* text areas are made available for edit even after the case lock.

c. Default viewing format of the PMDA E2B R3 report (used with Interchange-J)

Option 1: XML
Option 2: Decoded (Default)
Option 3: HL7

The default view for E2B Viewer for PMDA E2B R3 report can be configured using the above profile switch.

Profile Switch under **Common Profile -> Case Processing -> Dictionary Browser**

a. Allow User to Add Non-Current Meddra Terms for:

Option 1: Case irrespective of Country of Incidence
Option 2: Case where Country of Incidence is other than Japan (Default)

This profile switch value is used to control the application behavior to allow the user to add the Non-current LLT (J) term to Case Forms.

b. On change of LLT Term Sync English and Japan LLTs, irrespective of the currency:

Option 1: Yes
Option 2: No (Default)

This profile switch value is used to set the application behavior to synchronize the LLT term when the user updates the LLT.

---

**Optional Upgrade Scripts for Data Migration to New Fields**

**eVAERS specific**

**Illness at the time of Vaccination**

Illness at the time of Vaccination data is used in the eVAERS report and this data is captured in Case Form -> Patient -> Other Relevant History -> Condition Type = *Illness at Vac*. LLT code and MedDRA version of the ORH record with Condition Type as *Illness at Vac* is transmitted in data elements *illnessatvaccination* and *Illnessatvaccinationmeddraversion* respectively.

The VAERS report continues to map Illness at the time of Vaccination with the corresponding field in Vaccine tab.

If Illness at time of Vaccination in Vaccine tab has data in legacy cases, this data can be copied to Case Form -> Patient -> Other Relevant History by executing the optional upgrade scripts providing along with this release. Oracle recommends you keep this data in ORH and Vaccine tab in sync so that same data is presented in VAERS and eVAERS report.
**Emergency Room visit**

Emergency Room Visit data is used in the eVAERS report and this data is captured in Case Form -> Event -> Emergency Room Visit (checkbox). If this checkbox is checked, then `seriousnesservisit` data element is transmitted as true. If this checkbox is unchecked, then null flavor NI is transmitted.

The VAERS report continues to map Emergency Room visit data with the field **Required ER visit** in Vaccine tab.

If **Required ER visit** checkbox is ticked in Vaccine tab in legacy cases, this data can be copied to Case Form -> Event-> Emergency Room visit by executing the optional upgrade scripts providing along with this release. Oracle recommends you keep this data in Event tab and Vaccine tab in sync so that same data is presented in VAERS and eVAERS report.

**Prior Adverse Event**

The VAERS report transmits LLT code and MedDRA version data from Case Form-> Patient -> Other Relevant History. Upgrade scripts are provided to copy data from Case Form -> Product -> Vaccine -> Prior Adverse Event (where Person type=Patient ) to Case Form-> Patient -> Other Relevant History.

The VAERS report continues to print the verbatim text entered for Adverse Event in box 21 from Case Form -> Product -> Vaccine -> Prior Adverse Event as per existing functionality.

Oracle recommends that customers enter Prior Adverse Event experience by Patient in Case Form -> Patient -> Other Relevant History so that required information is populated in the eVAERS report and if the VAERS report must be sent, the same data can be entered in Case Form -> Product -> Vaccine -> Prior Adverse Event.

**Admin By and Responsible Physician**

The Vaccine Administration Section in Products > Vaccine has been re-organized and several new fields have been included to be compliant with CBER eVAERS Guidance.

Upgrade scripts are provided to copy data from **Admin By** (CASE_VACC_VAERS.ADMIN_BY) to Best Doctor Physician Last Name ( ), if **Admin By** is blank, the data from Responsible Physician CASE_VACC_VAERS.PHYSICIAN is copied.

Based on company requirements, the upgrade logic can be altered to consider **Responsible Physician** data first instead of **Admin By**.

**eMDR Specific**

**Device Age and Unit**

The Device Age and Unit fields are provided in Products -> Device tab. Upgrade scripts are provided to copy data from Device Age (approx) to Device Age and Unit fields by using the following logic. Oracle recommends customers review this logic and make necessary changes based on the format in which Device Age was entered in Device Age (approx) field.

1. Device Age is derived from CASE_PROD_DEVICES.DEVICE_AGE by considering the initial numeric value of the Device Age field value.

2. Unit is derived from CASE_PROD_DEVICES.DEVICE_AGE by considering later portion of Device Age field value.
   a. Unit is populated as Hours, if the later portion of CASE_PROD_DEVICES.DEVICE_AGE text is Hour or Hours or Hr irrespective of upper/lower case used.
b. Unit is populated as Days, if the later portion of CASE_PROD_DEVICES.DEVICE_AGE is Day or Days or Da irrespective of the upper/lower case used.

c. Unit is populated as Month, if the later portion of CASE_PROD_DEVICES.DEVICE_AGE is Month or Months or Mo irrespective of the upper/lower case used.

d. Unit is populated as Year, if the later portion of CASE_PROD_DEVICES.DEVICE_AGE is Year or Years or Yr irrespective of the upper/lower case used.

Location where Event Occurred

The Location where event occurred field is changed to a type ahead field in Case Form -> Analysis -> MedWatch Info tab.

Previously, Location Where Event Occurred was captured using multiple checkboxes representing different locations. As per typical business use case, the event occurrence is likely to happen only in one location.

Upgrade scripts are provided to copy data from the following fields with matching Codelist ID from the Location event occurred codelist. If data is present in more than 1 field, the data is not copied in the upgraded database and the upgrade log indicates that users need to manually select appropriate data for this field as the prior version had multiple options marked.

- CASE_MEDWATCH_DATA.LOC_HOSP
- CASE_MEDWATCH_DATA.LOC_HOME
- CASE_MEDWATCH_DATA.LOC_NH
- CASE_MEDWATCH_DATA.LOC_OTF
- CASE_MEDWATCH_DATA.LOC_ODF
- CASE_MEDWATCH_DATA.LOC_ASF
- CASE_MEDWATCH_DATA.LOC_OTHER

Attachments in HL7 Reports

ICSR Attachments can be sent in ICH E2B (R3), eVAERS, eMDR, and PMDA E2B(R3) reports. The Reporting Destination must be configured for sending attachments by marking Transmit E2B Attachments and selecting the Attachment classification that is required to be sent as an inline attachments in these reports.

Attachments are encoded using the B64 format.

Compression Format

For ICH E2B (R3), EMA E2B(R3), and PMDA E2B(R3) reports, attachments are compressed in the format as specified in the l Common Internal Profile switch.

- ICH E2B (R3) and EMA E2B(R3) reports use the internal common profile switch ZIPSTREAM_COMPRESSION_ALGORITHM. DF (Deflate) is the default compression algorithm used for compressing attachments; other options supported are GZ and ZL.

- PMDA E2B(R3) reports uses the common Profile switch Compression algorithm for file attachments in PMDA E2B R3. DF (Deflate) is the default compression algorithm used for compressing attachments; the other option supported is GZ IP.
Null Flavor Handling in HL7 Reports

eMDR and eVAERS profiles do not require compression as per guidelines from CDRH and CBER respectively.

File Formats

For more information on file formats supported for Attachments, refer to the following sections.

Configuring Common Profile Switches -> For configuring file types for the Report Types.

Attachment Size

For more information on Attachment size validation, refer to the following sections.

Attachment and report file size configuration: Configuring Reporting Destination for ICH E2B(R3), EMA E2B(R3), eVAERS, eMDR, and PMDA(R3) profiles.

Creating and Managing Amendments for eVAERS and E2B (R3) report

When to create Amendments?

If Initial / Follow-up eVAERS / E2B (R3) reports are submitted to a Reporting Destination/Agency and then there is a request from the Agency to send attachments, amendments can be created by unlocking the case as significant follow-up and ticking the Amendment checkbox in Case Form -> General Tab -> Follow-up section and providing the reason for creating Amendments.

Users can include Attachments and provide the details of the attachments in the Case Summary.

Auto-scheduling of Amendment Report

Amendment reports are auto-scheduled for cases with Significant Amendments only for the Reporting Destination configured with an eVAERS / E2B (R3) Profile.

Follow-up reports are auto-scheduled for cases with Significant Amendments for the Reporting Destinations that are configured with Non E2B and E2B (R2) reports.

Manual Scheduling of Amendment Reports

Amendment reports for eVAERS / E2B (R3) can be manually scheduled for Significant Amendments or Non Significant Amendments using the Scheduling New Expedited Report dialog. Users can select the Aware date pertaining to the Amendment and schedule an eVAERS / E2B (R3) report. Aware date pertaining to an Amendment can be identified by text (A) appended to the Aware date. Oracle recommends you have only one amendment for an Aware date, else it may be difficult to identify the latest amendment from the Aware date drop-down list in the Scheduling New Expedited Report dialog.

If User manually schedules Non E2B or E2B (R2) reports for an Amendment Aware date, then system schedules follow-up report if there is a previously submitted report of the same report type to the same agency, else will schedule an Initial report.

Other Recommendations

Amendments can be created only when there exists a previously submitted eVAERS / E2B (R3) report.

Null Flavor Handling in HL7 Reports

Null flavor data is not sent in eMDR in absence of clear guidance on the exact null flavor allowed for the individual data elements.
Null Flavor can be entered for Date and Text fields as per the ICH E2B(R3) Implementation Guidelines.

EMA, CBER, PMDA have minor differences in the allowed Null Flavors for various data elements.

Oracle recommends you customize the fields with appropriate Null Flavor sets based on reporting needs.

New Null Flavor sets can be created using Flexible data re-categorization.

For text fields, Null Flavors must be entered for English and Japanese fields separately by manually selecting them from the NF drop-down list.

Null flavors can be selected for Codelist fields by selecting key values such as MASKED, UNKNOWN and so on from the typeahead/drop-down fields.

During Report generation, mapping logic for the data elements (that support Null flavors) identifies these keywords as Null flavors and populates required information in the HL7 report.

Validation is done to check for only allowed Null flavor if Case data is missing. Error messages are displayed if incorrect Null flavors are used for a data element or when both Case Form data and Null flavors do not have the mandatory data elements.

---

**Best Practices in a Multi-Tenant Environment**

This section lists the best practices to follow in a multi-tenant environment.

**Single Sign-on**

Single Sign-on needs to be enabled to have the capability to switch client context and to open the Argus Safety application from the Global Worklists/Application Access Portlet. If SSO is enabled, then it becomes mandatory for a user to be configured as an LDAP user in all the enterprises where the data displays on the screen/portlet.

**Accessing Argus Safety Directly via URL**

It is expected that you will pass the internal Enterprise ID as a URL parameter for the Argus Safety application to open with the appropriate Enterprise context. If Enterprise ID is not passed, the user is validated against the default enterprise.

For ESM Mapping Utility and EOSU Tool which are client-server applications and do not have a mechanism to specify the Enterprise ID, will always validate users against the default enterprise. Hence, users that are expected to login into these applications are configured with appropriate access/roles within default enterprise. For this reason, "Active" checkbox for the default enterprise is always marked checked and disabled in Global Enterprise Management screen.

**Global Homepage and Portlets**

Set up appropriate Portal user and user group privileges to restrict access to Portlets and the Global Homepage. It is recommended that you configure the out-of-the-box Portlets so these (specified below) are accessible to all multi-tenant users who need to access data across multiple enterprises, except the ones specifically recommended for administrators.

- Global Worklist - New
- Global Worklist - Open
- Global Worklist - Action Items
- Global Worklist - Contacts
- Global Enterprise Management: Recommended for Administrators
- Global User Management: Recommended for Administrators
- Application Access Portlet

**Global Worklists Columns**
The system allows flexibility to hide some of the fields/columns in the Global Worklist Portlets through the Global Worklist grid/menu XML(s) which resides on the Web Server(s). It is advisable to hide only those fields/columns which are not updated nor referred by any Worklist context menu actions.

**Global User Management**
In order to apply updates to the "Synchronizable" fields to all the enterprises in the system, you should maintain some administrative users with the Console'Access Management 'Groups' Menus 'Console: Access Management: User menu access enabled for all enterprises in the system.

**User-Enterprise Association**
When a user is copied from one enterprise to another, it is expected that you have set up the appropriate site and the usergroups in the target enterprise. Otherwise the user-association with fail with the appropriate error message.

**New User Creation/Association**
Argus Console allows same UserID to be used to create different users across multiple enterprises. It is recommended that this feature is only be used if users are not expected to be shared across enterprises. Otherwise, if users are expected to be shared across multiple enterprises, then same UserID will not be used to create different users across different enterprises. Instead of that, a user created in one enterprise is associated to other enterprises through Global User Management.

**Inactivating an Enterprise**
It is recommended that you first archive all the cases belonging to the Enterprise before inactivating the Enterprise.

**New Enterprise Setup**
It is expected that you create and choose the appropriate Enterprises with generic configuration data which can be used as source for copying the configuration data for creation of a new enterprises. Following is a list of items that the you are recommended to ensure that the values being copied from the source enterprise are appropriate for the newly created enterprise:

- Advanced Conditions used within any configuration item
- Reporting Destination Code List ' Company identifier field values
- System Numbering and LAM System Numbering Formats
- ESM Mapping Utility ' Setup INI File Setup ' Service DB Setup ' Outgoing and Incoming folders for each Agency.

**Common Profile Switches**
Best Practices in a Multi-Tenant Environment

- MedWatch Configuration
- Documentum configuration
- Lot Number Web Service Configuration

Segregated by Enterprise

Following is the list of items that are segregated by enterprises. It is recommended that you configure distinct values across enterprises to ensure proper data segregation across enterprises:

- Literature Intake folder: Argus Console ' Common Profile Switches ' Argus J ' Shared Path for the Literature Intake
- Case Intake folder: Argus Console ' Code List ' User Sites ' Intake File Path
- Path for New Case from Image: Argus Console ' Common Profile Switches ' Case Processing ' Default Network directory for scanned images
- E2B Incoming Folder: ESM Mapping Utility ' Setup INI File Setup ' Service DB Setup ' Incoming Folder
- Site Printers: Argus Console ' Code List ' User Sites ' Site Printers ' Path

Maintaining Consistency Across Enterprises

The following is the list of items that are segregated by enterprises but the CRO is recommended to maintain consistent across all enterprises:

- Common Profile Switches ' Argus Insight URL
- Common Profile Switches ' Argus Safety Load Balancer Server
- System Configuration ' Enabled Modules

Shared Across Enterprises

Following is the list of items that are common for all enterprises:

- MedDRA and WHO Web Services
- Common Profile Switches ' Security ' LDAP ' Enable/disable LDAP
- Common Profile Switches ' Security ' LDAP Server configuration
- Common Profile Switches ' Security ' Enable/disable SSO
- Common Profile Switches ' Security ' SSO Header Configuration
- Common Profile Switches ' Case Processing ' Where to store temporary case information during data entry
- Common Profile Switches ' Case Processing ' Auto Archiving ' The database job and its frequency - "Execution Period (in Days)"
- Default Enterprise

The common profile switches (related to SSO, LDAP, Auto Archiving job & frequency and Temporary Case Data Storage) which are common for all enterprises will only be displayed, updated and audit logged in DEFAULT enterprise. This is because any update to global level profile switches impacts all enterprises and is controlled. Also, such an update will also require propagation of the audit log to all other enterprises where the current user may not even exist or may not have proper access.
Pre-upgrade Considerations for Existing Databases

Make sure that all the AG Service users (login user id) in all the databases that are to be merged into single database are in sync with the DEFAULT ENTERPRISE. If there are AG Service users in other enterprises which do not exist in the DEFAULT ENTERPRISE, then you can either rename their login user IDs to map them to existing AG Service users in the DEFAULT ENTERPRISE or delete them. If extra users are found in other enterprises during multi-tenant database migration, then they will be marked disabled and you will not be enable them later.

Make sure that all the event & indication and who-drug encoding dictionaries used in Argus Console ' System Configuration ' Common Profile Switches ' Case Form Configuration ' Auto Encoding, Dictionary and Central Encoding section and Argus Console ' Business Configuration ' Studies ' Enable Study Specific Encoding ' Auto Encoding dialog, in all databases that are to be merged into single database are already loaded in the target database with the same name. This is required to enable the automatic linking of dictionaries configured in the separate databases to the already existing dictionaries present in the target database during the database merge script/process.

Post-upgrade Considerations for Existing Databases

E2B Outgoing and Incoming folders is configured again in ESM Mapping Utility because various folders for different transmission methods are now merged as one pair of folders for all transmission methods. Now these are saved into database rather than the ESM Service INI file.

Document Type field value from ESM Service configuration and AG Service configuration tool is now be configured again into Argus Console ' Common Profile Switches ' Documentum configuration as these fields are now moved to Argus Console.

Make sure that all the event & indication and who-drug encoding dictionaries used in Argus Console ' System Configuration ' Common Profile Switches ' Case Form Configuration ' Auto Encoding, Dictionary and Central Encoding section and Argus Console ' Business Configuration ' Studies ' Enable Study Specific Encoding ' Auto Encoding dialog, in the newly migrated enterprises are linked properly to the global dictionaries already present in the target database. This is required to correct any dictionary configuration linking that could not be done automatically by the database merge script due to mismatch in dictionary names in the source and target databases.

Documentum Migration

Existing single-tenant as well as multi-tenant Documentum users upgrading to AS 7.0 release, and are migrating/keeping all the documents in the Documentum server, is also add additional attributes- "enterprise_id" and "enterprise_short_name" and populate these appropriately for all their documents that are to be accessed by Argus Safety in Documentum server.

Existing single-tenant as well as multi-tenant users which are upgrading to AS 7.0 release, and have configured "Use Logged in User's Username/Password" for Argus Console ' System Configuration ' Common Profile Switches ' Document Management for Case Attachments will switch to Common Username/Password for Documentum login if not already configured for E2B, Expedited and Periodic Reports.

MedDRA and WHO Webservices: As MedDRA and WHO webservice is common for each enterprise, it will use only single version for encoding events and drugs. However, as these web services use the dictionaries configured in Argus Console'
System Configuration 'Common Profile Switches 'Case Form Configuration 'Auto Encoding, Dictionary and Central Encoding section for the respective enterprises for populating dictionary id and dictionary version information for the encoded items, configure these dictionaries as same across all enterprises.